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Preface

ADVANCED Motion Controls constantly strives to improve all of its products. We review the information in 
this document regularly and we welcome any suggestions for improvement. We reserve the right to modify 
equipment and documentation without prior notice.

For the latest revision of this manual, visit the company’s website at www.a-m-c.com. Otherwise, contact 
the company directly at:

ADVANCED Motion Controls  3805 Calle Tecate Camarillo, CA  93012-5068 USA

This manual is for the exclusive use of ADVANCED Motion Controls. The reproduction, transmission or 
use of this document or its contents is prohibited without the expressed written permission of ADVANCED 
Motion Controls.

© 2021 ADVANCED Motion Controls. All rights reserved.

General Safety

You must install and operate ADVANCED Motion Controls motion control equipment so that 
you meet all applicable safety requirements. Ensure that you identify the relevant standards 
and comply with them. Failure to do so may result in damage to equipment and personal 
injury.

Read this entire manual prior to attempting to install or operate the drive. Become familiar 
with practices and procedures that allow you to operate these drives safely and effectively. 
You are responsible for determining the suitability of this product for the intended 
application. ADVANCED Motion Controls is neither responsible nor liable for indirect or 
consequential damages resulting from the inappropriate use of this product.

High-performance motion control equipment can move rapidly with very high forces. 
Unexpected motion may occur especially during product commissioning. Keep clear of any 
operational machinery and never touch them while they are working.

http://www.a-m-c.com
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Keep clear of enclosed units, motor terminals, and transformer terminals when power is 
applied to the equipment. Follow these safety guidelines:

• Always turn off the main power and allow sufficient time for complete discharge before 
making any connections to the drive.

• Make sure that the minimum inductance requirements are met. Pulse Width 
Modulated (PWM) amplifiers deliver a pulsed output that requires a minimum amount 
of load inductance for proper operation.

• Do not rotate the motor shaft without power. The motor acts as a generator and will 
charge up the power supply capacitors through the amplifier. Excessive speeds may 
cause over-voltage breakdown in the power output stage. Note that an amplifier 
having an internal power converter that operates from the high voltage supply will 
become operative.

• Do not short the motor leads at high motor speeds. When the motor is shorted, its own 
generated voltage may produce a current flow as high as 10 times the amplifier 
current. The short itself may not damage the amplifier but may damage the motor.

• Do not make any connections to any internal circuitry. Only connections to designated 
connectors are allowed.

The warning symbol instructs and directs you to avoid harming yourself. This ensures 
operator safety and protection.

ADVANCED Motion Controls, the combined isosceles trapezoid/right triangle logo, and DriveWare are 
either registered trademarks or trademarks of ADVANCED Motion Controls in the United States and/or 
other countries. All other trademarks are the property of their respective owners.

Some features shown in this manual are not available on all FlexPro models. More information on new 
features can be found in the ACE release notes. Please contact technical support for questions.

Document ID Revision Date Changes

MNDGACUG-01 1.2019 - BETA 6/2019 First Release

MNDGACUG-02 1.2019.4 12/2019
- Added Initial Support for Jerk Limiting
- Added Initial Support for AC Induction Motors

MNDGACUG-03 1.2020.1 3/2020 - Added Pre-Trigger Value field for BiSS-C Encoders

MNDGACUG-04 1.2021.1 6/2021 - Added note regarding current loop Ki display units
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MNDGACUG-05 1.2021.4 11/2021

- Added Tamagawa/Nikon Envoder Feedback Parameters
- Added 4.1.1 Auto-Tuning section
- Added 4.1.2 Manual Current Loop Tuning
- Updated Temperature table in Signal Definitions

MNDGACUG-06 1.2022.2 7/2022

- Updated “Incremental Encoder Feedback Parameters” table.
- Updated “Absolute Encoder (EnDat® 2.2) Feedback Parameters” table.
- Updated “Absolute Encoder (BiSS C-Mode) Feedback Parameters” table.
- Updated “Tamagawa/Nikon Encoder Feedback Parameters” table.
- Added information about storage location of motor database file in 3.4.6 Motor Database.
- Updated “Velocity Feedback” table to include “Low Speed Estimator (incremental encoder feedback only.”
- Updated Section 4.1.1
- Added 4.3.1 Velocity Loop Auto-Tuning
- Added A.1.3 Import

Document ID Revision Date Changes
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 1 Introduction

This document provides instructions on how to use the setup software to connect to, set up and control digital 
servo drives.

These instructions walk you through the commissioning steps necessary to set drive limits, tune the current, 
velocity, and position control loops, and assign automated functions to drive events.

The following major sections are covered:

• “Connecting to the Drive” on page 12
• “Configuring the Drive” on page 15
• “Tuning and Commutation” on page 52

Follow the procedures in this chapter to get an overview of many functions. Familiarize yourself with the files 
on your computer, the software workspace and controls of the software. Later chapters provide more details in 
using these functions.

Before proceeding, you must accomplish the following actions:

 Read the release notes and installation text files for your setup software version.
 Install the setup software.



MNDGACUG-06 2

Introduction / Getting Started

1.1 Getting Started

After installing the setup software on your computer, you can run the application from your 
Start > Programs menu or desktop icon.

When you first start the setup software, you see the following choices:

• Open - This will allow you to browse through the files on your computer to select a 
previously saved project file to open, without having to connect to a drive. The project can 
then be configured or modified before downloading the project file into a drive.

• Connect - This will allow you to immediately connect to a drive. The drive can then be set 
up and configured for operation, and the information saved as a project file.

1.1.1 Software Files
Look in the folder in which you placed the application; by default, this location is under 
C:\Program Files. This folder includes the subdirectories:

• MotorDB holding a library of *.xml database files making up the motor database.
• My Firmware Files holding a library of *.aff firmware files for various drives.
• My Projects holding a library of *.adf project files, each with the parameters and controls 

specific to a particular drive-and-motor setup.

1.1.2 Workspace Display
The software provides functions, tools and status to help you set up your drive.

Caption Bar

Status Panel

Status Bar

Menu Bar and Associated Toolbar Icons

Main Workspace Display

Dynamic Help

System Browser
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Menu Bar and Associated Toolbar Icons   At the top of the screen are pull down menus 
and a toolbar for access to many tools and functions.

Function Menu Pull-down Toolbar Keys
Open a project file File > Open Project Crtl+O

Save a project file to PC Save Project Crtl+S

Save a project file  to PC as a file name Save Project As... - - - - - -

Apply changes made to active window Apply Changes Ctrl+L

Automatically apply changes made Auto Apply Ctrl+U

Close the program Exit - - - Alt+F4

Power up or down the bridge Drive > Enable

Disable

Alt+E

Alt+D

Allow motion to occur or disallow motion by 
sending a Stop command

Motion Ready

Stop Motion

Alt+G

Alt+P

Change the active Configuration Switch Configurations Alt+C

Change the active Gain Set Switch Gains Alt+A

Connect to the drive or change connection 
settings once connected

Connect Ctrl+N

Disconnect from the drive Disconnect Ctrl+D

Store project on the drive Store to drive Alt+O

Upload settings from drive Restore from drive - - - - - -

Update drive firmware Firmware Download - - - - - -

Display drive information About Drive - - - - - -

Turn the Motion Engine on or off Motion Engine > On Alt+R

Reset the Motion Engine Reset Ctrl+R

Open the Scope/Tuning tool Tools > Scope/Tuning Ctrl+E

Open the Multimeter tool Multimeter Ctrl+M

Brings up the Motion Panel window. Motion Panel Ctrl+T

Assign the Disable Drive Hotkey Settings > Hot Key Settings - - - - - -

Open the User Units window User Units Ctrl+R
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System Browser   Navigate between the setup windows to configure the drive. Each panel 
contains multiple headings for specific drive parameters. Select a configuration item from the 
System Browser to open a window in the main workspace display.

Status Panel   The Status Panel provides real-time information on drive events and actions.

• Drive Status - Shows drive events (current and history) and is a useful troubleshooting tool.
• Critical Event Activity - Lists drive faults and fault events along with the time they occurred.
• Event Counters - Lists the number of times faults have occurred since the drive has been in 

operation.

Dynamic Help Browser   Dynamic Help tracks user movements through the software 
workspace and automatically navigates to the appropriate Help topic in the list. Select a topic 
from the Dynamic Help Panel to open a new tab with the Help information. The Dynamic Help 
automatic tracking feature can be toggled on or off by clicking the Pause button  in the Help 
Browser pane. The Back  and Forward  buttons will navigate between previously viewed 
Help Topics.

Status Bar   The Status Bar provides information on the drive configuration, bridge state, connection 
status, and accessibility. From left to right across the bottom of the workspace window, the 
Status Bar provides information on:

• Motion - Displays motion tasks the drive is currently performing when the motion engine 
is enabled. Will be blank if no task is currently active.
— Config 0: Configuration 0 is currently selected, and no autonomous modes are active.
— Config 1: Configuration 1 is currently selected, and no autonomous modes are active.
— Ready: Motion Engine is on and the drive is ready to receive commands from the Motion 

Engine. No motion tasks are currently active.
— Home: Drive is actively in homing mode.
— Jog: Drive is actively in jog mode.
— Index (# or name): Drive is running an index.

Show or hide the System Browser View > System Browser - - - - - -

Show or hide the Status Panel Status Panel - - - - - -

Show or hide the Caption Bar Caption Bar - - - - - -

Customize the Toolbar icons Toolbar - - - - - -

Customize the display themes Theme - - - - - -

Arrange software windows into horizontal 
tabbed group

Window > New Horizontal Tab Group - - - - - -

Arrange software windows into vertical 
tabbed group

New Vertical Tab Group - - - - - -

Closes all open tabs Close All Tabs - - - - - -

Re-arranges all toolbars and panels to their 
default locations

Reset Window Layout - - - - - -

Open the software Help file, or display the 
Dynamic Help Browser

Help > Help... F1

Display software information, version 
number, and copyright.

About... - - - - - -

Function Menu Pull-down Toolbar Keys
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— Waveform: The Waveform Generator is controlling the axis.
— AutoComm: The AutoCommutation process is controlling the axis.

• Bridge - Shows the status of the drive.
— Enabled: Drive is enabled (note that a Stop condition is considered enabled).
— Disabled: Drive is disabled (note that a Dynamic Brake condition is considered disabled).

• Action - Shows the present bridge action as the result of a drive or system event. Hovering 
the mouse pointer over the Action status will display the event causing the action.
— Bridge Disabled: The bridge is disabled.
— Negative Disabled: Disable negative direction action is active.
— Positive Disabled: Disable positive direction action is active.
— Dynamic Braking: Dynamic brake action is active.
— Negative Stopped: Negative stop is active.
— Positive Stopped: Positive stop is active.
— Stopped: Stop is active.

• Comm - Shows whether the setup software is connected to a drive. Hovering the mouse 
pointer over the Connection status of a connected drive will provide information about 
the connection type.
— Connected: Software is connected to a drive.
— Not Connected: Software is not connected to a drive.

• Access - Shows whether the setup software has full control or monitoring access. Will be 
blank if the drive is not connected.
— Read/Write: The drive is connected and the software has Read/Write access (full control).
— Read-Only: The drive is connected and the software has Read-Only access (monitoring only).

Caption Bar   Displays details about the current drive configuration.

• Command - Shows the present Command Source (either as configured in the active 
Configuration window or as selected for motion, tuning, waveform, or commutation 
functions).

• Gains - Displays the presently selected Gain Set.
— Set 0: Gain Set 0 is active.
— Set 1: Gain Set 1 are active.

• Loop Configuration -Displays the present loop configuration.
— Position Around Velocity: All loops are enabled.
— Position Around Current: Only the position and current loops are enabled.
— Velocity: Only the velocity and current loops are enabled.
— Current: Only the current loop is enabled.

• Velocity Feedback - Shows the present velocity feedback device as configured in the 
Feedback window.

• Position Feedback - Shows the present position feedback device as configured in the 
Feedback window.
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1.2 Using the Setup Software

The setup software provides many tools to configure and monitor the settings for the drive. 
Later chapters go into detail about these tools, but briefly, this section describes how to:

• Open a project file
• Name the drive
• Connect to and disconnect from the drive
• Enable and disable the power bridge
• Set the drive behavior when you disable the power bridge
• Use a Hot Key to disable the power bridge
• Show and hide the toolbars
• Move, scroll and arrange the windows

1.2.1 Opening a File
The setup software must be disconnected from the drive before performing this task.

1. To open an existing project file from your computer, perform one of the following actions
— Select File > Open on the main menu bar.

— Click on the Open icon  on the tool bar.

2. Browse your computer to the My Projects subdirectory or wherever your project files are 
saved, and select a project (.acf extension).

Once opened, you can connect to the drive and if the configuration settings in the drive don’t 
match the configuration settings in the setup software, you can choose to either download the 
project file configuration settings into the drive, or upload the configuration settings from the 
drive into the setup software. For more information, see “Connecting to the Drive” on page 12.

1.2.2 Working with the Drive
There are several tasks you must accomplish to configure and set up the drive. Later chapters 
go into detail about these tasks.

Naming the Drive   The Drive Name data field allows you to assign a unique name to the drive 
(such as "X-Axis"). You may enter a name up to 32 characters.

1. Select Settings from the [DriveName] heading in the System Browser.
2. In the data field, type the name of the drive.
3. Click on the OK button.

Connecting to the Drive   You must start communicating with the drive before performing 
any configuration and setup. Choose one of these actions:

• Select Drive > Connect on the main menu bar.
• Click on the Connect icon  on the tool bar.
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When you connect, you decide whether to upload the configuration settings currently in the 
drive or download the current project from the setup software into the drive.

While connected to the drive, the status bar in the lower, right-hand corner of the workspace 
reads CONNECTED and you can perform most configuration tasks.

See “Connecting to the Drive” on page 12 for more information.

Disconnecting from the drive   When it is time to stop communicating with the drive, you 
must disconnect from the drive. Choose one of these actions:

• Select Drive > Disconnect on the main menu bar.

• Click on the Disconnect icon  on the tool bar.

After terminating communication with the drive, the status bar in the lower, right-hand side of 
the workspace reads NOT CONNECTED.

1.2.3 Hot Key
The Hot Key Settings window allows you to select the behavior associated with a specified Hot 
Key. It does not apply to user inhibits or event-related inhibits. Select Settings > Hot Key Settings 
on the main menu bar.

This window allows you to assign a Hot Key to either disable the bridge or stop motion. 

*Stop behaves differently depending which mode the drive is in. For current mode, Stop will command zero 
current. For velocity mode, Stop will decelerate and command a zero velocity. For Position mode, Stop will 
decelerate and hold position.

When you press the Hot Key, it is the same action as disabling the drive or stopping motion 
through the Menu Bar or clickable icons on the Command Toolbar. You can use the Hot Key at 
any time. However, if the Hot Key is set to Stop Motion, it will have no function if the drive is 
already disabled. To assign keystrokes for the Hot Key:

1. Select Settings > Hot Key Settings from the menu bar.
This action displays a window allowing you to reassign the key combinations.

2. Make sure the cursor is placed in the edit box.
3. Press the desired function keys (F2-F11).
4. Click the OK button.

Disable Bridge The Hot Key will issue a Software Disable. The action associated with a Software Disable may be 
specified in the Events window.

Stop Motion The Hot Key will issue a Stop command*.
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1.2.4 Working with the Command Toolbar
The Command Toolbar has four main functions:

• Controls whether the power bridge circuit is enabled or disabled
• Controls whether the drive is ready to respond to motion commands.
• Switches between user configurations
• Switches between gain sets

Command Toolbar Buttons

In later chapters, when you actually enable the bridge, the motor will 
have power and can move. You must take care so as to avoid damage 
to equipment or injuries to people.

Icon Action Description

Enable /
Disable

Enable Drive
Clicking on the Enable Button will send an Enable instruction to the drive. If there are 
no active errors or digital inputs causing the bridge to be disabled, the bridge will 
become enabled, allowing the drive to react to motion commands.

Disable Drive

Clicking on the Disable Button will send a Software Disable instruction to the drive. If 
the bridge was enabled prior to clicking the button, the bridge will be disabled. This 
action will turn off the power bridge circuit. The Stop/Allow Motion button is greyed 
out when the drive is disabled. You may configure events to automatically disable the 
bridge from within the Events window.

Motion / Stop

Motion

Clicking on the Motion Button will release the drive from the stopped state. This 
action allows the drive to react to motion commands. In order to perform functions in 
the setup software such as Phase Detect, AutoCommutation, and tuning tasks, 
motion must be enabled. Keep in mind that when the drive has been set to allow 
motion commands, the drive is software enabled, but a hardware event (digital input, 
invalid hall state, etc.) could still prevent motion.

Stop

Clicking on the Stop Button will send a Stop instruction to the drive. This action 
prevents the drive from sending motion commands to the motor such that no 
movement is allowed to occur. Note that stopping motion is not the same as disabling 
the power bridge. The bridge will still be enabled when motion has been stopped. The 
behavior of a Stop command depends on the mode of operation the drive is in. If the 
drive is controlling velocity or position, the motor will decelerate according to the 
deceleration limit (specified in the Stop window). When the motor has decelerated to 
zero speed, it will continue to servo in this state until the Stop is released or the bridge 
becomes disabled. If the drive is controlling current, activating the Stop will issue a 
zero current command to the drive. A zero current command will continue until the 
Stop is released or the bridge becomes disabled. You may configure events to 
automatically Stop motion from within the Events window.

Switch Active 
Configuration

Switch Active 
Configuration

Clicking on the Switch Active Configuration button will change the active user 
configuration from Configuration 0 to Configuration 1, or vice versa. Settings for the 
user configurations can be configured under Configuration 0 or Configuration 1 in the 
System Browser. The Caption Bar will display the currently active user configuration.

Switch Active 
Gain Set

Switch Active 
Gain Set

Clicking on the Switch Active Gain Set button will change the active gain set from 
Gain Set 0 to Gain Set 1, or vice versa. Values for the gain sets can be input under 
Tuning > Gain Set 0 or Gain Set 1 in the System Browser. The active gain set can 
also be assigned in the user configuration windows.



MNDGACUG-06 9

Introduction / Using the Setup Software

1.2.5 Working with the Setup Software Windows
The setup software allows for customization of the workspace display for selected features.

Showing/hiding the Toolbars and Caption Bar   To allow more room in the 
workspace, you can hide the Toolbar icons and Caption Bar. It is recommended to leave the 
Toolbars and Caption Bar visible.

To show/hide the toolbars:

1. Select View > Toolbars on the main menu bar.
2. Select or deselect the desired Toolbars, depending on your preference.
3. Alternatively, select the drop-down arrow at the end of each portion of the Toolbar, and 

using the Add or Remove Buttons option, choose which icons and customization 
selections to have visible.

4. Each portion of the Toolbar can also be dragged off into a floating menu by clicking and 
dragging on the Toolbar handle for each portion.

To show/hide the Caption Bar:

1. Select View > Caption Bar to show/hide the Caption Bar.

Showing/hiding Panels   To allow more room in the workspace, you can hide the System 
Browser, Status Panel, and the Dynamic Help panel. It is recommended to leave all the panels 
visible.

1. Select View > System Browser or View > Status Panel to show/hide the System Browser or 
Status Panel, respectively.

2. Select Help > Dynamic Help to show/hide the Dynamic Help panel.

Arranging the Windows   
• To arrange open windows into a tabbed group, select either New Vertical Tab Group or 

New Horizontal Tab Group from the Window menu. Note that not all windows are able to 
be arranged into tabbed groups. Typically it is recommended to use the tabbed grouping 
option to allow the digital oscilloscope to be visible with the active gain set window to 
allow for real-time gain adjustments. It is also helpful to have the Dynamic Help Browser 
open in a tabbed group to provide useful information based on the active window.

• To close all open tabs, select Windows > Close All Tabs on the main menu bar.
• To re-arrange all toolbars and panels to their default locations, select Windows > Reset 

Window Layout on the main menu bar.
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1.3 Getting Help

The Help topics offer assistance with the setup software. “Troubleshooting” on page 120 in this 
manual also offers descriptions and recommended troubleshooting techniques for some 
common issues.

To open the help documentation, either:

• Select Help > Help... on the main menu bar.
• Press the F1 key.

1.3.1 Dynamic Help
The Dynamic Help panel offers a direct link to the Help file topic associated with the active 
software window. Clicking on certain items or opening certain windows will automatically 
shift the Dynamic Help index to the appropriate topic. Click on the topic to open a tab 
containing help information.

The Dynamic Help automatic tracking feature can be toggled on or off by clicking the Pause 
button  in the Help Browser pane. The Back  and Forward  buttons will navigate 
between previously viewed Help Topics.

Alternatively, users can navigate manually through the help index in the Help Browser panel to 
find the desired help topic.

1.3.2 Technical Support
If you need to contact technical support with a problem or question, please have this 
information readily available.

Software Version   To display the version number of your copy of the setup software, select Help 
> About... on the main menu bar.

Display the Drive Information   To display information about the drive’s internal hardware 
and software, select Drive > About Drive from the menu bar. In the Drive Information window, 
click the  button in the lower right corner of the window to expand/collapse detailed 
drive information.
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1.4 Saving Your Setup

After you have configured your drive, be certain to save all parameters and settings.

1.4.1 Storing the Changes onto the Drive
The setup software must be connected to the drive before performing this task.

After you configure and adjust the drive’s settings, use the store function. The drive settings 
stored in the drive’s nonvolatile memory (NVM) are used by the drive after an off-on power 
cycle.

To save the current drive settings in nonvolatile memory, you would either:

• Select Drive > Store to Drive on the main menu bar.

• Click on the Store icon  on the tool bar.

1.4.2 Saving the Project File onto Your Computer
Use this command to save the active configuration project file to its current name and 
directory. When you save a project for the first time, the software displays the Save As dialog 
box so you can name your project.

To overwrite your project file on the computer with your current changes in the setup 
software, you would either:

• Select File > Save on the main menu bar.

• Click on the Save icon  on the tool bar.

If you want to change the name and directory of an existing project file before you save it, 
choose the Save As command.

1. Select File > Save as on the main menu bar.
2. Enter a file name in the dialog box.

1.5 Exiting the Program

Use this command to end your configuration session. To exit the program, either:

• Select File > Exit on the main menu bar.
• Double-click on the upper left corner of the main window.

The software will prompt you to save documents with unsaved changes.

— Apply Changes to Drive - Apply changes to the drive before exiting.
— Save Project to File- Saves the current project file to the PC before exiting.
— Store Changes to the Drive NVM - Saves the current project settings to the drive non-volatile 

memory before exiting.
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Before proceeding, you must accomplish the following actions:

 Read the data sheet for the drive and the specification sheet for the motor and be familiar 
with their capabilities.

 Cable your computer to the drive.
 Wire the drive to the motor.
 Provide electrical power to the drive; the drive, in turn, provides power to the motor.
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2.1 Connecting to the Drive

When you first start the setup software, you see the following choices: 

1. Select Connect.

The Connect To Drive window appears when Connect is selected from the opening window. 
You must initially connect to the drive using the factory default settings stored in nonvolatile 
memory. Once the communication settings have been configured, click Connect.

Ace has the ability to check for updated firmware. If available, a download prompt is shown on 
the screen.
 

If the drive has previously been configured, these settings may have changed.

Connect To Drive Window Settings
Option Default Settings Description

RS232 RS485 Ethernet USB
Drive 
Address 

63 63 1 63 Selects the address of the drive that is connected to the PC. The valid range of 
addresses is 1 - 63.

Baud 
Rate*

115200 115200 - - - - Selects the communication baud rate. The recommended baud rate setting is 115200 for 
RS232, and 115200 or higher for RS485. If necessary, a baud rate of 9600 can be used 
to connect to the drive, but the baud rate should be increased prior to commissiong the 
drive.

Communication Interface Selects the appropriate interface for your application.

Interface Access Control Under normal circumstances, Read/Write should be selected. You may select Read Only 
to put the software in a state that allows monitoring through the configuration software 
while writing through another interface.
Restricted R/W (Read/Write) control allows Read/Write access to certain tuning features 
while writing through another interface. The tuning controls accessible in Restricted R/W 
mode are: Current Loop Gains, Gain Set 0, Gain Set 1, Velocity Feedback Filter 
Frequency, and Advanced Settings.

USB Device The USB Device option will allow selection of the appropriate drive via the drop-down 
menu. Click the USB Search button  to search for compatible drives using the 
current address entered in the Drive Address field. Drives will be listed by their serial 
number for selection.

IP Address (Ethernet communication only) Allows entry of a user defined IP address.

Connect Establishes a connection with the specified settings. If you have a project open, you can 
choose to download the current project settings to the drive, or to upload the stored drive 
settings into the project. The status bar in the lower right corner of the setup software will 
change from NOT CONNECTED to CONNECTED.

Restore Defaults Returns connection settings to the factory default values.

Help Brings up this help document.
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2.2 Changing Communication Parameters

Once communication is established, you may change interface settings.

1. Choose one of the following actions:
— Select Drive > Connect from the menu bar.

— Click on the Connect icon  on the tool bar.

2. Choose your desired settings.
3. Click the OK button.

The new settings take effect immediately. In order to retain the new settings upon power-up, 
they must be stored in the drive’s nonvolatile memory (see “Storing the Changes onto the 
Drive” on page 11.)

ACE has the ability to check if there is updated firmware and prompts the user for a download.
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Before proceeding, you must accomplish the following actions:

 Wire the drive to the motor.
 Connect your computer to the drive.
 Use the setup software to successfully recognize the drive.

Configuration requires you to decide upon several parameters for your drive based on the requirements of your 
application. The drive must have information about scale factors, feedback devices, motor parameters, and 
limits. The setup software provides windows for you to:

• Enter the motor constants.
• Configure the primary feedback.
• Assign the user units of measurements.
• Decide which analog and digital signals will provide input and output for the drive.
• Set the limits for temperature, current, voltage, velocity and position and decide options 

for power-up and brake/stop behavior.
• Specify the command source.

All these parameters are collected in a project file. You can save several project files on your 
computer (they have the *.adf extension). From your computer, a file can be downloaded to—
or uploaded from—the drive. Once in the drive, you must store the file in the drive’s non-
volatile memory.

This chapter discusses each setup software window and function. Once you have completed 
configuration, the drive will be ready for tuning and commutation.

The Restore function loads into your computer’s project file the 
parameters stored in the drive’s non-volatile memory. Use Restore when 
you wish to revert back to the parameters last stored in the drive if you 
find your recent changes result in poor performance.
Select Drive > Restore from drive on the main menu bar.Note
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3.1 Configuration

The Configuration windows are used for defining the Loop Configuration, Gain Set and 
Command Source and allows two separate configurations to be saved for mode switching 
purposes. Open the desired configuration window by selecting [DriveName] > Configuration 0 
or Configuration 1. Note that Mode Switching must be enabled in order for Configuration 1 to 
be available to edit. Mode Switching can be enabled in the Drive Settings window ([DriveName] 
> Settings) by checking the Enable Second Configuration checkbox. Typically it is only 
necessary to define the parameters for one configuration, but for systems where switching 
between two configurations is desired, the setup software can switch between Configuration 0 
and Configuration 1 in any of the following ways:

• Use the Switch Config icon on the Toolbar
• Set up the Digital Inputs to switch Configurations
• Configure the Power-up Settings to switch Configurations

Loop Configuration

The Loop Configuration option allows selection between the four control loop choices: Current, 
Velocity, Position Around Current, and Position Around Velocity. Set the loop configuration for 
the final application of the drive system. For instance, if the desired configuration is Position 
Around Velocity, it is not necessary to change the loop configuration from Current to Velocity 
to Position Around Velocity while tuning each control loop. See “Tuning and Commutation” on 
page 52 for information on tuning the control loops.

Gain Set

Most applications will not require gain switching, and therefore should use the default Gain 
Set 0. For advanced configurations, a particular gain set can be associated with the 
configuration, and can be initiated automatically each time the configuration is initiated or the 
drive is power cycled. If the application requires more than one configuration, a single gain set 
can be used on both configurations, or a separate gain set may be used for each. See “Gain 
Sets” on page 49 for more information.

3.1.1 Command Source
The Command Source option allows selection between any command source supported by the 
drive hardware and firmware. After selecting a command source, the available settings for the 
chosen command will appear to the right in the Configuration window.

Some command sources may require a specific Loop Configuration for proper operation. In 
this case, a message will appear with information on which Loop Configuration is required. 
The command source change cannot be applied until the compatible Loop Configuration is 
selected.

No Command
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This assigns no command source to the drive. Typically, No Command will be automatically 
assigned when major control loop changes are performed. This is a protection feature to 
minimize sudden motor movement.

Analog Input

Selects an analog input as the command source for the drive.

Configuration of this input can also be done in the Analog Inputs window. All analog inputs are 
shown. If more than one is available, you may select it from the Select available input box. If an 
input is disabled (grayed out), that means it is already assigned to another task, and cannot be 
selected as a command source.

Configuration allows the assignment of parameter values for the applicable Analog Input.

• Scaling: Provides a ratio between the input command voltage and the drive output, in 
terms of applicable user units.

• Offset: Used to apply an offset to the input command signal.
• Deadband: Sets a deadband range in which the input command signal will have no effect. 

Deadband will automatically be enabled when an analog input is applied as the command 
source, even if the Deadband value is zero.

Status allows for monitoring of the input command signal.

• Measured Value: The value measured at the analog input.
• Commanded Value: The value after applying the specified scaling and offset values, 

measured in applicable user units.

Step & Direction

Selects the step and direction inputs to control the motor in a simulated stepper motor 
configuration.

Configure input scaling allows entry for the number of input pulses desired to move the motor 
by a given amount, defined in the second entry field. Conversion varies depending on which 
loop is in control; for example, input counts to amps for Current, input counts to speed units for 
Velocity, and input counts to position units for Position.

PWM & Direction

Allows the user to select from either PWM & Direction or Single Input PWM as the command 
source input type. The PWM & Direction command option consists of separate PWM (0-
100%) and Direction inputs, while the Single Input PWM option consists of only a single PWM 
input signal (Direction input connections are left unconnected). When using Single Input 
PWM, a duty cycle in the range of 0-50% will command motion in one direction, while a duty 
cycle in the range of 50-100% will command motion in the opposite direction. The PWM input 
signal for both command selections has a range of 1kHz to 125kHz.

Configuration allows for parameter setup and configuration of the PWM input signal.



MNDGACUG-06 18

Configuring the Drive / Configuration

• Scaling: Assigns the command input in terms of applicable user units that will be 
associated with 100% PWM duty cycle. This value may be positive or negative.

• Offset: The offset applied after logic polarity is interpreted. If this offset places the PWM 
input signal outside of the available range of 0-100%, the duty cycle will saturate at its 
limits. This value may be positive or negative.

• Invert PWM Logic: Inverts the logic polarity of the PWM input.
• Invert Direction Logic: Inverts the logic polarity of the Direction input. This option is only 

available for PWM & Direction type input.

Status allows for monitoring of the PWM input signal.

• Measured Value: The value measured at the digital input. This represents the duty cycle of 
the input. It does not reflect the polarity of the command.

• Commanded Value: The value after applying the specified logic polarity, offset, and unit 
scaling, measured in applicable user units.

Encoder Following

Selects the secondary encoder input to drive the motor in a master/slave configuration.

Input Type selects the type of input that will be used during Encoder Following.

• Auxiliary encoder will configure the drive to receive input commands from an auxiliary 
encoder.

• Virtual encoder will configure the drive to receive input commands via the 
communications channel.

Configure input scaling sets the number of quadrature input pulses desired to move the motor 
by a given number of output counts. If using an encoder for primary feedback, Input Counts 
represents the number of encoder counts to move. If using a resolver for primary feedback, 
Input Counts represents the number of resolver counts as determined by the specified resolver 
resolution. Values entered in either field may be positive or negative.

Interface Input

Used for RS-485/RS-232 as the command source.

Communication Channel

This command is assigned when the drive is being controlled by an outside source. This 
capability is available with network interface products. Selecting Communication Channel will 
display the current network settings. Clicking the Edit button will open the Network Settings 
window to change the network communication settings.

Do not connect to the drive in Read/Write mode while sending 
commands over the communication channel. Instead, connect to the 
drive in Read Only mode.
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DriveLibrary
Selecting this option will automatically configure the current project file to operate with 
DriveLibrary. DriveLibrary is a high-level API for developers of motion control solutions. The 
DriveLibrary API defines a collection of control functions that support the majority of motion 
control applications. DriveLibrary applications are written and developed in C++. Users should 
be familiar with the C++ language in order to properly develop motion control applications in 
DriveLibrary.

Selecting DriveLibrary as the Command Source will automatically configure the current 
project file to operate with DriveLibrary. The present network settings will be displayed with 
an Edit button to open the Network Settings window to change communication settings if 
desired.

Once DriveLibrary is selected, if necessary a list will appear containing a list of the drive 
parameters that need to be modified in order to configure the drive for operation with 
DriveLibrary. Selecting Apply will accept the changes, and the project file will automatically be 
configured for compatibility with DriveLibrary. DriveLibrary will not be assigned as the 
Command Source until the parameter requirements are met.

If any attempt is made to change a drive parameter that is required for compatibility with 
DriveLibrary (such as disabling the Position Loop) the setup software will provide a 
notification window alerting the user that continuing with that action will cause DriveLibrary 
compatibility to be lost, and the Command Source will be set to No Command.

3.1.2 Command Limiter
The Command Limiter allows you to limit the change in the input command signal as seen by 
the drive. The resulting effect is dependent on the operating mode. This is a command 
smoother, not a drive limiter. In other words, it will change how the command is seen by the 
drive, but if an event occurs which is not affected by the command, the drive will react 
according to drive limits. To change drive limits, see the Limits window.

The Command Limiter has a corresponding drive event, Command Limiter Active, that will be 
high (active) if the Command Limiter is enabled and the command is being actively limited by 
the Command Limiter settings. The state of this event is dependent upon the target value only 
and not the measured value. The Command Limiter parameters will change automatically 
depending on the current Loop configuration.

Current Mode
• Linear Ramp: Limits the jerk, or change in commanded current.

Velocity Mode
• Linear Ramp: Limits the acceleration and deceleration independently for positive and 

negative velocities.

Position Mode
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• Accel/Decel: Allows acceleration and deceleration limits to be set. Selecting Accel/Decel 
will also enable the Jerk Limiting feature.

Jerk Limiting
• The Jerk Limiting feature is available in Position modes when the Command Limiter is set 

to Accel/Decel.
• What is Jerk Limiting?

— Jerk is the third derivative of position, or the rate of change of acceleration. When a 
command is issued, rapid changes in acceleration occur which can cause wear and 
tear on the system’s components. Jerk limiting is needed to prevent any permanent 
damage from occurring.

— Most drive operating modes have no jerk limiting protection built in. Instead, a 
constant acceleration is used to get from one command to the next. Supplemental jerk 
limiting can be attached to the Command Limiter and found when using Position 
around Current and Position around Velocity.

— When using networks to command the drive (EtherCAT, CANopen, RS485, etc.) Profile 
Position mode will also be able to use the Jerk Limiting feature, since the Command 
Limiter is used for trajectory generation. For Cyclic Synchronous Position mode, jerk 
limiting must be provided by the master.

• How to Fix a Move
— The velocity target is put through a low pass filter, making the velocity trajectory 

follow an S-Curve. The smooth S-Curve motion of the velocity means that the 
acceleration is no longer constant, eliminating the negative consequences from high 
dynamic movements.

• How to Adjust Jerk Limiting
— The Jerk Limiting feature can be adjusted by changing a time value with units of 

milliseconds. This value is the time constant of the filter. A larger time constant 
increases the time needed to reach the velocity target, but creates smoother motion.
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3.2 Loop Feedback

The Loop Feedback window allows specification of which feedback device is used for the 
velocity and/or position loop. Open the Loop Feedback window by selecting [DriveName] > 
Loop Feedback in the System Browser.

For descriptions of the feedback parameters, see “Feedback Type” on page 25.

3.2.1 Velocity Feedback Source

For reference, see “Filtering Velocity Feedback” on page 117.

3.2.2 Position Feedback Source

Analog The velocity is derived from an analog input. Typically used in case of a motor mounted tachometer. The analog signal must 
be conditioned not to go outside the hardware limits of the drive (typically ±10V). Select which analog input to use, and 
configure the Scaling (ratio between the input voltage and the measured velocity) and Offset.

Network Interface The velocity is provided over the communication interface. Select which interface input to use from the available inputs.

FB1 - Incremental The velocity is derived from the motor mounted incremental encoder (Feedback 1 connector). The Polarity, Resolution, and 
Index selection can be defined in this window. Encoder configuration is also available in the Motor window.

FB1 - BiSS The velocity is derived from the motor mounted BiSS C-Mode absolute encoder (Feedback 1 connector). The BiSS encoder 
parameters can be defined in this window or on the Motor Parameters page.

FB2 - Incremental The velocity is derived from the motor mounted incremental encoder (Feedback 2 connector). The Polarity, Resolution, and 
Index selection can be defined in this window. Encoder configuration is also available in the Motor window. This selection is 
not available if Encoder Following is selected as the command source.

Halls The velocity is derived from the motor mounted Hall sensors. When configured for Hall velocity mode, the drive will define 1 
count to be equal to 1 hall state change (that is, a 4-pole motor has 12 counts per revolution).

Analog The position is derived from an analog input. Typically used in case of a load-mounted potentiometer. The analog signal 
must be conditioned not to go outside the hardware limits of the drive (typically ±10V). Select which analog input to use, and 
configure the Scaling (ratio between the input voltage and the measured position) and Offset.

Network Interface The position is provided over the communication interface. Select which interface input to use from the available inputs.

FB1 - Incremental The position is derived from the motor mounted incremental encoder (Feedback 1 connector). The Polarity, Resolution, and 
Index selection can be defined in this window. Encoder configuration is also available in the Motor window.

FB1 - BiSS The position is derived from the motor mounted BiSS C-Mode absolute encoder (Feedback 1 connector). The BiSS encoder 
parameters can be defined in this window or on the Motor Parameters page.

FB2 - Incremental The position is derived from the motor mounted incremental encoder (Feedback 2 connector). The Polarity, Resolution, and 
Index selection can be defined in this window. Encoder configuration is also available in the Motor window. This selection is 
not available if the incremental encoder pins on the Feedback 2 connector are assigned to other functions.
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3.3 Power-up Settings

The Power-up window ([DriveName] > Power-up) is used to configure certain software 
settings and parameters when the drive initially receives power.

Bridge Status Selecting Software Enable will issue an Enable command upon power-up. Depending on other 
software settings or external hardware faults, the drive may remain disabled.
Selecting Software Disable will issue a Disable command upon power-up.

Configuration Select Select the Configuration set the software will default to upon power-up.

Phase Detect Allows for the configuration of Phase Detect power-up settings. Under most circumstances, the 
appropriate setting is On First Enable Following Power-up. However, other options may be used 
depending on the configuration of your drive and motor.

Set Position Selecting the Set Position checkbox will set the value of the measured position and target position 
to the value defined in the Preset Position field defined in the active Gain Set window.

Motion Engine Selecting Enable will enable the Motion Engine upon power-up.
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3.4 Motor Parameters

The Motor Parameters window can be accessed by going to Motor > Parameters in the System 
Browser. The motor data is stored in:

• The drive
• The project file

The Motor Parameters window is where you will input the motor ratings, motor-specific data, 
feedback information, and commutation information. The values entered in the Motor 
Parameters window will have an effect on the values entered in the Limits window.

3.4.1 Motor Selection
From within the Motor window, enter the motor information based on a default template for a 
selected motor type.

• To enter the motor information:
— Select the Motor Type from the Select Motor drop-down options.
— Enter the information for both Manufacturer and Model (optional).
— Begin entering data in the Motor Parameters and Feedback Type fields (see “Motor 

Parameters” on page 23 and “Feedback Type” on page 25 for field descriptions).
— Once the motor and feedback information have been entered, click the Apply button 

in the toolbar. The motor information will now be saved in the project file.

Rotation Direction

The motor rotation direction can be selected independently of the motor and feedback 
selection. Changing the rotation direction will change the direction of the motor for a given 
command. Typically, the rotation direction is not determined during initial motor 
configuration, but is changed after commutation has been established.

3.4.2 Motor Parameters
Depending on the selected Motor Type, the information available for editing will change in the 
Motor Parameters field. Consult the motor datasheet to determine the appropriate values.

Motor Type The type of motor used. Selections for rotary motors are Brushed, Brushless, Stepper, and AC Induction. 
Selections for linear motors are Voice Coil and Linear Brushless.

Manufacturer The name of the motor manufacturer.

Model The motor model.
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Brushed, Brushless, Linear Brushless, Stepper, and Voice Coil Motor 
Parameters

AC Induction Motor Parameters

Motor Field Description
Cont Current The nominal (continuous) current that the motor can handle. The setup software will not allow the drive continuous current to be 

configured greater than this value.
(Note: The specified current is in units of Adc. For sinusoidally commutated motors, this is the peak of the sine wave through any 
phase of the motor within one electrical cycle. To calculate the RMS current, divide the DC value by 1.414. This calculation should not 
be used when the motor is commutated trapezoidally.)

Peak Current The peak operating current that the motor can handle. This does not correspond to the de-magnetizing current, which is typically 
much higher than the maximum operating current. The setup software will not allow the drive peak current to be configured greater 
than this value.
(Note: The specified current is in units of Adc. For sinusoidally commutated motors, this is the peak of the sine wave through any 
phase of the motor within one electrical cycle. To calculate the RMS current, divide the DC value by 1.414. This calculation should not 
be used when the motor is commutated trapezoidally.)

Max Speed Corresponds to the maximum rated speed of the motor. The setup software will not allow the drive positive velocity limit, negative 
velocity limit, or motor over speed to be configured greater than this value.

Motor Poles / 
Pole Pitch

(Brushless, Linear Brushless, and Stepper motors only) The number of poles, in case of rotary motors, corresponds to twice the 
number of electrical cycles per motor revolution. The pole pitch, in case of linear motors, corresponds to the length of one electrical 
cycle (360 degrees). The numerical value and units can be selected independently (the numerical value will NOT be automatically re-
calculated when a different unit is selected).

Motor 
Resistance

In case of Brushed motors it corresponds to the armature resistance. In case of Brushless motors it corresponds to the phase-to-
phase resistance.

Motor 
Inductance

In case of Brushed motors it corresponds to the armature inductance. In case of Brushless motors it corresponds to the phase-to-
phase inductance.

Motor Ke The voltage constant corresponds to the motor back-EMF constant. The numerical value and units can be selected independently 
(the numerical value will NOT be automatically re-calculated when a different unit is selected).

Motor Kt The motor torque (Brushless) or force (Brush) constant. The numerical value and units can be selected independently (the numerical 
value will NOT be automatically re-calculated when a different unit is selected).

Max Motor 
Temp

Maximum allowable motor temperature (recommended if using an analog input for motor temperature).

Motor Field Description
No Load 
Current

The no-load (magnetizing) current as specified by the motor manufacturer.

Peak Current The peak operating current that the motor can handle. This does not correspond to the de-magnetizing current, which is typically 
much higher than the maximum operating current. The setup software will not allow the drive peak current to be configured greater 
than this value.
(Note: The specified current is in units of Adc. For sinusoidally commutated motors, this is the peak of the sine wave through any 
phase of the motor within one electrical cycle. To calculate the RMS current, divide the DC value by 1.414. This calculation should not 
be used when the motor is commutated trapezoidally.)

Max Speed Corresponds to the maximum rated speed of the motor. The setup software will not allow the drive positive velocity limit, negative 
velocity limit, or motor over speed to be configured greater than this value.

Rated Speed The rated speed as specified by the motor manufacturer.

Motor Poles For rotary AC induction motors, the number of motor poles as specified by the motor manufacturer. For linear AC induction motors, 
the distance required for one electrical cycle.

Connection Specifies the type of connection used for the motor ratings.

Base 
Frequency

The rated frequency for base speed as specified by the motor manufacturer.

Rated Voltage The rated motor voltage as specified by the motor manufacturer.
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3.4.3 Feedback Type
The Feedback Type area holds information about the motor feedback device. The feedback 
device and parameters listed will be dependent on the drive model and the firmware currently 
used in the drive.

• The primary feedback device will be shown along with the configurable parameters.
• For universal feedback drives, the present primary feedback device will be shown as a 

selection option.
— To change the primary feedback device, choose the new type of feedback from the 

selections. A message will appear stating that a firmware change is required to 
support the selected feedback device. Click ’OK’ to open the Firmware Download 
window to download the required firmware into the drive.

— Once the download is complete, return to the Motor window, and the primary 
feedback device will reflect the firmware change.

The parameters for each type of feedback device are as follows:

Incremental Encoder Feedback Parameters 

Absolute Encoder (EnDat® 2.2) Feedback Parameters

Max Motor 
Temp

Maximum allowable motor temperature (recommended if using an analog input for motor temperature).

Motor Power Motor power as specified by the motor manufacturer.

Phase 
Parameters

Selects either Equivalent Circuit or Name Plate Parameters. The selected item will display the phase parameters associated with that 
item.

Equivalent Circuit
- R1: as determined by the motor’s equivalent circuit model
- R2: as determined by the motor’s equivalent circuit model
- X1: as determined by the motor’s equivalent circuit model
- X2: as determined by the motor’s equivalent circuit model
- Xm: as determined by the motor’s equivalent circuit model

Name Plate Parameters
- Stator Resistance: The stator transient resistance as specified by the motor manufacturer.
- Stator Transient Inductance: The stator transient inductance as specified by the motor manufacturer.

Power Factor The power factor as specified by the motor manufacturer.

Efficiency The motor efficiency as specified by the motor manufacturer.

Field Description
Commutation 
Polarity

Represents the polarity of the feedback device signal used for commutation. Autocommutation will determine 
Commutation Polarity.

Feedback 
Polarity

Represents which rotation direction corresponds to an increase in feedback device counts. Feedback Polarity can 
be used to change this rotation direction without affecting commutation.

Resolution Represents the lines per revolution (lines/rev) for a rotary motor, or the lines per distance (lines/in or lines/mm, 
depending on the units selected for pole pitch) for a linear motor.

Index / Ref 
Marker

Indicates if there is an encoder index pulse.

Motor Field Description
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For EnDat 2.2 encoders, specify the data width, then enter the resolution. Entered data width 
should match the encoder resolution specified on the encoder datasheet. The resolution fields 
are the number of bits used of the corresponding data width.

Absolute Encoder (BiSS C-Mode) Feedback Parameters

For BiSS C-Mode encoder parameters, it is recommended to begin with selecting the 
manufacturer of the BiSS encoder in use from the Data Format drop-down menu. Verify the 
parameters match the values given in the manufacturer’s encoder datasheet.

BiSS C-Mode Advanced Fields

By default, the Advanced fields are hidden from view as they should not be edited when using a 
standard manufacturer template. To view these fields, select the Advanced check box in the 
Feedback Type panel. Note that the values entered are subject to the following requirements:

— The sum of the Single- and Multi-Turn Data Widths cannot exceed 64.
— The Single-Turn Resolution cannot be greater than the Single-Turn Data Width.

Field Description
Multi-Turn 
Resolution

Enter the Multi-Turn Resolution of the EnDat 2.2 encoder.

Single-Turn 
Resolution

Enter the Single-Turn Resolution of the EnDat 2.2 encoder.

Commutation 
Polarity

Represents the polarity of the feedback device signal used for commutation. Autocommutation will determine 
Commutation Polarity.

Feedback 
Polarity

Represents which rotation direction corresponds to an increase in feedback device counts. Feedback Polarity can 
be used to change this rotation direction without affecting commutation.

Multi-Turn Data 
Width

Encoder Multi-Turn Data Width (this is the bit resolution specified by the manufacturer).

Single-Turn 
Data Width

Encoder Single-Turn Data Width (this is the bit resolution specified by the manufacturer).

Total Number 
Of Bits Used

This field displays the total number of bits used. This field cannot be changed. The total number of bits is limited 
to 31.

Single-Turn 
Reserved Bits

Specifies the number of bits within the Single-Turn data field that are reserved to be zero.

Multi-Turn 
Reserved Bits

Specifies the number of bits within the Multi-Turn data field that are reserved to be zero.

Field Description
Multi-Turn 
Resolution

Enter the Multi-Turn Resolution of the BiSS encoder. The graphic in the Feedback Type panel will update with the 
corresponding bit usage.

Single-Turn 
Resolution

Enter the Single-Turn Resolution of the BiSS encoder. The graphic in the Feedback Type panel will update with 
the corresponding bit usage.

Polarity Represents the polarity of the BiSS encoder.

Data Format Select from the list of BiSS C-Mode encoder manufacturers to auto-populate manufacturer-specific standard 
encoder parameters.

Pre-Trigger 
Value

Some BiSS-C encoders have a longer delay between the start of the first clock and the return of the first bit of the 
data frame. Changing the Pre-Trigger Value allows the drive to wait longer for the first bit of data. Known 
examples of encoders to require a non-zero value are Celera/Zettlex IncOders. It is recommended for all other 
encoders to use a value of zero.
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— The Multi-Turn Resolution cannot be greater than the Multi-Turn Data Width.
— The Single-Turn Resolution cannot be greater than 31.
— The sum of the Single- and Multi-Turn Resolutions cannot exceed 31.
— The recommended selection for Encoder Clock Frequency is 5MHz.
— The Single-Turn Reserved Bits value specifies the number of bits within the Single-

Turn data field that are reserved to be zero. The value must not exceed 8.

The Multi-Turn Reserved Bits value specifies the number of bits within the Multi-Turn data field 
that are reserved to be zero. The value must not exceed 8. 

Tamagawa/Nikon Envoder Feedback Parameters

For Tamagawa encoders, specify the data width, then enter the resolution. Entered data width 
should match the encoder resolution specified on the encoder datasheet. The resolution fields 
are the number of bits used of the corresponding data width.

Note that values entered are subject to the following requirements: 

— The Single-Turn Resolution cannot be greater than the Single-Turn Data Width.
— The Multi-Turn Resolution cannot be greater than the Multi-Turn Data Width.
— The sum of the Single-Turn and Multi-Turn Resolutions cannot exceed 31.

Unknown Single-Turn Resolution:

If the single-turn Data Width of the encoder is unknown, set the Single-Turn Resolution to the 
same value as the Single-Turn Data Width. Then, turn the motor one revolution while 
monitoring the position measured. The number of counts will correspond with the actual 
Single-Turn Data Width. E.G., If setting a value of 15-bits in each field and measuring 131,072 
counts per revolution, the encoders single-turn Data Width is 17-bits.

Field Description
Multi-Turn 
Resolution

Enter the Multi-Turn Resolution of the Tamagawa/Nikon encoder.

Single-Turn 
Resolution

Enter the Single-Turn Resolution of the Tamagawa/Nikon Encoder.

Multi-Turn Data 
Width

Encoder Multi-Turn Data (this is the bit resolution specified by the manufacturer).

Single-Turn 
Data Width

Encoder Single-Turn Data Width (this is the bit resolution specified by the manufacturer).

Total Number of 
Bits Used

This field displays the total number of bits used. This field cannot be changed. The total number of bits is limited 
to 31.
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3.4.4 Commutation
The commutation section allows configuration of basic commutation settings. The available 
settings will depend on the type of motor and feedback in use:

3.4.5 Braking
The Brake checkbox allows a brake to be assigned with an event action. The brake can be 
assigned to a digital output in the Inputs/Outputs window. Checking r unchecking the Brake 
checkbox may result in certain event actions changing. Look in the Advanced Events window 
to view the assignments. The following event actions will be affected:

• When "Brake" is checked, events configured for "Disable Bridge" or "Dynamic Brake" will 
be changed to "Apply Brake and Disable Bridge" or "Apply Brake and Dynamic Brake", 
respectively.

• When "Brake" is unchecked, events configured for "Apply Brake and Disable Bridge" or 
"Apply Brake and Dynamic Brake" will be changed to "Disable Bridge" or "Dynamic Brake", 
respectively.

In addition, the brake output can be configured to use delays between external braking and 
enabling/disabling the drive. This delay is designed to prevent loads from falling or coasting 
when the effects of gravity or other external forces are seen in the system. 

Field Description
Commutation 
Sensors (Halls)

Indicates that commutation sensors are to be used.

Commutation 
Angle

Selects the Hall phasing angle. Note that the Hall phasing angle will be automatically selected after running 
AutoCommutation. If the Hall sensor phasing differs from 60º or 120º by more than 10 electrical degrees, "Other" 
will be automatically selected.

Trapezoidal / 
Sinusoidal

Selects between Trapezoidal or Sinusoidal commutation. Trapezoidal is disabled for Resolver and Absolute 
Encoder feedback, and is only enabled for other types of feedback if Commutation Sensors is checked and a valid 
Commutation Angle of 60º or 120º is selected.

Reset 
Commutation

Reset Commutation is used primarily for systems unable to complete AutoCommutation that need commutation 
angles set to known good angles.
- If the existing commutation setting is 120º, Reset Commutation will reset the commutation angles to the drive 
default angles for 120º phasing.
- If the existing commutation setting is 60º, Reset Commutation will reset the commutation angles to the drive 
default angles for 60º phasing.
- If the existing commutation setting is "Other", Reset Commutation will change the commutation angle to 120º 
and reset the commutation angles to the drive default angles for 120º phasing.

External 
Commutation 
Between 
Phases

Selects the two phases the drive will output current to when using a brush type motor.

Field Description
Brake Applied 
Delay

Delay after applying external brake before disabling power bridge or performing dynamic braking.

Brake Released 
Delay

Delay before releasing external brake after enabling power bridge or discontinuing dynamic braking.
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3.4.6 Motor Database
The Motor Database allows motor information to be saved and stored in a database for 
convenient access. Motor information can be saved directly from the Motor Parameters 
window, or imported via an .XML file. Motor information from the database can also be 
exported as an .XML file. Importing and exporting of motor information is accomplished in the 
Tools > Manage Motor Database Menu Bar window.

• To save motor information:
— Enter the motor information into the Motor Parameters window.
— Click the Save button in the Motor Database pane.
— The motor information is now stored in the User Database section in the Motor 

Database.
— The Motor Database is saved in the default installation folder where the "My Projects" 

folder is located.
• To select and load previously saved motor information:

— Click the Select button in the Motor Database pane.
— In the Motor Database Selection window that opens, expand the heading of the User 

Database category.
— Motors are organized in the following structure: [Database Name] > [Manufacturer] > 

[Model]. Locate the desired motor, and click Select at the bottom of the Motor 
Database Selection window.

— The desired motor information will auto-populate into the Motor Parameters fields.
• To edit previously saved motor information:

— Load the desired motor information as described above.
— Modify fields in the Motor Parameters window. Do not change the Manufacturer or 

Model fields. Changing these will save the information as a separate motor in the 
database.

— Click the Save button in the Motor Database pane.
— The motor information in the database will be updated with the new changes.

Manage Motor Database   The Manage Motor Database window is used to import, export, 
and delete motor information from the Motor Database. Motor information is imported or 
exported in .XML file format.

Contact the setup software manufacturer for assistance in creating an .XML file that is 
compatible with the Motor Database.

Import

Allows an .XML file that contains motor parameters for one or more motors to be imported 
into the Motor Database. Click Import, then navigate to the .XML file in the window that opens. 
The imported information will then be saved in the User Database section of the Motor 
Database.

Export

Creates an .XML file that contains motor parameters from the Motor Database. Check the box 
for the desired motor from the available options, and then click Export to choose the save 
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location of the .XML file. Note that information for multiple motors can be exported into the 
same .XML file.

Delete

Deletes one or more motor database entries. Check the box(es) for the motor entry to be 
removed from the database, then click Delete. Click OK in the warning prompt to delete the 
motor entry.
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3.5 AutoCommutation

The AutoCommutation routine detects the motor feedback type and polarity, and then 
configures the drive commutation parameters appropriately.

Before running AutoCommutation:

• Enter in the correct motor information in the Motor Parameters window.
• Specify the correct feedback information.
• Specify limits to protect the motor.
• Tune the current loop.
• De-couple the motor from any load and secure the motor. Sudden motion will occur!

If you have not done the preceding, see the corresponding sections in this manual.

See “AutoCommutation™” on page 61 for information on how to run the AutoCommutation 
routine.
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3.6 Encoder Output

Certain drive models that support a 1Vp-p Sin/Cos encoder or Absolute encoder feature either 
a Buffered Encoder Output or an Emulated Encoder Output that emit a 5V square wave that 
can be used to synchronize the command to other axes or to close the position loop. The 
buffered encoder output has a 1:1 input-to-output ratio, while the emulated encoder input-to-
output ratio is configurable.

The Divide Amount field sets a value by which the interpolated encoder resolution is divided to 
get the emulated encoder output resolution (counts/rev). The Emulated Index Position field 
allows you to specify an absolute position for the output index relative to the emulated output 
counts. Additionally, you may select to have this index repeat for every specified number of 
output counts in the Emulated Index Period field. The index period is specified as the number 
of emulated counts between emulated indices. The index period must be zero, or divisible by 4. 
If zero is used, the effective period will be 232 emulated counts.

For Sin/Cos feedback, the emulated output will be re-initialized each time the absolute 
position of the drive is initialized (i.e. via homing, Set Position, etc.). Until the drive position is 
initialized, no emulated index will be output by the drive.

For certain drive models that support resolver feedback, the emulated output will match the 
resolver resolution setting. For example, selecting Low Resolution (12-bit) will give an 
equivalent 212 (4096) counts/rev at the output. There will be a small phase lag between the 
sinusoidal feedback to the drive and the emulated output due to the time required to process 
the emulated signal.
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3.7 Inputs / Outputs

Inputs / Outputs allows configuration and diagnostics of all digital and analog programmable 
inputs and outputs.

The following tabs are available:

• Analog Inputs
• Analog Outputs
• Digital Inputs
• Digital Outputs

3.7.1 Analog Inputs
Each programmable analog input can be assigned a certain drive function through the 
Command, Feedback, or Limits windows. When a function is assigned to an analog input, the 
Analog Inputs window will display the assignment, the configuration settings, and the 
currently measured value. Analog Inputs cannot be assigned to a function in the the Analog 
Inputs window.

Check the drive datasheet to find the number of available analog inputs.

Each assigned input can be scaled, according to the selected function, to provide an optimal 
range by entering a value in the "Scale" column. Entering the numerical value of the chosen 
function for a 1V input signal performs the scaling. An offset (in volts) can also be defined.

A programmable deadband can be configured for 
analog inputs assigned to the command source. The 
deadband sets a voltage range which will have no 
effect on the command. This is particularly useful 
when the analog command source is configured to 
control velocity.

The drive handles anything within the deadband 
range as zero, and subtracts the deadband value 
from all other values. For example, with a deadband 
setting of ±100 mV, the drive ignores any signal 
between -100 mV and +100 mV.

Selections become effective after clicking the Apply button.
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3.7.2 Analog Outputs
Each programmable analog output can be assigned to a certain drive variable.

Each output can also be scaled, according to the selected variable, to provide an optimal range. 
Entering the numerical value of the chosen variable for a 1V output signal performs the 
scaling. An offset (in volts) can also be defined.

Check the drive data sheet to find the number of available analog outputs. A list of available 
output signals and their definitions can be found in “Signal Definitions” on page 95.

3.7.3 Digital Inputs
To assign a function to a digital input, drag-and-drop one or more functions from the Input 
Functions field to the desired digital input in the Input Assignments field. High Speed Capture 
functions may only be assigned to High Speed (HS) digital inputs, while other functions may be 
assigned to either General Purpose (GP) or High Speed digital inputs. The Capture Panel 
allows configuration of High Speed Capture functions once they have been assigned to a High 
Speed input.

The present status of each input is displayed by the LED graphic beside each digital input 
number (clear = Not Active, green = Active). The Active column displays the input polarity. 
Active Low means the input must be pulled-down for the input to be considered ON. Set the 
input polarity by selecting either the Active Low or Active High button at the bottom of the 
window. Each input can be assigned to one or more functions. If more than one function is 
assigned to a single input, the following priority rules apply (from highest to lowest):

1. Inhibit
2. Dynamic brake
3. Positive or negative limit
4. Phase Detection

The User Disable, User Aux Disable, and the Motor Over Temperature functions depend on the 
selected Action in the Events windows.

Functions can be removed from a digital input by highlighting the selected function, then 
hitting Delete on the keyboard, or the  button in the Digital Inputs window.

Selections become effective after clicking the Apply button.

Selections become effective after clicking the Apply button.

Note

Note
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Capture Panel

Digital Input Definitions

Captured Signal This field shows the selected signal to be captured.
Captured Value This shows the last value captured by the drive.
Trigger Edge You may select between Rising, Falling, or Both to set when the signal will be 

captured.
Trigger Mode Single mode will allow the signal to be captured only once per set/reset. 

Continuous will allow the signal to be captured any time it is triggered while 
capture is set.

Set / Reset Input Displays the Digital Input assigned to reset the capture signal.

User Disable (Level Sensitive) Disables the drive. User Disable can be set to either Disable 
Power Bridge or Dynamic Brake in the Advanced Events window. The default 
configuration assigns Disable Bridge to this function.

Use Aux Disable (Level Sensitive) Disables the drive. User Aux Disable can be set to either 
Disable Power Bridge or Dynamic Brake in the Advanced Events window. The 
default configuration assigns Dynamic Brake to this function.

User Stop (Level Sensitive) Activates the User Stop event. When User Stop is active, the 
drive will issue a Stop command to halt motor motion.

User Positive Limit (Level Sensitive) Activates the User Positive Limit event. User Positive Limit 
can be set to either Positive Stop or Disable Positive Direction in the Events 
window to cease motor motion in the positive direction. The default 
configuration assigns Positive Stop to this function.

User Negative Limit (Level Sensitive) Activates the User Negative Limit event. User Negative Limit 
can be set to either Negative Stop or Disable Negative Direction in the Events 
window to cease motor motion in the negative direction. The default 
configuration assigns Negative Stop to this function.

Motor Over Temp (Level Sensitive) Activates the Motor Over Temperature event. Motor Over 
Temperature can be assigned to a number of different setup software safety 
actions to prevent the motor from over-heating. The default configuration 
assigns Bridge Disable to this function.

Phase Detect (Edge Sensitive) Activates the Phase Detect routine. Phase Detect is a 
function used to initialize the correct commutation angle for brushless motors 
lacking commutation sensors. The drive can be configured to run Phase Detect 
automatically on power-up in the Power-up window.

Zero Position Error (Edge Sensitive) When triggered, a pulse command is sent to the position 
target, setting it equal to the measured position. Note: if the position command 
source is an absolute source such as an analog input, the target position will 
immediately be overwritten by the command source with the next position loop 
update.
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Set Position (Edge Sensitive) When triggered, a pulse command is sent to both the position 
measured and position target, setting both equal to the value defined in the 
“Preset Position” field within the position gain set. Note: if the command source 
and/or position feedback device is an absolute device such as an analog input, 
the target position and/or measured position will immediately be overwritten 
with the next position loop update.

Home Execute (Edge Sensitive) Enables and initiates the selected Home routine. Note: If the 
Motion Engine is not enabled, this input must remain active until the homing 
procedure is completed.

Home Switch (Edge Sensitive) Acts as a Home Switch when a compatible homing routing is 
selected.

Reset Events (Edge Sensitive) When triggered, latching and history status events are reset. 
Note: Certain critical events cannot be reset via the digital input, and instead 
require a drive reset or network commands to reset. These events are: Drive 
Internal Error, Current Overshoot, Parameter Store Error, and Parameter 
Restore Error, Phase Detection Failure, Software Disable.

Configuration Select (Edge Sensitive) Changes the active configuration when two configurations are 
used. Falling Edge = Configuration 0. Rising Edge = Configuration 1.

Gain Select (Edge Sensitive) Changes the active gain set when two gain sets are used. 
Falling Edge = Configuration 0. Rising Edge = Configuration 1.

Motion Execute (Edge Sensitive) When triggered, the selected Index or Sequence will initiate 
(depending on whether the drive is in Indexer or Sequencer mode). Note: the 
motion engine must be enabled before the drive will respond to this function.

Motion Select 0,1,2,3 (Level Sensitive) Defines the selected Index or Sequence (depending on 
whether the drive is in Indexer or Sequencer mode). Represents a binary 
number allowing up to 16 Indexes or Sequences to be independently selected. 
Motion Select 0 represents the least significant bit with Motion Select 3 
representing the most significant bit. Active = 1. Inactive = 0. The Motion 
Engine must be enabled before motion can be executed.

Motion Enable (Edge Sensitive) Enables the Motion Engine. The Motion Engine must be 
enabled before Indexes or Sequences can be executed.

Motion Mode (Edge Sensitive) Toggles the drive between Indexer or Sequencer mode. 
Active = Sequencer; Inactive = Indexer.

Motion Reset (Edge Sensitive) Resets the Motion Engine when a Motion Engine fault has 
occurred.

Jog Select 0, 1 (Level Sensitive) Defines the selected jog velocity when jogs are used. 
Represents a binary number allowing up to 4 jogs to be independently 
selected. Jog Select 0 represents the least significant bit with Jog Select 1 
representing the most significant bit. Active = 1. Inactive = 0. The Motion 
Engine must be disabled before jogging can be executed.

Jog Forward (Edge Sensitive) Activates the selected Jog speed in the forward direction. The 
Motion Engine must be disabled before jogging can be executed.

Jog Reverse (Edge Sensitive) Activates the selected current Jog speed in the reverse 
direction. The Motion Engine must be disabled before jogging can be executed.
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3.7.4 Digital Outputs
To assign a function to a digital output, drag-and-drop one or more functions from the Output 
Functions field to the desired digital output in the Output Assignments field.

The present status of each output is displayed by the LED graphic beside each digital output 
number (clear = Not Active, green = Active). The Active column displays the output polarity. 
Active High means the output is pulled-down if the output is considered OFF. Set the output 
polarity by selecting either the Active Low or Active High button at the bottom of the window.

Each output can be assigned one or more functions. If more than one function is assigned to a 
single output, the functions are OR-ed, which means that if one of the functions is true, the 
output will be turned ON. Functions can be removed from a digital output by highlighting the 
selected function, then hitting Delete on the keyboard, or the  button in the Digital Outputs 
window.

3.7.5 Extended I/O
Certain drive models allow the allocation of additional external digital and analog I/O beyond 
the standard number of I/O pins available on the drive hardware. The I/O Allocations pane in 
the Inputs / Outputs > Extended I/O window determines the number of drive I/O that will be 
assigned for external I/O expansion. Selecting a value in the drop-down combo boxes will 
automatically assign pre-determined drive I/O for expansion purposes, and the approriate 
I/O will appear labeled as such in the Digital I/O windows. Attempting to assign a drive action 
or event to I/O that is allocated for external I/O expansion will bring up a dialog box warning 
of the I/O resource conflict. For more information on expanded I/O capabilities, please contact 
technical support.

3.7.6 Programmable Limit Switch
The setup software is configurable to support two independent programmable limit switch 
(PLS) outputs. These allow the drive to activate digital outputs that are position dependent. The 
pulse time and repeatability are configurable. The following requirements must be met before 
the PLS outputs can be used:

• A free digital output must be available to be assigned to the PLS function.
• A compatible position loop feedback device must be configured and connected. The 

position loop does not need to be closed.
• An absolute position must be defined. If using an incremental encoder to close the position 

loop, an absolute position can be set using Homing or the Set Position function.

It is recommended to use the setup software to configure the PLS function. It is also possible to 
configure using direct network commands. For more information on PLS configuration using 

Selections become effective after clicking the Apply button.

Note
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network commands, refer to the appropriate communication manual for the supported 
network type.

Programmable Limit Switch Parameters
Field Description

Source Allows selection of either Position Demand or Position Measured as the input signal to the PLS outputs.

Rollover Selecting the Rollover checkbox will place the PLS outputs in Rotary Mode, and allow the configuration of a Rollover Count value (in user 
units) that specifies the position value at which the PLS position counter will return to zero. In Rotary Mode, the following requirement 
must be met:
0 < Lower Edge < Upper Edge < Rollover Count

Level Specifies the active polarity of the digital output(s) mapped to the PLS

Direction Specifies the direction of motion that will trigger the PLS function (rising edge sensitive). Selecting Bidirectional will trigger the PLS in both 
rising edge Forward and rising edge Reverse directions.

Type Sets the width of the PLS pulse to be either Position or Time based.
When configured for Position, the pulse width is defined by the position values entered in the Lower Edge and Upper Edge fields.
When configured for Time, the pulse width is defined by the time value entered in the Pulse Time field. For a single trigger that occurs at 
the same location regardless of direction, set the Lower Edge and Upper Edge fields to the same value. For different trigger locations 
depending on direction, set the Lower Edge to be the trigger position for the forward direction, and the Upper Edge to be the trigger for the 
reverse direction.

Lower Edge Starting location for the PLS pulse (position user units).

Upper Edge Ending location for the PLS pulse when position based, or a separate directional pulse when time based (position user units)

Pulse Time Sets a fixed time width of the PLS pulse when time based.

Repeats Sets the number of pulses to be repeated. Selecting the Infinite checkbox will cause the PLS pulse to continue repeating until the Rollover 
Count is reached (in Rotary Mode) or the maximum allowable position value is reached (in Linear Mode).

Repeat Delta Sets the distance between repeated pulses (position user units). Note that when specifying a repeat pattern, the following requirement 
must be met:
(Lower Edge + Repeat Delta) > Upper Edge

The parameters for PLS1 and PLS2 will become active when the Source 
signal has been chosen and the Enable checkbox for the respective PLS 
output has been selected.

Note
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3.8 Limits

Limits allows configuration of general drive parameters.

The following selections are available regardless of which loops are enabled:

• Current
• Velocity
• Position
• Stop
• Voltage
• Temperature

3.8.1 Current Limits
Use this window to set the drive output current limits within the hardware capabilities of the 
drive.

The drive can output its rated peak current for a maximum of 2 seconds with a foldback time 
within 10 seconds. This defines the maximum current capability curve. Current profiles that 
intersect with the maximum current capability curve will be limited to stay within this 
envelope.

The specified current is in units of peak current. This is the peak value 
allowed to go through any phase of the motor within one electrical 
cycle. To calculate the RMS current, divide the peak value by 1.414. This 
calculation should not be used when the motor is commutated 
trapezoidally. For an in-depth explanation of how the drive limits current, 
see “Current Limiting” on page 101.

Peak Current Maximum output current (limited output time).

Peak Current Time The maximum time duration of peak current.

Continuous Current The maximum continuous current level the drive will output.

Foldback Time The time the drive will use to reduce the current to the continuous current level setting.

Current Limiting Algorithm Selects between Time-Based Limiting or RMS Charge-Based Limiting (for supported drive models 
only). RMS Charge-Based Limiting will allow the drive to output more continuous current during 
motor movement. See “Current Limiting Algorithm” on page 105 for detailed information on current 
limiting.

Current Limit Scaling 
Source

You may assign an input to change the current limit dynamically. The scaling value can be adjusted 
in the I/O Configuration window (see “Inputs / Outputs” on page 33).

Note
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3.8.2 Velocity Limits
The following velocity-related limits can be set:

3.8.3 Position Limits
The following position-related limits can be set:

Note that position limits will be ignored during homing routines. This setting can be changed 
via network commands.

3.8.4 Stop
The Stop window configures software deceleration behavior. This field controls the 
deceleration limit for all stop actions and direction stops. If the drive is controlling velocity or 
position, the load decelerates according to the user-defined deceleration limit. If the drive is 
controlling current, the drive will command zero current with no deceleration control.

Events that trigger the Stop function can be configured in “Events” on page 44. Be sure to use 
deceleration values that are realistic and physically possible given the system constraints. For 
example, the more inertia a motor has, the longer it will take to stop. If you try to use limits that 
are not physically possible, the motor may move unpredictably during the deceleration period.

Motor Over Speed The maximum speed in which the motor should be able to go. The action following a motor overspeed event can be defined 
in Event Manager (active in all operating modes).

Zero Velocity Window The measured velocity values, within which the motor is considered to be at zero velocity (active in all operating modes).

At Velocity Window The "At Velocity" event will be set when the measured velocity reaches the target velocity, within the "At Velocity" window 
(active in velocity mode only).

Velocity Following Error The maximum allowed velocity error (difference between target velocity and measured velocity), prior to setting the "Velocity 
Following Error" event (active in velocity mode only).

Positive Velocity Limit The maximum allowed demand velocity in the positive direction (active only when the velocity loop is closed).

Negative Velocity Limit The maximum allowed demand velocity in the negative direction (active only when the velocity loop is closed).

In-Home Position Window Defines a window around the Home Position Value, such that when the measured position is within 
this window, the In Home Position event will be active.

In-Position Window Defines a window around the target position, such that when the measured position is within this 
window, the At Command event will be active.

Position Following Error 
Window

The maximum allowed position error (difference between target position and measured position) 
prior to setting the "Position Following Error" event (active in position mode only).

Max Measured Position 
Limit

Maximum allowed measured position. The Max Measured Position event will become active if the 
measured position exceeds this value.

Min Measured Position 
Limit

Minimum allowed measured position. The Min Measured Position event will become active if the 
measured position exceeds this value.

Max Target Position Limit Maximum allowed target position. The Max Target Position event will become active if the target 
position exceeds this value.

Min Target Position Limit Minimum allowed target position. The Min Target Position event will become active if the target 
position exceeds this value.

Disable Position Limits 
Checkbox

Allows you to disable position limits so the motor has no maximum or minimum position value.
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3.8.5 Voltage Limits
Use this window to set the User Under- and Over-Voltage limits. These limits are restricted to 
fall within the hardware capability of the drive. The Nominal DC Bus Voltage should contain the 
normal operating DC voltage supplied to the drive. If using an AC input drive, the Nominal DC 
Bus voltage is equal to the AC voltage multiplied by 1.41.

Shunt regulator operation

The shunt regulator (if available, depending on drive model) can be enabled/disabled and its 
turn-on voltage can be set at any given voltage below the hardware over-voltage limit of the 
drive. The internal shunt resistor parameters, if present, are displayed.

If the drive has provision for connection of an external shunt resistor, the parameters for that 
resistor can be entered. If that provision is not available, these fields will not be available. Check 
the data sheet for your drive to see if an external shunt resistor can be connected.

The shunt regulator method is used to dissipate excess energy during periods of rapid 
deceleration. In most cases, this energy can be consumed in a matter of milliseconds. If a 
longer regeneration time is needed, the drive will limit the output to the resistor according to 
the following information.

• Measured Bus Voltage
• Shunt resistor Power
• Shunt resistor Resistance
• Shunt resistor Inductance (if unknown, use zero)

If the stated resistor power or resistance is incorrect, the drive cannot 
reliably regulate the power dissipated.

There is a limit to the amount of current the drive can output to the shunt 
without damaging the circuitry. The resistance of the external resistor 
should be large enough to handle this current. Follow the table below to 
determine the absolute minimum resistance that the shunt circuitry can 
handle.

Drive Power Module  Minimum Shunt Resistance (Ohms)
015A400 N/A

030A400 20

060A400 10

100A400 10

030A800 Consult Factory

060A800 40

C060A400 20

C100A400 25

Note
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External shunt resistor power selection

During a regenerative event, the shunt output will initially turn on for 10ms, and the entire bus 
voltage is placed across the shunt resistor to allow the excess bus voltage to fall below the 
shunt enable threshold during normal regeneration.

After this initial pulse, if the bus voltage is still higher than the shunt turn on voltage, the shunt 
output will turn on and off rapidly in order to regulate the power dissipated. For both external 
and dual shunt modes, the on time and period are adjusted such that the shunt is on for 
approximately 3 time constants while maintaining the same duty cycle. The highest duty cycle 
attainable is 50%. The drive sets the on-time PWM output to a duty cycle such that:

Vbus = measured bus voltage (Vdc)
R = shunt resistance (ohms) - specified in setup software for 

external shunt
Pmax = maximum shunt power (W) - specified in setup software for 

external shunt
DC = PWM duty cycle

The period of the PWM output is set as [Vbus
2/(R * Pmax)] * Ton, with Ton=2/Fs, where Fs is the 

switching frequency of the drive (Hz). The average current going through the shunt resistor 
will be less than or equal to Vbus/2R. The average power through the shunt resistor during 
this time will be less than or equal to (Vbus)2/4R.

This initial turn-on is independent of the shunt resistor information entered; 
therefore the power dissipated through your shunt resistor may exceed 
the rated power during the first 10ms. If using an external shunt resistor, 
be sure the resistor can handle this 10ms pulse.

Vbus
2

R
----------- DC Pmax=
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3.8.6 Temperature Limits
The Temperature Limits tab allows configuration of an external temperature sensor. 
Configuration options are dependent upon the specific drive hardware. Certain drives accept 
an external temperature sensor in the form of either a switch or a thermistor. Use the "Sensor 
Type" pull down list to select the type of sensor in use.

Switch

For applications using a switch as an external temperature sensor, select whether the Motor 
Over Temperature event will occur when the switch is open or closed.

Thermistor

For applications using a thermistor as an external temperature sensor, input the resistance 
value when Motor Over Temperature will activate, and at what resistance Motor Over 
Temperature will become inactive. Acceptable input values range from 0 to 5000 . Both 
negative thermal coefficient (NTC) and positive thermal coefficient (PTC) thermistors are 
supported. The setup software will automatically determine the thermistor type based on the 
values entered in the Event Action fields.

If the Event Action Active Level is greater than or equal to the Event Action Inactive Level, then:

• The Motor Over Temperature event will turn on when the resistance becomes higher 
than the Event Action Active Level.

• The Motor Over Temperature event will turn off when the resistance becomes lower than 
the Event Action Inactive Level.

If the Event Action Active Level is set less than the Event Action Inactive Level, then:

• The Motor Over Temperature event will turn on when the resistance becomes lower than 
the Event Action Active Level.

• The Motor Over Temperature event will turn off when the resistance becomes higher 
than the Event Action Inactive Level.

Other drives are capable of accepting an analog temperature sensor that can be connected to 
an analog input of the drive. You can configure a maximum allowable motor temperature at 
which point the drive will be disabled. The motor temperature level at which the drive can be 
re-enabled can also be configured. For a digital temperature sensor, see the digital inputs 
section of “Inputs / Outputs” on page 33.
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3.9 Events

The Basic and Advanced Events windows let you configure or review actions associated with 
certain drive events. For a full list of drive events and recommended troubleshooting methods, 
see “Events and I/O Descriptions and Troubleshooting Methods” on page 121.

The diagrams below illustrate the behavior of an event and the corresponding event action.

The Event Actions that can be assigned to drive events are as follows (note that not all event 
actions are available for each event):

Event Action Description
No Action Event Action is disabled

Disable Power 
Bridge

No power is delivered to the motor. Motor is allowed to move freely.

Disable Positive 
Direction

Disables the drive from outputting to the motor in the positive direction, while allowing commanded motion in the negative 
direction. The result is dependent on the mode of operation. This action is not recommended in vertical applications because 
the load will be free to fall once the limit is activated. For vertical loads, we recommend using 'Positive Stop'.

Disable Negative 
Direction

Disables the drive from outputting to the motor in the negative direction, while allowing commanded motion in the positive 
direction. The result is dependent on the mode of operation.

Dynamic Brake Motor leads are virtually shorted together internally. However, the bridge enables to protect motor by regulating motor current.

Positive Stop If the drive is controlling velocity or position, the load decelerates according to the deceleration limit specified in the Stop Limits 
window. If the drive is controlling current, the drive will command zero current with no deceleration control. Commanded motion 
in the positive direction has no affect. Motor continues to servo with zero command in the positive direction.

Negative Stop If the drive is controlling velocity or position, the load decelerates according to the deceleration limit specified in the Stop Limits 
window. If the drive is controlling current, the drive will command zero current with no deceleration control. Commanded motion 
in the in the negative direction has no affect. Motor continues to servo with zero command in the negative direction.

Stop If the drive is controlling velocity or position, the load decelerates according to the deceleration limit specified in the Stop Limits 
window. Commanded motion has no affect. Motor continues to servo with zero command.

Apply Brake then 
Disable Bridge

Brake output is turned on, and then the bridge is disabled. The delay is set in the Braking window.

Apply Brake then 
Dynamic Brake

Brake output is turned on, and then the dynamic brake is applied. The delay is set in the Braking window.
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3.9.1 Basic Events
The Basic Events window allows for simple configuration of some common drive events. Select 
an Event Action from the drop-down lists for each drive event.

• Latch: If the latch box is checked, the selected Event Action will remain active until the 
event is removed or you perform one of these actions:
— Cycle power to the drive
— Refresh the Drive Status

3.9.2 Advanced Events
The Advanced Events window allows in-depth customization of the way the drive responds to 
certain drive events. Events under Advanced Settings can correspond to one of the following 
groups.

Each event has several programmable attributes that can be edited by clicking on an event 
row:

• Delay: The time delay between the actual occurrence of the event and the event action.
• Action: The action to be taken by the drive after the response time has elapsed. For safety 

reasons some actions are not available with some events.
• Recovery: The time after which the selected event action will be removed when the cause 

of the event is no longer present.
• No Repeat: The time, after the recovery time and subsequent removal of the event action, 

during which the drive will NOT consider an occurrence of the event as a new occurrence. 
The Event Action will still be applied in case an event does occur within this window. 
However, that occurrence will not be counted as a new occurrence with regard to the 
Maximum Recoveries attribute.

• Recoveries: The number of occurrences of the event prior to a permanent event action. 
The number of recoveries can be set to a specific value, or to Latch or Unlimited.

Group Description
Fault Critical events that result in the drive being disabled.

User Action Event actions that are activated via a digital input or other external interface.

Software Action Event actions that are a result of an internal event.

Motor Events directly related to the motor.

Feedback Events directly related to the motor feedback signals.

Command Events related to the command source or command signal.

Current Events related to the current output as measured by or limited by the drive.

Velocity Events related to the velocity as measured by or limited by the drive.

Position Events related to the position as measured by or limited by the drive.

Shunt Applicable to drives that support a shunt regulator only. Event indicates when the shunt regulator is active.
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3.10 Network Settings

The  Network > Settings window allows configuration of network communication settings. 
Note that the settings entered in the Network Settings window are not necessarily the same as 
the connection settings used to connect to the drive. Network Settings fields may only be 
changed when connected over USB. The window display is specific to the type of network the 
drive hardware is compatible with (note the type of Ethernet protocol is selected in the [Drive 
Name] > Settings window in the System Browser).

Drive Operation Mode   On certain drives, the Drive Operation options in the [Drive Name] > 
Settings window are available to configure the drive for Network Mode or Stand-Alone Mode.

• Network Mode should be used when the drive will be controlled over the network, and will 
restrict the drive to use the state machine defined by the network. This means a network 
command is required to transition the drive out of the fault state before the bridge can be 
enabled.

• Stand-Alone Mode should be used when the drive will not be connected to a network. 
Stand-Alone Mode allows the drive to automatically recover from disabling events such as 
User Disable when the event is no longer active.

Network Type Configurable Settings Description
CANopen Address Sets the CANopen Node ID (1 - 127)

Baud Rate Selects the CAN bus speed (kbit/s).

Initial Mode of Operation 
(6060)

Specifies the mode of operation (6060) initial value. This is the initial mode after a 
communication reset or power cycle. The mode changes will be applied upon drive 
reset.

Cyclic Mode Period Defines the cyclic interpolation cycle time (ms). Value should be equal to the target 
update rate sent by the host in cyclic position, velocity, or torque mode.

Guard Time Guard Time and Life Time Factor (both in ms) determine a "Lifetime" for each NMT 
slave in the network (Lifetime = Guard Time x Life Time Factor). If a node does not 
receive a Node Guard message within its Lifetime, the node assumes 
communication with the host is lost and triggers a communication error event. Each 
node may have a different Lifetime.

Life Time Factor

RS485/232 Drive Address Sets the RS485 drive address (1 - 63)

Baud Rate Selects the RS485 communication baud rate (kbit/s).

Serial Type Selects the interface type for serial communication. Depending on the drive model, 
additional configuration via DIP Switches on the drive/mounting card may be 
required.

EtherCAT Station Alias Sets the Station Alias of the drive (0 - 256)

Initial Mode of Operation 
(6060)

Specifies the mode of operation (6060) initial value. This is the initial mode after a 
communication reset or power cycle. The mode changes will be applied upon drive 
reset.

Cyclic Mode Period Defines the cyclic interpolation cycle time (ms). Value should be equal to the target 
update rate sent by the host in cyclic position, velocity, or torque mode.

Ethernet/IP Node ID Sets the Node ID (1 - 255)

User Defined IP Allows entry of a user defined IP address by selecting the checkbox.

Initial Mode of Operation 
(6060)

Specifies the mode of operation (6060) initial value. This is the initial mode after a 
communication reset or power cycle. The mode changes will be applied upon drive 
reset.

Cyclic Mode Period Defines the cyclic interpolation cycle time (ms). Value should be equal to the target 
update rate sent by the host in cyclic position, velocity, or torque mode.
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3.11 PDO Configuration

The PDO Configuration windows are available for drives that support the CANopen 
communication protocol and are opened by selecting the appropriate option under the 
Network heading in the System Browser.

The PDO Configuration windows allow the configuration of PDO mapping assignments, and 
the option of exporting the project file as a .DCF (CANopen drives) file by clicking the Export 
DCF button.

3.11.1 RPDOs - CAN Drive
The CAN drive RPDO mappings are pre-configured and cannot be changed in the setup 
software. However, each RPDO can be manually enabled or disabled in one of two ways:

• Click on the Load Preset button to select a pre-determined RPDO configuration.
• Select the desired RPDO in the Object Assignments box, then check or uncheck the PDO 

Enabled checkbox.

The PDO Settings box allows further RPDO configuration:

3.11.2 TPDOs - CAN Drive
The CAN drive TPDO configuration and settings controls function in the same way as the 
RPDOs (“RPDOs - CAN Drive” on page 47) with the addition of RTR and period configuration.

Except for TPDO 26, the CANopen TPDO mappings are pre-configured and cannot be changed 
in the setup software. TPDO 26 can hold up to eight objects, or 64 bits. The number of objects 
that can be assigned will be limited by the size of the objects.

To map an object to TPDO 26, drag an object from the Available Objects box over to the Object 
Assignments field. Objects will be relegated to TPDO 26 automatically in the order in which they 
are assigned. To change the order of a selected object assigned to TPDO 26, use the  and 

 buttons. The  button will remove the selected object from TPDO 26.

The Mapping Capacity bar displays how much space remains for objects to be assigned to 
TPDO 26.

Setting Description
COB-ID Enter the COB-ID for the selected RPDO (181h - 57fh)

Transmission Type Set the transmission type for the selected RPDO

Setting Description
RTR Allowed Allow or disallow RTR (Remote Transmission Request) access for the selected TPDO

COB-ID Enter the COB-ID for the selected TPDO (181h - 57fh)

Transmission Type Set the transmission type for the selected TPDO

Period For Sync Cyclic transmission type, enter the number of sync pulses for the selected TPDO
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3.11.3 TPDO Events - CAN Drive
The CAN drive TPDO Events tab is used to assign TPDOs to specific events. Drag TPDOs from 
the Available PDOs box to one of the event fields. By clicking on a desired event, the Event 
Settings box can then be used to further configure the event, or to remove the assigned 
TPDO(s).

Timer Events

Sets the cycle time of the assigned TPDOs. If the cycle time is set to 0, the assigned TPDOs will 
be transmitted continuously.

Bit Monitor Events

The Bit Monitor identifies an object which is observed continuously. Select an object from the 
Observed Object drop down box. If the observed bits change the TPDO(s) assigned to the Bit 
Monitor will be sent. The observed bits are defined by the Bit Mask field (0 to FFFF in hex).

Value Events

The Value Changed event observes an object continuously, defined by the Observed Object drop 
down box. If the object changes by the user defined value entered into the Target Value field 
the assigned TPDO(s) will be sent.

The Value Reached event observes an object continuously, defined by the Observed Object drop 
down box. If the object reaches the user defined value entered into the Target Value field in the 
selected Direction, the assigned TPDO(s) will be sent.

3.11.4 RPDOs and TPDOs - Ethernet Powerlink or EtherCAT
When using an Ethernet Powerlink or EtherCAT network, up to 16 words can be mapped to 
the RPDO and TPDO. A 16-bit object will take up 1 word, and a 32-bit object will take up 2 
words. Objects can be assigned in one of two ways:

• Click on the Load Preset button to select a pre-determined RPDO or TPDO configuration.
• Drag-and-drop objects from the Available Objects field to the Object Assignments field. Use 

the , , and  buttons to change the order or remove assigned objects.
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3.12 Tuning

The selections under Tuning in the System Browser are used to set the control loop gains and 
configure filters and other tuning tools.

3.12.1 Current Loop Gains

There are two options for current loop (torque and flux) parameters:

• Proportional Gain and Integral Gain: Set the gain values according to conventional PI 
tuning rules.

• Proportional Gain and Motor Pole: Use for zero-placement in the current loop 
algorithm. The proportional gain setting is the overall gain of the current loop algorithm. 
When the Motor Pole value matches the actual motor electrical pole (the inverse of the 
motor electrical time constant), a critically damped response can be obtained with the 
largest overall proportional gain.

The Calculate button can be used to automatically set the current loop gains based on the 
values entered in the Motor and Limits windows. Typically these values will provide a good 
starting point and further gain adjustment is required for optimal tuning. Make sure proper 
motor and application data are entered prior to using this function.

3.12.2 Gain Sets
For a motion control system to work properly, the drive must be correctly tuned to the motor 
and/or system. This is accomplished with a set of gain values for each of the control loops in 
the drive. Most applications will not require gain switching, and therefore should use the 
default Gain Set 0. However, more than one set of gains may be required as the machine 
mechanics may change shape (effecting inertia) or the system is loaded or unloaded. The setup 
software allows the configuration of two separate sets of gain values, Gain Set 0 and Gain Set 1. 
Each gain set can be assigned to either Configuration 0 or Configuration 1 in the Configuration 
window.

To set the gain values, access the Gain Set windows by clicking on Tuning > Gain Set 0 or Gain 
Set 1 from the System Browser. Note that Gain Switching must be enabled in order for Gain Set 
1 to be available to edit. Gain Switching can be enabled in the Drive Settings window (Drive > 
Settings). For a step-by-step guide to tune the drive to the system, see “Tuning and 
Commutation” on page 52.

Note that as of ACE version 1.2021.1 the display units for the Ki parameter 
have been changed to Hz. Values from older project files will be 
converted to the new display units when opened in ACE version 1.2021.1. 
It is recommended to confirm that the current loop gains still result in a 
stable current loop response during first connection with ACE version 
1.2021.1 to a drive used with previous versions of ACE.

Note
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The Gain Set values can be set according to conventional PID tuning rules: 

Set Position   The Set Position function will change the value of the measured position and target 
position to the values defined in the "Preset Position" field. It is recommended to use the Set 
Position feature to avoid unexpected motor movement when enabling the bridge, as a large 
difference between the measured and target position may cause the motor to spin rapidly 
upon receiving power.

3.12.3 Filters
The Filters selections (Tuning > Filters) allow configuration of additional gain parameters that 
can be used for more in-depth loop tuning behavior. Note that the values entered in the Filters 
windows will effect both Configuration 0 and Configuration 1:

Velocity Feedback    

Custom   The Custom Filters window allows the specification of biquad filter coefficients for 
different locations in the servo drive’s control loop. A separate biquad filter can be enabled for 
both Configuration 0 and Configuration 1. See “Control Loop Architecture” on page 116 for 
biquad filter locations. Note that only one biquad filter can be enabled at a given time for each 
Configuration. Determination of biquad coefficients is accomplished using a data computing 
language such as MATLAB or a similar programming environment. Most servo applications 
will not require the use of custom biquad filters. Implementation of the digital filter in the 
drive is according to Direct Form II. which results in a transfer function in z domain:

Proportional Gain (Kp) Increase for faster response and increased stiffness. Excessive proportional gain can cause 
overshoot and oscillation.

Integral Gain (Ki) Increase to eliminate steady-state error and increase accuracy (i.e. amount torque/force per 
deflection). Excessive integral gain can cause instability and jitter.

Derivative Gain (Kd) Increase to dampen response and reduce overshoot. Excessive derivative gain results in a more 
sluggish response. Depending on the feedback source, it may cause excessive jitter and noise.

Accel Feed Forward (Aff) Creates a direct current demand, based on the change in velocity demand (Velocity Loop) or the 
second derivative of the position demand (Position Loop). This gain does not affect closed loop 
behavior, but can help improve velocity/position-tracking capability.

Velocity Feed Forward (Vff)
(Position Loop only)

Creates a direct velocity demand based on the change in position demand. This gain does not 
affect closed loop behavior, but can help improve position-tracking capability. In the case that the 
velocity and position loop feedback are the same source, the value of Vff should always be 
1/(Velocity Loop Update Rate in Hz).

Parameter Description
Feedback Filter Cut-off Frequency Sets the cutoff frequency for the velocity feedback filter. This low-pass filter reduces velocity ripple 

(due to digitization). However, this will also affect closed loop performance. A typical setting is 
between 50 Hz and 1500 Hz.

Low Speed Smoothing
(incremental encoder feedback only)

When using a standard incremental encoder, Low Speed Smoothing stabilizes the velocity loop 
during low-speed movement. To tune the low speed gain, use the Waveform Generator to command a 
low speed (1 or 2 rpm) and look at the velocity measured with the oscilloscope. Adjust the low speed 
gain to minimize the velocity spike as seen by the scope. Alternatively, this gain can be used to 
reduce jitter when position is tuned around the velocity loop.

Low Speed Estimator (incremental 
encoder feedback only) 

The Low Speed Estimator is used by the drive for better velocity control at lower speeds by estimating 
fractional incremental encoder counts. If the bandwidth from the calculated velocity loop gains during 
Auto-tune is lower than expected for your system, this option can be unchecked before trying the 
velocity Auto-tune process again.
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YBQ(z)=K*(b0*z2+b1*z+b2)/(z2-a1*z-a2)

Note that numbers may be rounded due to the fixed-point representation. It is the 
responsibility of the user to determine system stability when user-specified coefficients are 
used.

3.12.4 Advanced Settings
The Advanced Settings window (Tuning > Advanced Settings) allows configuration of the 
Velocity and Position Integrator Decay functions. 

Parameter Description
Integrator Decay Enabling Integrator Decay will reduce the integrator output each sampling cycle by the specified rate 

(0-100%) of the Integral Gain. This prevents the integrator from commanding a high current while 
trying to resolve a small error signal in high stiction applications. When Velocity Integrator Decay is 
enabled, decay will trigger if the velocity error going into the integrator is within the specified decay 
Active Window. When Position Integrator Decay is enabled, decay will trigger if the position error is 
within the specified decay Active Window.
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Before proceeding, you must accomplish the following actions:

 Configure the limits and events parameters
 Connect the motor power and feedback

Drive tuning is a multi-step process that involves proper tuning of up to three different servo loops. Before 
tuning, the drive should have the appropriate parameters and limits configured as per the "Limits" on page 39. 
Following are the summary tasks you must perform; later in this chapter you will find the actual procedures 
with individual steps.

1. Current Loop Tuning: Once the drive parameters are configured properly, the current 
loop must be tuned. This is the innermost loop and forms the basis of all motion. You can 
select to have the current loop gains calculated based on motor and application data. This 
will typically provide a good starting point although some applications may require 
further refinement of the tuning parameters.

2. AutoCommutation™: This routine collects data on the motor and feedback parameters 
and asks the user to verify that they match what is entered into the Motor Data page. 
Some applications may have motors that cannot perform this routine due to mechanical 
constraints. See "Manual Commutation Procedure" on page 63 if you must perform 
manual commutation.

Sudden motion may occur! Tuning should only be performed after you 
have specified motor information, drive limits and events, and user units.

Make sure the drive is disabled before selecting Calculate Gains.

It is crucial to make sure the motor is unloaded during commutation; any 
load applied to the motor will skew the results of the routine.
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3. Velocity Loop Tuning: If you want to operate the drive in velocity mode, you must tune 
the current loop and set up the drive to commutate the motor (steps 1 and 2). A very tight 
current loop inside of a relatively tight velocity loop may cause audible noise. If maximum 
bandwidth is not necessary, de-tuning the current loop usually removes most of the 
audible noise. The velocity loop will have to be adjusted any time the current loop tuning is 
changed.

4. Position Loop Tuning: You can either tune the position loop around the velocity loop, or 
around the current loop. Generally, it is much easier to tune a position loop around a 
velocity loop because only the proportional gain is needed. When tuning position around 
the current loop, a high derivative gain may be necessary on top of both proportional and 
integral gains.

For a diagram of how the setup software control loop architecture is implemented, see "Control 
Loop Architecture" on page 116.
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4.1 Current Loop Tuning

Before beginning current loop tuning, make sure that the motor is free to move and de-coupled 
from the load, as sudden motion may occur. The motor and drive limits information must be 
correctly specified in the Motor and Limits windows before tuning the current loop. For 
current loop tuning, the Loop Configuration in the active Configuration can be set to any of the 
available options.

It is recommended to disable the drive by clicking on the Disable icon on the toolbar before 
beginning tuning. The procedure below will prompt you to enable the drive when necessary 
for tuning.

4.1.1 Current Loop Auto-Tuning
Auto-tune automatically calculates optimal current loop gains and can be used as an 
alternative to manual tuning. Before you run Auto-Tune, be sure you have:

• Specified Limits to protect the motor

Proceed as follows:

Current Loop Auto-Tuning Procedure   
1. Navigate to the Limits and Setup window.
2. Verify the motor parameters are correct.
3. Navigate to the Current Loop Window
4. Click Identify Model to determine the transfer function for the system. The Step-Response 

and Bode plots on the page will be populated with the system’s open loop information 
once this step is complete. 

The calculated transfer function can be viewed by clicking the Transfer Func button (this 
will appear after running Identify Mode). The transfer function will persist during a single 
ACE session.

5. If ACE is disconnected or the Reset Drive command is used, then Identify Model will need 
to be rerun to continue using the auto-tune function.

6. In addition, Identify Model should be rerun if system parameters such as input voltage or 
current limits are changed after the transfer function has been determined.

Some motor vibration will occur.
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7. Click Auto-Tune to generate/calculate the optimal current loop gains.

The calculated gains are displayed at the top of the Current Loop window after running 
Auto-Tune.

To run the step response with different gain values, make the desired changes and click 
the Evaluate Gains box to return the step-response with the new values.

The Frequency Verification button will command frequency sweep through the current 
loop. The Step-Response and Bode plots on the page will be populated with the system’s 
closed loop information once this step is complete.

Current Loop Auto-Tuning Warnings   If the following error appears, double check that the 
AMC Service_Autotune is running in the Services windows application and that MATLAB 
Runtime  9.4 is installed correctly in the Program and Features list.

Some motor vibration will occur.
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If the error persists, the user can clear the MATLAB Runtime cache by restarting AMC Service_ 
Autotune via the Service application.
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4.1.2 Manual Current Loop Tuning
It is recommended to disable the drive by clicking on the Disable icon on the toolbar before 
beginning tuning. The procedure below will prompt you to enable the drive when necessary 
for tuning.

Step 1: Inputs/Outputs Configuration setup   
1. Select Inputs/Outputs >Digital Inputs from the System Browser.
2. If an external Inhibit/Enable circuit is used during setup, assign the digital input that will 

be used to the User Disable function, and set the proper polarity (e.g., active high or active 
low).

3. If no external Inhibit/Enable circuit is to be used during setup, then the Enable/Disable 
icons on the toolbar will be used to control drive enabling.

Step 2: Waveform Generator Setup   

1. Open the Scope/Tuning tab by clicking on the Scope/Tuning icon  from the toolbar.

2. In the Waveform Generator pane, select the waveform Target as Current Loop.
3. Select the Square waveform Type.
4. Set Frequency to 100 Hz. If your motor has low inertia and is very responsive, use 150 Hz 

or 200 Hz.
5. Ensure Offset is zero.
6. Ensure Symmetry is 50%.
7. Set the waveform Amplitude to an appropriate value. Begin with 10% of the drive 

continuous current rating or 50% of the motor continuous current rating, whichever is 
lower.

8. Click the ON button to turn on the Waveform Generator.

Step 3: Oscilloscope setup   
1. Select the Current oscilloscope preset from the Presets drop-down menu in the Scope/

Tuning tab, or to manually configure the settings follow the steps below.
2. Change the channel 1 signal to Current Target.
3. Change the channel 2 signal to Current Measured.
4. Change the Trigger Source to Current Target with the Level set to zero.
5. Ensure Trigger Mode is Normal.
6. Change Time/Div to either 1 msec or 500  sec.
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Step 4: Tuning   
1. With the Scope/Tuning window still open, select Tuning > Current Loop Gains from the 

System Browser.
2. To set starting values for the Current (Torque) Loop proportional (Kp) and integral (Ki) 

gains, click the Calculate button to calculate gains that utilize the values entered into the 
Motor Parameters, Feedback, and Limits windows. The specified motor inductance, 
resistance, and bus voltage determine the accuracy of the calculated values. If accurate data 
is not available, begin with Proportional Gain = 1 and the Integral Gain = 0.

3. Enable the drive by clicking the Enable icon. The motor should emit an audible noise but 
remain still.

4. Proper current loop tuning starts with zero integral gain while increasing the proportional 
gain until a 'knee' is formed (with no overshoot) in the Current Measured trace.

5. At this point, the proportional gain is done and the Integral gain must be slowly increased 
to close the steady state error between the Current Target and Current Measured traces.

6. Tuning changes with signal amplitude. Therefore you should now re-adjust the current 
amplitude in the Waveform Generator tab according to your most common application 
current requirements and re-tune. Contouring applications generally use small signal 
transients while point-to-point applications use larger signal transients.

7. When current loop gain adjustments are complete, disable the drive .
8. Turn off the Waveform Generator to remove the command signal from the drive by 

clicking the OFF button in the Waveform Generator pane.

9. Click Store  on the toolbar to store the parameters to the drive’s nonvolatile memory.
10. For Brushed or Brushless motors, no further current loop tuning is required. Skip to 

"Commutation" on page 61 to continue the Tuning and Commutation process. For AC 
Induction motors, continue to Step 5.

For reference, see "Current Limiting" on page 101.
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Step 5: (For AC Induction Motors Only) Flux Reference Loop - Waveform 
Generator Setup   

The preceding Steps 1 through 4 must also be performed for AC Induction motors.

1. Open the Scope/Tuning tab by clicking on the Scope/Tuning icon  from the toolbar.

2. In the Waveform Generator pane, select the waveform Target as Flux Reference Current.
3. Select the Square waveform Type.
4. Set Frequency to 1 Hz.
5. Ensure Offset is zero.
6. Ensure Symmetry is 50%.
7. Set the waveform Amplitude to the No Load Current (as entered on the Motor Parameters 

page).
8. Click the ON button to turn on the Waveform Generator.

Step 6: (For AC Induction Motors Only) Flux Reference Loop - Oscilloscope 
Setup   

1. Change the channel 1 signal to Flux Ref. Current Target.
2. Change the channel 2 signal to Flux Ref. Current Measured.
3. Change the Trigger Source to Flux Ref. Current Target with the Level set to zero.
4. Ensure Trigger Mode is Normal.
5. Change Time/Div to 100 msec.

Step 7: (For AC Induction Motors Only) Flux Reference Loop - Tuning   
1. With the Scope/Tuning window still open, select Tuning > Current Loop Gains from the 

System Browser.
2. To set starting values for the Flux Loop proportional (Kp) and integral (Ki) gains, click the 

Calculate button that calculates gains that utilize the values entered into the Motor 
Parameters, Feedback, and Limits windows. The specified motor inductance, resistance, 
and bus voltage determine the accuracy of the calculated values.

3. Enable the drive by clicking the Enable icon. The motor should emit an audible noise but 
remain still.

4. Proper  loop tuning will look similar to the figure below. Adjust Kp and Ki accordingly to 
remove any overshoot.

5. When flux reference loop gain adjustments are complete, disable the drive .
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6. Turn off the Waveform Generator to remove the command signal from the drive by 
clicking the OFF button in the Waveform Generator pane.

7. Click Store  on the toolbar to store the parameters to the drive’s nonvolatile memory.

Step 8: (For AC Induction Motors Only) Commutation   
1. For AC Induction motors, all that is required for motor commutation is to command a DC 

current into the current loop.

2. Open the Scope/Tuning tab by clicking on the Scope/Tuning icon  from the toolbar.

3. Select the waveform Target as Current Loop.
4. Select the DC waveform Type.
5. Set the waveform Amplitude to an appropriate value.
6. Click the ON button to turn on the Waveform Generator.
7. Enable the drive by clicking the Enable icon. The motor should spin quickly and smoothly 

in a constant direction. If the motor does not spin, or spins very slowly, it is likely the 
feedback polarity will need to be changed. Disable the drive . From the System Browser, 
select Motor > Parameters and change the feedback polarity, then Apply the change. Return 
to the Scope/Tuning window, and command the same DC current into the drive. The 
motor should now spin quickly and smoothly.

8. No further motor commutation is required for AC Induction motors. Skip to "Velocity Loop 
Tuning" on page 68 to continue the tuning process.
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4.2 Commutation

Motor commutation is dependent on the type of motor and feedback available from the motor. 
Brushed motors have a commutator built into the motor housing; therefore the drive does not 
have to be configured to commutate them. Brushless DC (Trapezoidal), and AC (Sinusoidal), 
motors require a correctly configured drive to commutate.

Commutation of a permanent magnet servomotor is the process that maintains an optimal 
angle between the permanent magnet field and the electromagnetic field created by the motor 
current(s). This process ensures optimal torque or force generation at any motor position, 
regardless of speed, for brushless motors.

There are two ways to configure a digital drive to commutate a motor:

• AutoCommutation™: Most applications can use the AutoCommutation routine for config-
uring a drive to a specific motor. This routine will detect the feedback devices attached to 
the motor and ask the user to verify them against the motor’s datasheet.

• Manual Commutation requires more time, and may not be as accurate as 
AutoCommutation. You will have to perform this method if:
— Your motor is mechanically restrained such that it is not free to move 2 revolutions + 

1 electrical cycle in both directions (3 electrical cycles for a Brushless linear motor).
— Your motor or load has a significant amount of inertia.
— Your motor cannot be unloaded, or is a vertical load.
— Your motor has a high degree of stiction.

4.2.1 AutoCommutation™
The AutoCommutation routine detects the motor feedback type and polarity, and then 
configures the drive commutation parameters appropriately.

Brushless and linear motors with insufficient travel distance (two revolutions plus one 
electrical cycle for rotary motors, or three electrical cycles for linear motors) or large amounts 
of inertia will require the Manual Commutation Procedure instead. AutoCommutation 
detection is not required for brush-type motors.

Before you run AutoCommutation, be sure you:

• Enter in the correct motor information in the Motor window page.
• Specify the correct feedback information.
• Specify limits to protect the motor.
• Tune the current loop.
• De-couple the motor from any load and secure the motor. Sudden motion will occur!

If you have not done the preceding, see the corresponding sections in this manual.
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For brushless, stepper, and linear motors with sufficient travel distance, proceed as follows:

1. In Motor > Parameters, ensure that Sinusoidal Commutation is selected in the 
Commutation section of the window.

2. Open the AutoCommutation window (Motor > AutoComm).
3. If the drive is disabled, click the Enable icon to enable the drive.
4. Click Start AutoCommutation to begin the process. During the AutoCommutation process, 

monitor the distance traveled in each direction. The motor will move at 60 electrical 
degrees per second. Rotary motors will turn two revolutions plus one electrical cycle in 
each direction. Linear motors will move three electrical cycles in each direction. Motors 
with a high pole count will take a longer time to complete.

5. When AutoCommutation is complete, select whether the motor has moved the proper 
distance or has not moved the proper distance. If the motor did not move the proper 
distance, verify the pole count or pole pitch in the motor parameters window.

6. Once the motor has properly completed the AutoCommutation routine, verify the proper 
commutation and synchronization settings:
— Commutation:

Trapezoidal - The drive uses Hall Sensors to commutate trapezoidally.
Sinusoidal - The drive uses a feedback device to perform sinusoidal 
commutation.
External Commutation (Brush) - The drive does not commutate the motor. 
Commutation is performed externally.

— Synchronization: (It is recommended to synchronize on the index any time that an 
index exists. This will allow the drive to home to an index. If a different method of 
synchronization is selected other than on the index, the drive will not be able to home 
to an index.)
None - No synchronization is performed.
Halls - each hall cycle - Synchronization is performed on every rising edge of 
Hall A.
Index - Synchronization is performed on the rising edge of the encoder index 
pulse.

7. Click Apply from the toolbar to save the AutoCommutation parameters.
8. Click the Store Settings icon to store parameters to non-volatile memory.

AutoCommutation™ Warnings   After running AutoCommutation, it is possible that a 
warning (or warnings) may appear due to wiring errors or discrepancies between the 
information on the Motor Data page and the results of AutoCommutation.

Follow these steps to successfully complete AutoCommutation:

For brushless or stepper motors with encoder feedback and no Hall 
Sensors, the Phase Detection function must be utilized whenever power 
to the drive is cycled or a loss of sinusoidal commutation occurs. See 
"Phase Detect" on page 66.

Note
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1. Review the information in the AutoCommutation warning box, then select OK.
2. Select ’Edit Motor Data’ from the options in the lower right hand corner.
3. Click ’OK’ in the Pre-Loaded data dialog box.
4. On the Motor Data page, the relevant information will have been changed to correspond 

with the AutoCommutation results. Click ’OK’, then click ’OK’ in any dialog boxes to return 
to the AutoCommutation window.

5. Select ’Accept’ in the AutoCommutation window. If the ’Accept’ button is still grayed out, 
consult the general guidelines in the following table to diagnose and correct any 
AutoCommutation warnings, then re-run AutoCommutation.

4.2.2 Manual Commutation Procedure
The large majority of applications do not require this method for configuring a drive to 
commutate the motor. However, because some applications cannot use the AutoCommutation 
routine, each drive defaults to a standard switching sequence that will commutate one of the 
six motor phase wiring combinations for a given feedback wiring configuration.

Before you perform manual commutation, be sure you have:

• Entered in the correct motor information in the motor data page.
• Specified the correct feedback information.
• Specified limits to protect the motor.
• Tuned the current loop.
• De-coupled the motor from any load and secured the motor. Sudden motion will occur!

Setting over speed limits   
1. From the System Browser, go to the Limits > Velocity window, and set the maximum speed 

you wish the motor to spin for this test. Set this fairly high but not so fast it is dangerous if 
the motor spins away.

AutoCommutation Warning 
Text

Warning Description

Primary Feedback Polarity 
Opposite from Motor Data

AutoCommutation detected that the feedback polarity of the primary encoder is the opposite of 
what is specified on the Motor Data page. This does not necessarily indicate an error, only that 
the observed polarity is different. In this case, it is best to trust AutoCommutation.

Different Feedback Devices 
from Motor Data

AutoCommutation detected a feedback device (usually Hall Sensors) that was not specified on 
the Motor Data page. Check motor data to be sure accurate information was entered.

Other Hall Phasing AutoCommutation found Hall Sensor spacing that is outside the normal range for 60 degree or 
120 degree Hall spacing. This does not necessarily indicate an error. It is acceptable to run with 
other Hall spacing.

Invalid Hall Sensors AutoCommutation detected inconsistent Hall Sensors. This usually means one or more Hall 
Sensors are shorted or not properly connected. Check Hall wiring between motor and drive.

Inconsistent Index Transitions AutoCommutation did not find the index signal consistently during its travel. Check to make sure 
the index signal of the encoder is properly wired to the drive. Can also indicate a noise issue. 
Check to make sure cables are properly shielded.

Inconsistent Encoder 
Transitions

AutoCommutation did not find encoder transitions during its travel. Check to make sure that the 
encoder’s A and B channels are properly wired to the drive, and that the encoder is properly 
powered. Can also indicate a noise issue. Check to make sure cables are properly shielded.
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2. From the System Browser, go to the Events > Advanced window. In the Motor group, set 
the Motor Over Speed event Action to Disable Power Bridge and Unlimited Recoveries.

Performing Manual Commutation (Incremental Encoder, Sin/Cos 
Encoder)   

1. If the drive is enabled, click the Disable icon to issue a Software Disable and disable the 
drive.

2. Check the Drive Status panel for any faults or user inhibits that may be disabling the drive 
or preventing operation, and take corrective action to clear them. Software Disable should 
remain applied.

3. In the Motor > Manual Commutation window, it is recommended to use the default settings 
for Current, Rate, and Offset in the Drive Parameters and Procedure Settings and Status 
panes.

4. Enable the drive. Click and hold the Move Positive or Move Negative button in the 
Measurement pane. The needle in the diagram will begin to revolve. The measured 
commutation settings will appear as solid lines in the diagram.

5. Once the needle has travelled a complete rotation, release the Move... button. (Optionally, 
after completing a full rotation in one direction, click and hold the Move... button in the 
opposite direction for another full rotationto increase resolution). If the measured 
commutation settings (solid lines) do not match up with the configured commutation 
settings (dashed lines), change the Commutation Sequence from the Drive Parameters 
pane so that the solid lines line up with the dashed lines.
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6. To set the properEncoder Direction, click and hold the Move Positive button. As the needle 
rotates, pay attention to the Position counter field. If the value is increasing as the needle 
moves forward, Encoder Direction should be set to Standard. If the value is decreasing as 
the needle moves forward, Encoder Direction should be set to Inverted.

7. Apply the commutation settings by clicking the Apply button in the Toolbar.

Performing Manual Commutation (Absolute Encoder - BiSS, EnDat, 
Hiperface)   

1. If the drive is enabled, click the Disable icon to issue a Software Disable and disable the 
drive.

2. Check the Drive Status panel for any faults or user inhibits that may be disabling the drive 
or preventing operation, and take corrective action to clear them. Software Disable should 
remain applied.

3. In the Motor > Manual Commutation window, it is recommended to use the default settings 
for Holding Current, Holding Time, and Commanded Phase Angle in the Procedure Settings 
pane.

4. Enable the drive. Click the Start button. The motor should begin to rotate slowly (the 
current and position can be monitored in the Status pane).

5. Once the configured Holding Time has been reached, the Calculated Null Torque Angle 
(NTA) will be displayed in the Drive Settings pane. The Feedback Polarity will also be 
automatically adjusted to the correct setting, if necessary.

6. Apply the commutation settings by clicking the Apply buttonin the toolbar.

Re-Setting Over Speed Limits   
1. In the Limits > Velocity window set the desired application Motor Over Speed.
2. In the Events > Advanced window, configure the desired event actions for the application.
3. Click the Store Settings icon on the toolbar to store the parameters to the drive non-

volatile memory. The drive is now ready either for tuning the outer loops, or final 
commissioning and use.

4.2.3 Advanced Commutation
The Advanced Commutation window provides setup and commutation information for more 
advanced or non-typical commutation configurations or environments. Most applications will 
not require any adjustment of the Advanced Commutation values.

Note that not all of the Advanced Commutation parameters listed below are available for every 
drive. Only the commutation parameters specific to the drive and feedback device in use will 
be displayed in the setup software.



MNDGACUG-06 66

Tuning and Commutation / Commutation

Changing settings in the Advanced Commutation window will automatically adjust settings 
that are also available in other windows (i.e. wiring polarities, commutation type, 
synchronization source, etc.).

4.2.4 Phase Detect
Phase Detect is required for use with brushless and stepper motors with encoder feedback 
and without hall sensors. This routine must be performed before the motor can properly be 
commutated each time the drive power is cycled, or anytime sinusoidal commutation is lost.

The reason is that without hall sensors, the motor position is initially unknown, and therefore 
cannot be properly commutated until a positioning routine is followed. Phase Detect will 
require motor motion for several seconds, and can be set up to be performed via a digital 
input, or automatically on power-up.

Be sure to enter motor data and run AutoCommutation if possible before running Phase 
Detect. Couple the motor to the load before you perform Phase Detection. Phase Detect is also 
used with absolute feedback devices (i.e., resolver or absolute encoder). This form of Phase 
Detect does not require motor motion.

• Power-up Option: Under most circumstances, the appropriate setting in the [DriveName] 
> Power-up tab is On First Enable Following Power-up. However, other options may be used 
depending on the configuration of your drive and motor.

• Disable Events: The positive and/or negative limit switches may be disabled in the Phase 
Detect window by checking the disable checkboxes under Configuration. This will prevent 
the limit switches from causing a premature phase detect failure.

• Settling Time: For Phase Detect to complete successfully, the absolute position must be 
determined when the motor is at a standstill. For motors with high inertia or low friction, 
the motor may take a longer time to come to a stop after the initial Phase Detect move-
ment. Entering a Settling Time value greater than the amount of time that the motor takes 
to settle will allow Phase Detect to complete successfully in these cases. Depending on the 
motor, typical settling time values may range from one second to several seconds. The 

Commutation Parameter Description
Wiring Configures motor and feedback rotation and wiring information

Rotation Direction - Specifies the direction of motor rotation
Wiring Polarity - Specifies the polarity of the motor wiring
Feedback Polarity - Specifies the polarity of the feedback device connections. The proper setting for Feedback 
Polarity is necessary to prevent a motor runaway condition.

Phase Registration Displays the counts per electrical cycle of the motor, and the Null Torque Angle at Zero Count. The NTA is 
configurable when using an absolute encoder.

Halls For drives using Hall Sensors for commutation, displays the Hall Sensor phase centers.

Commutation Configures the drive for Sinusoidal or Trapezoidal commutation. Also enables or disables Synchronization via an 
Index or Halls, and allows the configuration of Null Torque Angle values for the First Edge and Second Edge.

The Phase Detect window will not be available in all cases, as the Phase 
Detect routine is not required for setup in all scenarios.
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current that the drive will command to hold the motor at a standstill for the Settling Time 
duration will be the maximum continous current value allowed by the hardware, or the 
software Peak Current level (if set below the hardware continous current). If the Settling 
Time is longer than the the software Peak Current Time, then the commanded current will 
foldback to the software Continuous Current value.

• Restrict Motion: Unrestricted motion is recommended if the system will allow it for the 
best chance of successful Phase Detection. Unrestricted motion Phase Detection can be 
used against a hard stop. Restrict Motion should be used when sudden motor motion of up 
to ±1/2 electrical cycle is unacceptable in the system. Enable the Restrict Motion checkbox, 
and enter a motion value within the physical limits. The required motion for the Phase 
Detect routine is no more than ±1/2 of an electrical cycle. Phase Detect can complete suc-
cessfully with less motion, but the success rate will be reduced.

• Pulse Current: This is the current used to excite the motor during a restricted motion 
Phase Detect. It should be large enough to move the motor (and load) smoothly, but not so 
much that the motor overshoots. A good starting current is one quarter of the RMS cur-
rent to be used in your application. If you are trying to perform Phase Detect with no load 
on the motor, very little current will be required.

To perform Phase Detection, use the following procedure:

1. You may wish to monitor the following status events: Phase Detection, Phase Detection 
Complete, and Phase Detection Fault. These can be monitored with the Drive Status panel 
or can be assigned to digital outputs and monitored with a controller.

2. Configure the Phase Detect settings for Settling Time and Disable Positive/Negative Limits 
for what is appropriate for the system. For a restricted motion Phase Detect, select the 
Restrict Motion checkbox, and enter a motion value within the physical limits of the 
system, and an appropriate Pulse Current value.

3. Click the Phase Detect Button. Motion will occur, before the drive will hold the motor in a 
fixed location. This process may repeat multiple times while the drive collects data. If a 
restricted motion window has been defined, the motion will be confined within that 
window. Otherwise, Phase Detect will command several small moves of 45 electrical 
degrees.

4. Check Drive Status to make sure the Phase Detect routine was successful.
5. If Phase Detect was unsuccessful, the routine may automatically repeat again. It may be 

necessary to vary the Pulse Current and motion parameters to ensure successful Phase 
Detection.
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4.3 Velocity Loop Tuning

Tuning of the velocity loop should only be performed after current loop tuning and motor 
commutation. Velocity loop tuning is dependent on the mechanical load, and therefore will 
change with any mechanical system changes. Velocity loop tuning should be performed with 
the motor installed in the system and connected to the load. Make sure that the load is free to 
move as sudden motion may occur. For velocity loop tuning, the Loop Configuration setting in 
the active Configuration must be set to either Velocity or Position around Velocity.

It is recommended to disable the drive by clicking on the Disable icon on the toolbar before 
beginning tuning. The procedure below will prompt you to enable the drive when necessary 
for tuning.

4.3.1 Velocity Loop Auto-Tuning
Auto-tune automatically calculates optimal velocity loop gains and can be used as an 
alternative to manual tuning. Before you run Auto-Tune, be sure you have:

• Specified Limits to protect the motor

Proceed as follows:

Velocity Loop Auto-Tuning Procedure   
1. Navigate to the Velocity Loop window.
2. Click Identify Model to determine the transfer function for the system. The Bode plots on 

the page will be populated with the system’s open loop information once this step is 
complete. 

The calculated transfer function can be viewed by clicking the Transfer Func button (this 
will appear after running Identify Mode). The transfer function will persist during a single 
ACE session. If ACE is disconnected or the Reset Drive command is used, then Identify 
Model will need to be rerun to continue using the auto-tune function. In addition, Identify 
Model should be rerun if system parameters such as input voltage or velocity limits are 
changed after the transfer function has been determined.

Some motor vibration will occur.
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3. Click Auto-Tune to generate/calculate the optimal velocity loop gains.

The calculated gains are displayed at the top of the Velocity Loop window after running 
Auto-Tune.

To run the step response with different gain values, make the desired changes and click 
the Evaluate Gains button to return the step-response with the new values.

The Frequency Verification button will command frequency sweep through the velocity 
loop. The Step-Response and Bode plots on the page will be populated with the system’s 
closed loop information once this step is complete.

The Max and Min Freq parameters can be used to change the range of the frequency 
sweep command during Identify Model and Frequency Verification.

Velocity Loop Auto-Tuning Warnings   If the following error appears, double check that 
the AMC Service_Autotune is running in the Services windows application and that MATLAB 
Runtime 9.4 is installed correctly in the Program and Features list.

Some motor vibration will occur.
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If the error persists, the user can clear the MATLAB Runtime cache by restarting AMC Service_ 
Autotune via the Service application.

4.3.2 Manual Velocity Loop Tuning

Step 1: Waveform Generator setup   
1. Open the Scope/Tuning tab by clicking on the Scope/Tuning icon  from the toolbar.
2. Select the waveform Target as Velocity Loop.
3. Select the Square waveform Type.
4. Set Frequency to around 1-3 Hz. The frequency should be slow enough to achieve 

commanded velocity, but fast enough to prevent the system from reaching a mechanical 
limit.

5. Ensure Offset is zero.
6. Ensure Symmetry is 50%.
7. Set the waveform Amplitude to approximately 10% of motor nominal speed.
8. Click the ON button to turn on the Waveform Generator.

Step 2: Oscilloscope setup   
1. Select the Velocity Scope Preset, or to manually configure the settings follow the steps 

below.
2. Change the channel 1 signal to Velocity Target.
3. Change the channel 2 signal to Velocity Measured.
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4. Change the Trigger Source to Velocity Target with the Level set to zero.
5. Ensure Trigger Mode is Normal.
6. Change Time/Div to 10-20msec.

Step 3: Tuning   
1. With the Scope/Tuning tab still open, select Tuning > Gain Set 0 or Gain Set 1 from the 

Sysytem Browser, depending on which Gain Set is currently used for the active 
Configuration.

2. Begin by setting all the velocity loop gains to zero (Kp-Proportional, Ki-Integral, Kd-
Derivative, Aff-Feedforward).

3. Enable the drive by clicking the Enable icon.
4. Proper Velocity loop tuning starts with zero integral gain while increasing the proportional 

gain until a "knee" is formed (with no overshoot) in the Velocity Measured trace as shown 
below. There may or may not be an error between the Target and Measured traces, the key 
is to have a smooth knee shape.

5. At this point the Proportional gain is left alone and the Integral gain is increased slowly 
until the "knee" begins to deform as shown below. It is OK if the waveform does not start 
to distort until the integral gain is very high. When the distortion occurs, back off the 
Integral gain until the knee becomes smooth again.

6. Next, in order to improve the smoothness of the response, it may be beneficial to adjust 
the velocity feedback filter cutoff frequency in the Tuning > Filters window. The Filter 
Frequency is used to dampen oscillations and noise in the velocity measurements. For 
most systems, the ideal cutoff frequency will be somewhere between 50Hz and 1500Hz.

7. Most systems will be tuned properly at this point. If your system requires fine-tuning, you 
may adjust the derivative and feed-forward gains. If the motor starts to make audible 
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noise, increase the Low Speed Smoothing in the Loop Filters window until the vibration 
and noise stops.

8. When tuning is complete, disable the drive by clicking the Disable icon on the toolbar. Turn 
off the Waveform Generator by clicking the OFF button in the waveform generator pane.

9. Click Store  on the toolbar to store the parameters to the drive’s nonvolatile memory.
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4.4 Position Loop Tuning

Position loop tuning is dependant on the mechanical load, and therefore will change with any 
mechanical system changes. Position loop tuning should be performed with the motor 
installed in the system.

The position loop can be closed around velocity or current (torque) mode. If it is closed around 
velocity mode, the position loop algorithm output becomes the new velocity set point. If it is 
closed around torque mode, the position loop algorithm output becomes the new current 
(torque) set point. There are some important differences in the tuning process and 
application of these two approaches:

• Position around Velocity: This mode is most common in "contouring" application, 
where a position trajectory must be tracked very closely. The velocity loop provides addi-
tional "stiffness", and keeps the dynamic position errors minimal, since the system now 
reacts to not just position errors, but also velocity errors (which can be interpreted as 
position error changes). It is important to start with a stable yet responsive velocity loop. 
Typically, it is sufficient to just use the position loop proportional gain. Feedforward gain 
can be added to improve tracking performance (i.e. minimize the difference between com-
manded and actual position). It is best to use a small step command as a reference signal 
during tuning.

• Position around Current (Torque): This mode is most common in point-to-point 
applications, where actual motion between start and end point is not very critical. In this 
case, velocity loop tuning can be avoided. This can be advantageous if the velocity feedback 
is poor (e.g., low resolution encoder, poor encoder quadrature, etc.). In this case, the tuning 
process requires that the position loop proportional and derivative gain are increased 
simultaneously, unless the system has sufficient friction, in which case no derivative gain 
is necessary. Once a stable response is achieved, integral gain can be added to improve 
stiffness. It is best to use a triangular waveform or a step command with the Command 
Limiter enabled as a reference signal during tuning.

For position loop tuning, the Loop Configuration setting in the active Configuration must be 
set to either Position around Current or Position around Velocity.

It is recommended to disable the drive by clicking on the Disable icon on the toolbar before 
beginning tuning. The procedure below will prompt you to enable the drive when necessary 
for tuning.

Step 1: Waveform Generator setup   
1. Open the Scope/Tuning tab by clicking on the Scope/Tuning icon  from the toolbar.
2. Select Position Loop as the waveform Target.
3. Select the Square waveform Type.
4. Set Frequency to around 1-3 Hz. The Frequency should be slow enough to allow the motor 

to settle in position.
5. Set Offset to zero.
6. Ensure Symmetry is 50%.
7. Leave the Amplitude at zero for the moment.
8. Click the ON button to turn on the Waveform Generator.
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Step 2: Oscilloscope setup   
1. Select the Position Scope Preset, or to manually configure the settings follow the steps 

below.
1. Change the channel 1 signal to Position Target.
2. Change the channel 2 signal to Position Measured.
3. Change the Trigger Source to Position Target with the Level set to zero.
4. Ensure Trigger Mode is Normal.
5. Change Time/Div to 20-50 msec.

Step 3: Tuning   

1. With the Scope/Tuning window still open, select Tuning > Gain Set 0 or Gain Set 1 from the 
System Browser, depending on which Gain Set is currently used for the active 
Configuration.

2. In the Gain Set tab, set all gains to zero (Kp-Proportional, Ki-Integral, Kd-Derivative, Vff-
Velocity Feedforward, and Aff-Acceleration Feedforward).

3. The Set Position function is used to set the measured and target position to the value 
defined in the Preset Position field. It is recommended to set the Preset Position to zero 
before beginning tuning to avoid any unexpected jumps when the drive is enabled. Enter 
"0" in the Preset Position field, then click the Set button.

4. Enable the drive by clicking the Enable icon. Set the waveform Amplitude between 1/8 and 
1/2 revolution for a rotary motor. Use the Proportional Gain, Integral Gain, and Derivative 
Gain sliders or arrow buttons in the Position Loop window to adjust the Position 
Measured waveform on the oscilloscope and match the Position Target as closely as 
possible without excessive overshoot. It is not necessary to adjust the Velocity or 
Acceleration Feed-forward Gains.

5. Readjust the Gains as Necessary.
6. When position loop gain adjustments are complete, disable the drive by clicking the 

Disable icon on the toolbar. Turn off the Waveform Generator by clicking the OFF button 
in the waveform generator pane.

7. Click the Store icon  on the toolbar to store parameters to the drive’s nonvolatile 
memory.
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 5 Motion Tasks

The Base Motion and Motion Engine selections of the System Browser are used to configure motion tasks. 
These features are used when it is desired to distribute motion to the drive, offloading the HMI, PC or PLC from 
calculating motion trajectories. This functionality provides greater flexibility to modify the drive behavior for the 
application.

Before executing any Motion Tasks, be sure to have:

 Entered in the motor and feedback parameters.
 Configured the drive limits and events.
 Tuned the necessary control loops and successfully completed AutoCommutation.
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5.1 Motion Tasks

Motion Tasks are commands in the drive that will cause pre-defined motion on the axis. The 
tasks will generate trajectories that will be fed into the position loop. Motion Tasks may be 
performed on the benchtop or with a load on the motor. There are five types of Motion Tasks 
available for configuration in the setup software.

• Homing
• Indexes
• PVT
• Jogs
• Sequences

5.1.1 Homing
Homing is a Motion Task that defines Absolute Position to the drive with respect to the 
machine typically involving a sensor or switch located at a known position. The Home Task is 
not required to be used in applications with an absolute feedback device. The absolute 
position can be defined in the case of an absolute feedback device through the Phase Detect 
routine. Note that position limits will be ignored during homing routines. This setting can be 
changed via network commands.

Many different homing routines are supported. These routines rely on signals such as limit 
switches, home switches, and encoder indexes to accurately position the load.

To open the Home window, select Base Motion > Home from the System Browser. Set the 
Homing Speeds and Acceleration, then configure the Homing Method. 

If no switches, index, or direction are selected, the homing routine will default to "Current 
Position". The "Current Position" homing routine will set the measured position equal to the 
specified home position value (typically zero) when executed.

Home 
Parameter

Description

Fast Velocity Value of the maximum velocity that can be commanded during search for first switch.

Slow Velocity Value of the maximum velocity that can be commanded during search for Home. The slower the velocity, the 
more accurate the homing routine should be.

Homing 
Acceleration

Value of the acceleration and deceleration for motion.

Home Position Position value set as the Home location.

Index Selects whether an Index pulse is used on motor feedback for Homing.

Home Switch Selects whether a Home Switch is in use.

Limit Switch Selects whether a Limit Switch is in use.

Direction Selects whether motion during the Home Task will begin in the positive or negative direction.
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The example below uses the index, the falling home switch edge and the positive limit switch to 
define the homing routine. The direction in which homing ends is in the negative direction as 
shown by the arrow.

For this particular routine, there are three possible scenarios. The scenarios are described as 
shown from top to bottom.

1. The home switch is inactive. Motion begins in the positive direction. When the home 
switch is encountered, motion starts in the negative direction. Homing completes at the 
first index pulse after the falling edge of the home switch.

2. The home switch is active. Motion begins in the negative direction. Homing completes at 
the first index after the falling edge of the home switch.

3. The home switch is inactive. Motion begins in the positive direction. When the positive 
limit switch is encountered, motion starts in the negative direction. Homing completes at 
the first index after the falling edge of the home switch.

Homing method  The set of drawings below illustrate the different components used to define 
the different homing routines. The components are grouped in the diagram to show events 
relative to motor/load position.

Load and physical limits: The square near the middle of the drawing shows the load object 
that is to be moved. The end points represent physical limitations or barriers in which the load 
cannot travel past. The left side is in the negative direction with the right side in the positive 
direction.

Direction of travel: The vertical line on the right side represents the starting position. The 
load travels in the direction of the arrow. In the drawing shown, the load would begin traveling 
in the negative direction and then switch directions to move in the positive direction. The 
circle represents the home position. This position is captured before the motor decelerates to 
zero velocity.

Index Pulse: Each vertical line represents one index pulse.

Limit and Home Switches: As shown, the switch can be either high or low. The vertical lines 
represent a toggle point.

1
2 3
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5.1.2 Indexes
An Index task is defined by a set of basic parameters that define a profiled move. Up to 16 
separately defined Index tasks can be configured (Index 0 - Index 15). An Index task can be 
either of the following types:

• Absolute - Commands a pre-defined move to an absolute position.
• Relative - Commands a pre-defined move relative to the current position.

To configure an Index task, select Motion Engine > Indexes > Index 0...15 from the System 
Browser. Each Index task (Index00 - Index15) can be assigned a unique identifier in the Name 
field in the Indexes window, and any further labels or important information can be added in 
the Comment Field. Select the Index Type (Absolute or Relative) from the drop-down menu, 
then configure the Index task by setting values for the following parameters: 

Click Apply to save the Index configuration once the values are entered.

Executing an Index Task   To perform an Index task, note that the drive and the Motion 
Engine must be enabled. The active drive Configuration should be set to Position around 
Velocity, and the Absolute Position Valid status must be active via the Homing, Phase Detect, or 
Set Position functions. Homing parameters are configured in the Base Motion > Home window 
in the System Browser. See "Homing" on page 76 for information on how to configure the 
Homing routine.

1. Configure an Index task from the Indexes window as described above.
2. Enable the drive by clicking the Enable icon  on the toolbar. Select Motion Engine > Run 

from the menu bar or click the Motion Engine On icon  on the toolbar to enable the 
Motion Engine.

3. Select Tools > Motion Panel from the menu bar to display the Motion Panel controls.
4. Use the drop-down arrow at the top-right of the Motion Panel window to select Indexes.
5. In the Motion Panel window, select a configured Index task from the Motion drop-down 

box in the Identification section. The selected index parameters will then be displayed in 
the Motion Panel.

6. Click the Home icon  on the Motion Panel toolbar to home the drive.

Index Parameter Description
Position/Distance - (Absolute Index) The target position for the task.

- (Relative Index) The target distance for the task relative to the current position.

Velocity Value of the maximum velocity of the profile that can be commanded. The motion may not reach the 
maximum velocity depending on the values set for Acceleration, Deceleration, and Position/Distance.

Acceleration Value of the acceleration for the profile. The profile will continue at this rate until Velocity is reached or the 
profile enters the deceleration phase.

Deceleration Value of the deceleration for the profile. The profile will continue at this rate until the axis reaches zero 
velocity. The profile starts decelerating at a position so that the axis is at zero velocity at the Position value.

Dwell After completion of motion the axis will dwell for this period of time. The task is still active during dwell time.

Start Location Define a starting position for the index task.
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7. To execute the selected Index task, click one of the following. 

8. For a looped Index task, once the desired motion has occured click the Halt Motion icon 
 at the top of the Motion Panel to complete the move.

Dynamic Indexes   Dynamic Index tasks are configurable within the Motion Panel window. Both 
Absolute and Relative Index tasks can be defined using the Dynamic Index tool. The drive and 
the Motion Engine must be enabled to perform a Dynamic Index task. The active drive 
Configuration should be set to Position around Velocity, and the Absolute Position Valid status 
must be active via the Homing, Phase Detect, or Set Position functions. Homing parameters are 
configured in the Base Motion > Home window in the System Browser. See "Homing" on 
page 76 for information on how to configure the Homing routine.To execute a Dynamic Index 
task:

1. Enable the drive by clicking the Enable icon  on the toolbar. Select Motion Engine > Run 
from the menu bar or click the Motion Engine On icon  on the toolbar to enable the 
Motion Engine.

2. Select Tools > Motion Panel from the menu bar to display the Motion Panel controls.
3. Use the drop-down arrow at the top-right of the Motion Panel window to select Dynamic.
4. In the Motion Panel window, select the Index Type (Absolute or Relative).
5. Enter the desired motion parameters (Position, Velocity, Accel, Decel, and Dwell) into the 

Motion Panel.

6. Click the Home icon  on the Motion Panel toolbar to home the drive if necessary.
7. To execute the selected Dynamic Index task, click one of the following. 

8. For a looped Dynamic Index task, once the desired motion has occured click the Halt 
Motion button  at the top of the Motion Panel to complete the move.

Index Motion Commands Description
Repeatedly Execute Motion in Reverse (Loop Reverse) - Relative Indexes only

Execute Motion in Reverse (Reverse)  - Relative Indexes only

Execute Motion (Forward)

Repeatedly Execute Motion (Forward Loop)  - Relative Indexes only

Loop over Forward and Reverse Motion (Cycle Motion)  - Relative Indexes only

Dynamic Index Motion Commands Description
Repeatedly Execute Motion in Reverse (Loop Reverse)  - Relative Indexes only

Execute Motion in Reverse (Reverse)  - Relative Indexes only

Execute Motion (Forward)

Repeatedly Execute Motion (Forward Loop)  - Relative Indexes only

Loop over Forward and Reverse Motion (Cycle Motion)  - Relative Indexes only
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5.1.3 PVT
Typically, Position-Velocity-Time (PVT) is used to stream motion data between multiple axes for 
coordinated motion. Arbitrary position and velocity profiles can be executed on each axis. A 
PVT command contains the position, velocity, and time information of the motion profile’s 
segment end points. The servo amplifier performs a third order interpolation between 
segment end points. This results in a kind of partial trajectory generation where both host 
controller and servo amplifier generate a specific portion of the overall move profile trajectory. 
The host controller calculates position and velocity of intermittent points on the overall 
trajectory, while the servo amplifier interpolates between these intermittent points to ensure 
smooth motion. The actual position loop is closed within the amplifier. This reduces the 
amount of commands that need to be sent from host controller to amplifier, which is critical in 
distributed control systems. The number of segments and the time duration of each segment 
need to be selected based upon required accuracy and network bandwidth.

Suppose the motor is at rest and the values P1, V1, and T1 are entered in the buffer to 
represent a PVT point S1 = (P1, V1, T1). If the profile is executed, the drive will attempt to 
move the motor a distance of P1 in T1 seconds with a final velocity of V1. The path of motion is 
calculated by using the difference between the initial and the target position and velocity 
points, and running them through a third order equation to produce a smooth motion profile. 
The figure below shows an example which involves multiple PVT points S1, S2, S3,..., Sn and 
displays how smooth motion between these points can be produced.

PVT Plot

How To Construct A PVT Points File   A PVT file can be constructed using any simple-text 
editor (such as Microsoft® NotePad). Each line in the file represents a PVT point by specifying 
position, velocity, and time separated by semicolons.

Position and velocity are specified in user units (see "User Units" on page 92) whereas time is 
always in milliseconds. Furthermore, velocity is specified on an absolute basis whereas time is 
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specified on an incremental basis with the largest allowable increment being 65535 
milliseconds. Position must be absolute.

CAN standard supports a time step up to and including 255 milliseconds.

Enter the desired PVT points in a text file and load that data into the Motion Panel. When first 
saving a PVT file, be sure to replace the default *.txt extension with *.pvt when specifying the 
file name.

If using the Repeatedly Execute Motion (Forward Loop) option with a PVT file, be sure that the 
first PVT point in the file can follow logically after the last point in the PVT file, and that they 
contain the same position value. Lastly, when looping through several PVT points with small 
incremental times, be aware of the fact that the PVT buffer may have time to empty out all of 
its points before the PVT Generator has time to refill the buffer. Such an event will result in no 
more than the PVT Buffer Empty status becoming active and is the result of restrictions on the 
RS232 baud rate used by the software to communicate with the drive.

There is no limit to the number of PVT points you can place in the PVT file. These files are 
useful to repeat a desired sequence several times or to save the data for future use.

1. To get started, select the Open PVT File button.
2. Navigate to your PVT file (make sure it has a *.pvt extension).
3. The file name is displayed below the Open PVT File button.
4. To execute the selected PVT file, click one of the following. 

5. For a looped PVT command, once the desired motion has occured press the Halt Motion 
button  at the top of the Motion Panel to complete the move.

An example of a PVT file with correct formatting, named pvt_points_file.pvt, is shown below.

PVT Points File Example

PVT Motion Commands Description
Execute Profile (Run)

Loop over Profile (Repeat)
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5.1.4 Jogs
Jogs are Position Mode Motion Tasks that command motion at a defined constant velocity with 
infinite distance. Four separate Jog velocities can be defined (Velocity 0, 1, 2, and 3).

To configure a Jog Task, select Base Motion > Jog from the System Browser, then enter values 
for the following parameters:

Click Apply to save the Jog parameters.

Executing a Jog Task   To perform a Jog Task, the drive must be enabled. Note that the Motion 
Engine must be disabled before a Jog Task can be executed. If the Motion Engine is currently 
turned on, select Motion Engine > Run from the menu bar or click the Motion Engine ON icon 

 on the toolbar to turn off the Motion Engine.

1. Configure a Jog Task from the Jog window as described above.
2. Enable the drive by clicking the Enable icon  on the toolbar.
3. Select Tools > Motion Panel from the menu bar to display the Motion Panel controls.
4. Use the drop-down arrow at the top-right of the Motion Panel window to select Jog.
5. In the Motion Panel window, select the desired Jog Velocity. The selected Jog parameters 

will then be displayed in the Motion Panel.
6. To execute the selected Jog Task, click and hold one of the following. 

7. The Jog motion will continue as long as the motion task button is held down. Release the 
motion task icon when the desired motion is complete.

5.1.5 Sequences
A Sequence is a set of steps that are Motion Tasks and Control Functions linked together and 
executed in a sequential order. With the exception of Jogs, any Motion Task can be used in a 
Sequence. Control Functions are all the non-motion steps that impact the flow of a sequence.

The setup software allows up to 16 different Sequences to be saved and stored to the project 
file and drive NVM. The Storage Used field will automatically update with the amount of 
memory used by the configured Sequences. Each Sequence can be given a unique name or 
number as an identifier, and selected by using the Seq ID drop-down menu or by choosing the 
desired Sequence from the System Browser tree view.

Jog Parameter Description
Velocity (0,1,2,3) Value of the maximum velocity of the profile that can be commanded.

Acceleration Value of the acceleration for the profile. Shared by all Jog Velocity parameters. (Note: Value may be rounded after 
entry to account for drive unit conversion).

Deceleration Value of the deceleration for the profile. Shared by all Jog Velocity parameters. (Note: Value may be rounded after 
entry to account for drive unit conversion).

Display Time Sets the Jog graph time duration. For estimation/graphing purposes only, does not affect actual duration of Jog 
motion.

Jog Motion Commands Description
Execute Motion in Reverse (Reverse)

Execute Motion (Forward)
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Each step in a Sequence is a distinct state of the Sequence. Steps are organized into one of the 
following groups: Motion, Sequence, If/Then, Wait For, and Set/Clear. Drag-and-drop step 
items from the Functions pane over to the Sequence list area in the Sequence pane to create a 
Sequence. The order of steps within a Sequence can be changed by using the , , or  
buttons in the Sequence window.

Functions

Break Points
• Up to two Break Points can be added to an inactive or active Sequence to pause the 

Sequence at a desired location. The Sequence will remain paused until either the Run or 
Single-Step button is selected to restart the Sequence progression.

• Break Points are added or removed by clicking on the white space between the Sequence 
# and the Sequence Step name in the Sequence list area.

Motion Description
Home Runs the currently configured Homing routine.

Index Runs an Index routine. After dropping the Index function into the Sequence list area, select the desired Index 
routine from the Identification pane. Indexes may be pre-configured or configured directly in the Sequence 
window.

Sequence Description
Start Used to start a new Sequence, allowing Sequences to be chained together.

End Used to end a Sequence. Note that it is not required to place an End function as the last step of a Sequence.

Label Assigns a label to a point in a Sequence. After dropping the Label function into the Sequence list area, the label 
name can be entered in the Label Step pane. Labeled steps within a Sequence can be called out in other 
Sequence control functions within the same Sequence.

Jump To Commands the Sequence to jump to a pre-configured Label within the same Sequence. Note that the labeled step 
in the Sequence must be configured before it can be selected in the Jump step. After dropping the Jump function 
into the Sequence list area, select the labeled point to jump to from the Jump to Step pane.

If/Then Description
Event / Input / 
Logic Bit

If/Then commands are used as test statements within a Sequence. Events, Digital Inputs and Logic Bits are 
selectable as test items. After dropping the desired test function into the Sequence list area, select the item to be 
tested from the If Event drop-down menu, and select whether to test if the item state is Set or Clear (Active or 
Inactive). The action the test step will take can then be selected from the then: drop-down menu. Some actions 
will only be available if the appropriate step has already been configured. For example, the option to "Jump To" a 
specific point in the Sequence will only be available if a Label has already been configured.

Wait For Description
Event / Input / 
User Bit / Time / 
Value

Wait For commands will hold a Sequence from progressing to the next step for either a defined time period or until 
a specified event or action has occured. A Time-out duration and subsequent Action can be entered for Wait For 
commands that are waiting for an event or action to occur. The setup software allows Wait For commands for 
certain drive Events, Digital Inputs, User Bits, and Measured and Target Position Values. The configurable Action 
taken at the end of the Time-out duration if the specified event has not occured can be one of the following 
options: End the current Sequence, Start a new Sequence, Jump to a labeled point within the current Sequence, 
or Continue to the next step in the current Sequence.

Set/Clear Description
Output Commands a specified Digital Output to either trigger or clear.

Logic Bit Commands a specified Logic Bit to either trigger or clear.
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I/O Assignments
• The I/O Assignments pane lists all the Digital Inputs and Outputs that may be selected for 

use in a Sequence.
• Digital Inputs or Outputs that are already assigned to other drive functions will be marked 

as "In Use".

Invalid Sequence Steps
• In the case where a step in any of the sequences has not been properly configured or 

initialized, a red flag icon will be visible next to the invalid step in the step list. All invalid 
sequence steps must be corrected before any sequences can be executed.

• If an invalid sequence step exists, the red flag button at the bottom of the Sequences 
window will automatically open the first sequence that contains an invalid step.
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 6 Downloading the Firmware

Each time the manufacturer releases a new setup software version or issues a firmware patch, you should 
update the firmware on your existing digital drives. When you work closely with the manufacturer, particularly 
for custom products, firmware changes may be required several times throughout your development process.

6.1 Prepare for Download

1. Connect to the drive.
2. Open the Connection Settings window by going to Drive > Connect, and changing the 

connection setting to a high baud rate.
3. Make sure the parameters are correct in both the setup software and the drive.
4. Store parameters to the drive’s nonvolatile memory.

6.2 Open the Firmware Download Window

Select Drive > Firmware Download on the menu bar to open the Firmware Download window.

This window allows changes and upgrades to the drive run-time firmware. For example, you 
may need to upgrade when a new version of software is to be used with an older drive or when 
a new drive needs a previous version to work in a system.

Check the Current Information window to view which firmware is currently in the drive. If the 
firmware file name matches the recommended name in the Select Firmware window, a 
firmware upgrade is unnecessary and you may click the cancel button. If the two names are 
different, you should update the firmware.

Browse Folder/Browse File: If the drive firmware is not installed in the default directory, you 
may need to browse for it. Use these buttons to navigate to where the firmware file is located.
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6.3 Downloading the Firmware

1. Select the recommended firmware file.
2. Click on the Download button.

This process may take several minutes depending on your connection.
3. The Close the dialog box when download completes box is checked by default so that you 

will return to the main workspace after firmware upgrade completes.
4. If the ’Bridge State on Power-up’ option in the Power-up Control tab in Limits and Options 

is set to Enable, you will see a dialog window during the download asking if you would like 
to reset the drive after the firmware download is complete:
Be aware that resetting the drive in this case will cause the power bridge to be enabled 
after the download is complete, unless there is a hardware limiting event active (invalid 
halls, digital inputs, etc). If you choose not to reset the drive, the bridge will be disabled 
upon download completion, and the drive will not go through its normal power-up 
sequence.

5. When the upgrade is complete, store the parameters to nonvolatile memory.
6. Read the release notes for information about new features and issues.

Do not power down or lose your connection during the process. If 
this happens, you may have to restart the download, or in 
extreme cases, send the drive back to the manufacturer.
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 A Tools and Functions

This appendix describes helpful tools provided by the setup software.

A.1 Digital Oscilloscope

The digital scope is a powerful tool used for tuning and diagnostics. You can select from more 
than forty different signals to monitor while testing or troubleshooting your machine. Slower 
baud rates can affect the scope performance.

To open the digital oscilloscope, do one of the following:

• Select Tools > Scope/Tuning on the menu bar.
• Click on the Scope/Tuning  icon  on the tool bar.
• Select Control Loops > Scope/Tuning from the System Browser.

The oscilloscope provides real-time feedback and adjustment during tuning and setup. This 
multichannel digital scope behaves similarly to a traditional oscilloscope but provides access 
to internal drive signals. You can show up to eight channels at any time depending on the 
bandwidth used for each channel. The units used in the vertical division setting depend on the 
selected signal.

Standard prefixes such as   (micro-), m (milli-), k (kilo-), M (mega-), are used for scaling 
factors. The bridge does not need to be enabled to use the scope. All that is required is that the 
drive be powered up and connected.

Channel Select   The Channel Select section provides selection of oscilloscope signals.

• Add Signal: Adds a new channel to the scope (if available) and allows you to select a 
corresponding signal of your choice. This button will be disabled (grey) if all oscilloscope 
channels are used.

• Change: Changes the currently selected signal to another one of your choice.
• Remove: Removes the selected channel from the scope.

A list of available channels and their definitions can be found in the “Signal Definitions” on 
page 95.
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Presets   Automatically configured oscilloscope settings that are frequently used when tuning the 
drive. Each preset has pre-determined unit and time per division scaling. Click on the 
corresponding button to either load a preset or save the existing layout as a preset. The 
presets will be reset to the defaults when DriveWare is closed and re-opened.

• Current: Configures the oscilloscope settings for monitoring a target current command 
and the measured drive output current.

• Velocity: Configures the oscilloscope settings for monitoring a target velocity command 
and the measured motor velocity.

• Position: Configures the oscilloscope settings for monitoring a target position command 
and the measured motor position.

Display   The Display section provides configuration of the oscilloscope display settings.

• Time/Div: Shows the horizontal scaling time per division for the corresponding signal as 
seen in the digital scope display.

• Scale: Shows the units per division for the corresponding signal as seen in the digital 
scope display.

• Offset: Shows the offset associated with the signal as seen in the digital scope display.
• Horizontal Location: Allows adjustment of the horizontal (time-based) level at which the 

scope triggers.

Trigger   The Trigger section provides configuration of the oscilloscope settings.

• Source: Displays the currently selected signal to be used as a trigger.
• Level: Allows you to select the level at which you want the scope to trigger.
• Slope: Sets the trigger slope to positive slope or negative slope.
• Mode: Sets the trigger mode to one of the following:

— Normal Mode: The scope triggers according to the settings specified.
— Single: The scope triggers once, according to the settings specified, after Run/Stop 

button is selected.
— Auto: The scope triggers automatically, ignoring the settings specified.
— Roll: The scope triggers in a continuous roll. Note: you will be limited to 200 msec/Div 

minimum while in roll mode.

Measure   The Measure section provides real-time measurement between any two signals 
displayed on the oscilloscope.

• Time: This allows you to measure time differences between any two points on the scope 
display. Click the Time checkbox to display two vertical lines on the scope plot. The 
difference in time between the two lines is displayed in the box to the right of the check 
box. Left click to drag each line or right click to drag both.

• Signal Level: Select a channel for measurement from one of the two dropdown boxes. You 
may use either of the two dropdown menus to select a channel. The difference between the 
lines is displayed next to the channel selection dropdown; the selected channels units 
apply. Depending on whether the Time checkbox is selected, the values measured will 
either be horizontal time/div or vertical units/div. Left click to drag each line or right click 
to drag both.
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A.1.1 Waveform Generator
The Waveform Generator is used to generate an internal signal during drive tuning and other 
procedures, eliminating the need for external signal sources during tuning. The Waveform 
Generator is in the Scope/Tuning window.

• Target: Select the destination for the waveform signal. Not Connected means the 
waveform signal will not be used. Command Limiter means the command signal will be 
limited as defined in the Command Limiter section of the active Configuration.

• Type: Select a DC (constant), square wave, triangle wave, or sinusoidal waveform.
• Frequency: Select the frequency of the waveform signal. This becomes inactive when 

"DC" is selected for the waveform type.
• Amplitude: Corresponds to the amplitude of the waveform signal (equivalent to half of the 

peak-to-peak value). Disabled in the case where a DC waveform is selected. Clicking on the 
 button will set the amplitude to zero.

• Offset: Adds an offset to the selected waveform. If a DC waveform is selected, the offset 
corresponds to the DC signal amplitude.
— When the Position Loop is enabled, the  button will set the offset equal to the 

measured position.
• Symmetry: Corresponds to the duty cycle or symmetry of the waveform signal. This 

becomes inactive when DC is selected for the waveform type.

A.1.2 Data Capture
The Digital Oscilloscope includes an export feature that allows a user to capture oscilloscope 
data in a .CSV format. In order for the export feature to appear, the setup software must be 
connected to a drive. The Data Capture button at the bottom right of the Oscilloscope will be 
visible once connected. Selecting the Data Capture button will begin capturing oscilloscope 
data, and will open a Save As... dialog window that will specify where to save a .CSV file that will 
contain the data for the active oscilloscope signals. Once the desired oscilloscope data has been 
capture, click the End Capture button to stop the data export. The .CSV file will now be saved, 
and will organize the oscilloscope data for the active signals during the capture time frame as 
shown in the example below:

Time Position Target Position Measured
0 1746 1676

20 1962 1899

40 2137 2082

60 2280 2237

80 2393 2362

100 2464 2447

120 2498 2492

140 2493 2499

160 2446 2469

180 2365 2397

200 2240 2283

220 2088 2133
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Depending on the Trigger Mode selected, the Data Capture feature will function as given below:

• Single: File will contain 100 points for each signal. The data will include 50 points before / 
after the trigger.

• Normal: File is continuously filled with data 100 points at a time. The data is not continuous 
because it captures only 50 points before / after each trigger. Time starts over with each 
update.

• Auto: File is continuously filled with data 100 points at a time. The data is not continuous 
because it captures only 50 points before / after each update with some dead time. Time 
starts over with each update.

• Roll: File is continuously filled with data points. The data is continuous; however, the 
maximum capture rate is 10 points per 200ms.

A.1.3 Import
• Selecting a .CSV file for data import will render the captured signals in the file on the scope 

and prevent parameters in the Display, Trigger, Measurement, and Waveform Generator 
panes from being edited. Selecting the Live-Data button will clear the imported data and 
resume regular use of the scope.

• For .CSV files containing more data than can be rendered in a single scope screen, the 
buttons in the Import pane can be used to navigate the data.

• Separate scaling and Time/Div parameters are available in the Import pane to adjust the 
imported signals on the scope.
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A.2 Multimeter

The Multimeter allows you to monitor a multitude of signal types including positions, 
velocities, torques, and voltages. Use the Change Signal button to select the signal to monitor 
and display.

A resettable counter keeps track of the maximum and minimum values found, and shows the 
current maximum and minimum values in the corresponding display gauges. These values 
will update automatically if higher or lower values are detected. The Reset button below each 
display gauge will erase and reset the current maximum and minimum values.

You must be connected to a drive to use the Multimeter functions.

To open the multimeter, do one of the following:

• Select Tools > Multimeter on the menu bar.

• Click on the multimeter icon  on the tool bar.

Up to four Multimeter windows can be opened at any given time. The Multimeter windows can 
be dragged, docked, and nested to multiple locations within the software workspace. Click and 
hold on the Multimeter window title bar, and drag the window to the desired location.

To see a list of available signals for the multimeter, see “Signal Definitions” on page 95.

The multimeter samples signals at a rate of once every 250 ms or four 
times per second. If you want to measure a faster signal, use the Digital 
Scope.

Note



MNDGACUG-06 92

Tools and Functions / User Units

A.3 User Units

The User Units window allows the specification of the general units to be used throughout the 
application. A variety of units are selectable. The User Units window also allows the defintion of 
custom units.

The User Units window is found under Settings > User Units in the menu bar or by clicking on 
the User Units icon  in the toolbar.

• Select the type of unit to be used for each data type (Torque, Position, Velocity, etc.) and the 
Load type (Rotary or Linear) from the drop-down menus. A scaling ratio between 
Feedback and Load units can also be defined.

• Selecting the Custom Units checkbox will allow the definition of custom units and labels. A 
scaling ratio between standard and custom units can also be defined.
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A.4 Motion Panel

The Motion Panel controls are opened by selecting Tools > Motion Panel from the menu bar. 
The Motion Panel is used to select and execute motion tasks that have been pre-defined in the 
Home, Jog, and Indexes windows, or to define parameters for a single index task with the 
Dynamic Index tool. The Motion Panel is also used to execute PVT commands.

The Motion Panel provides a set of control buttons for various motion functions. Note that 
Jogs only allow forward or reverse motion, and cannot be set for automatic looping. 

Indexes   For more information on Indexes, see “Indexes” on page 78.

• Selects a pre-defined Index task (Index00 - Index15). Only Indexes that have already been 
defined in the corresponding Index window will be available for selection.

• The Index parameters will be displayed in the Motion Panel window.
• The available Motion Panel Index controls will depend on the type of index selected 

(Absolute or Relative).

Dynamic Index   For more information on Dynamic Indexes, see “Indexes” on page 78.

• Configure parameters for a single index task within the Motion Panel window.
• Both Absolute and Relative Index tasks can be defined with the Dynamic Index tool.

Jog   For more information on Jogs, see “Jogs” on page 82.

• Selects a pre-defined Jog task (0 or 1).
• The corresponding Jog velocity, accel, and decel will be displayed in the Motion Panel 

window.
• The Motion Engine does not need to be enabled to execute Jog tasks.

PVT   For more information on PVT and how to construct a PVT points file, see “PVT” on page 80.

• Used to execute PVT commands from a PVT points file. Note that the Motion Engine must 
be turned off to use the PVT generator.

• A PVT file can be constructed using Notepad or a similar text editor program. Each line in 
the file represents a PVT point by specifying position, velocity, and time separated by semi-
colons.

Icon Description
Execute the Home Method (home)

Halt Motion (halt)

Repeatedly Execute Motion in Reverse (loop reverse)

Execute Motion in Reverse (reverse)

Execute Motion (forward)

Repeatedly Execute Motion (forward loop)

Loop over Forward and Reverse Motion (cycle motion)
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• Before running a PVT file, it is recommended to connect at the highest baud rate available, 
and to minimize the number of applications running in the background. Also close any 
unnecessary windows in DriveWare as they will slow down the rate at which the drive 
receives PVT points, possibly resulting in a PVT buffer error.

Motion Status   
• Displays the real-time measured values for Position, Velocity, Torque (% of continuous 

current limit as defined in the Current Limits window), and position error.
• The Motion Status panel also displays the current state of the Motion Engine.

A.5 Motor Diagnostics

The Motor Diagnostics window is used to assist in system troubleshooting and diagnostics. 
Typically, the Motor Diagnostics procedure is ran while monitoring signals on the digital 
oscilloscope or Multimeter (i.e., comparing the Commanded Phase Angle to the measured 
position).

Procedure Settings   
• The Motor Diagnostics procedure will move the motor at the entered Holding Current at 

the Commanded Phase Angle entered in the window for the amount of time entered in the 
Holding Time field.

• The drive must be enabled and clear of any disabling faults or event actions in order to run 
the Motor Diagnostics routine. Click the Start button to run the procedure. The routine 
will end automatically after the Holding Time has completed.

Status Definition
Disabled The Motion Engine is not active. Enable the Motion Engine by using the toolbar icon or select Run 

from the Motion Engine menu bar selection.

Ready The Motion Engine is enabled and ready to execute an Index or Sequence.

Executing The Motion Engine is executing motion.

Loading A Sequence or Index program is loading.

Halting A Halt command has been asserted during an Index or Sequence move.

Not Homed Absolute Position is not valid. A Homing routine or Set Position function must be used before a 
motion task can be executed.

Bridge Wrong The drive is disabled or stopped. The drive must be enabled before running a motion task.

Fault on Test The If/Then test produced an error.

Single Step A Sequence is being executed in Single-Step mode.

Break Point A Sequence has stopped at a Break Point.
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A.6 Signal Definitions

The following tables show all of the signals that can be measured using the Oscilloscope and 
Multimeter. These signals may also be used as analog outputs in compatible drives.

Current measurements   

For Iq and Id, “I” represents the peak of the current sine wave for an individual phase in a three phase motor.

Depending on the drive type, motor type, and motor settings, some of the signals may not be available.

Velocity measurements   

Value Definition
Current Target (Iq) This is the commanded torque-producing current. Current limit settings are ignored.

Current Demand (Iq) The commanded torque-producing current, after current limits have been applied. This value is 
zero when the drive is inhibited.

Current Measured (Iq) The actual measured torque-producing current being delivered to the motor. Ideally, this value 
should be as close as possible to the demand current.

Id - Target This represents the flux producing stator current in an AC induction motor. Id should equal zero 
when using a permanent magnet motor.

Id - Demand This represents the flux producing stator current in an AC induction motor. Id should equal zero 
when using a permanent magnet motor.

Id - Measured This represents the flux producing stator current in an AC induction motor. Id should equal zero 
when using a permanent magnet motor.

Current Phase A The measured current in motor phase A. The sum of all three phases should add up to zero.

Current Phase B The measured current in motor phase B. The sum of all three phases should add up to zero.

Flux Ref. Current Target The commanded flux reference current ignoring limits. The flux reference current is the current 
induced in the rotor of an AC induction motor.

Flux Ref. Current Demand The commanded flux reference current, after limits have been applied. The flux reference current is 
the current induced in the rotor of an AC induction motor.

Flux Ref. Current Measured The measured flux reference current. The flux reference current is the current induced in the rotor 
of an AC induction motor.

Flux Ref. Current Error The difference between the flux reference current target and the flux reference current measured.

Current Reference This is the commanded torque-producing current before current loop input filtering or current offset. 

Torque Offset The offset applied to the Current Target (lq)

Value Definition
Velocity Target This is the commanded velocity ignoring velocity limit settings.

Velocity Demand The commanded velocity, after velocity limits have been applied. This value is zero when the drive 
is inhibited.

Velocity Measured The velocity as measured by the velocity feedback device (after filtering).

Velocity Feedback The velocity as measured by the velocity feedback device (before filtering).

Velocity Error The difference between the motor's target velocity and measured velocity.

Velocity Reference This is the commanded velocity before velocity loop input filtering or velocity offset.

Velocity Offset The offset applied to the Target Velocity.
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Position measurements   

Commutation   

Voltage   

Command Limiter   

Value Definition
Position Target This is the commanded position ignoring position limit settings.

Position Demand The commanded position, after position limits have been applied.

Position Measured The position as measured by the position feedback device.

Position Error The difference between the motor's target position and measured position.

Position Reference This is the commanded position before position loop input filtering or position offset.

Position Offset The offset applied to the Target Position.

Value Definition
Sync Error Synchronization is used with brushless motors to verify the commutation angle is valid for the 

measured position. When synchronization occurs, the drive compares the expected position to the 
measured position. If the two are not aligned, the drive cannot reliably commutate and a 
synchronization error results.

Hall State The decimal equivalent of the binary combination of the three hall states where Hall A is bit 0 and 
Hall C is bit 2. (5V = 1, 0V = 0). It is important to note that the binary value is inverted for PCB drive 
models. For example, a standalone drive may read a Hall State of 1-1-1, while a PCB-mounted 
drive would read a Hall State of 0-0-0 in the same situation.

Phase Angle The present number of degrees of the rotor inside one electrical cycle. Also may be called 
Electrical Angle.

Sync. Capture The encoder count captured at the Synchronization edge. This will vary depending on the Sync 
edge chosen from AutoCommutation (Hall or Index edge).

Stator Angle The present number of degrees of the stator inside one electrical cycle. This value is equal to the 
phase angle plus the slip angle.

Value Definition
Analog Output The present voltage applied to the analog output.

DC Bus Voltage The voltage the drive can output during the ON state of a PWM cycle. This is generally equivalent 
to the DC or rectified AC supply voltage to the drive. The DC Bus Voltage may be greater than the 
supply voltage when the motor is in a state of regeneration.

Voltage Phase A The voltage, with respect to DC bus ground, applied to motor phase A

Voltage Phase B The voltage, with respect to DC bus ground, applied to motor phase B.

Voltage Phase C The voltage, with respect to DC bus ground, applied to motor phase C.

Analog Input The voltage measured on the analog input pin with respect to signal ground.

Value Definition
Command Limiter Input The commanded signal before being profiled by the command limiter.
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Temperature   

Torque   

Drive   

Feedback   

Interface Input   

Deadband Input   

PWM Input   

Value Definition
Drive Temp. The baseplate temperature of the drive. This value will remain at a constant value of 25°C for 

FlexPro drives that do not have the appropriate temperature sensor.

Motor Temp. The calculated motor temperature after being measured on the selected input and scaled 
according to the specified scaling value.

Value Definition
Torque Measured The torque applied by the motor. This value is calculated from measured current, as delivered to 

the motor from the drive, and the motor torque constant entered in the Motor Data window.

Value Definition
Drive Position The position as measured by the drive in counts.

Drive Velocity The velocity as measured by the drive in counts per second.

Raw ADC One The full scale raw value of the ADC used for Analog Input 1

Raw ADC Two The full scale raw value of the ADC used for Analog Input 2

Raw ADC Three The full scale raw value of the ADC used for Analog Input 3

Raw ADC Four The full scale raw value of the ADC used for Analog Input 4

Value Definition
Primary Feedback This signal is used by the drive for commutation purposes, and may differ from the measured 

position. For determining measured position, reference the Position Measured signal.

Value Definition
Interface Input The decimal value read from the interface input.

Value Definition
Deadband Input The commanded input before deadband is utilized. Measured in units of current, velocity, or 

position depending on configuration.

Value Definition
PWM Duty Cycle This represents the duty cycle of the input when the drive is configured for PWM as a command.
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PLS   

Capture   

Value Definition
PLS Input The value for the position signal configured as the source PLS.

PLS Pulse 1 State This is the value corresponding to the state of the PLS Pulse 1 output.

PLS Pulse 2 State This is a value corresponding to the state of the PLS 2 output.

Value Definition
Position Capture The value of the measured position when an index is detected for the encoder configured as the 

Position Feedback Source.
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A.7 Drive Status

The Drive Status panel shows drive events (current and history) and is a useful 
troubleshooting diagnostics tool. Click on the Drive Status tab in the Status Panel to view the 
Drive Status information.

The Drive Status pane shows data in three categories:

• Drive protection
• System protection
• System Status

For a description of drive events and recommended troubleshooting methods, see “Events and 
I/O Descriptions and Troubleshooting Methods” on page 121.

Use the icons at the top of the pane to select viewing options.

Event States

Icon Name Description
Expand All Show all sub-categories.

Collapse All Hide all sub-categories.

Reset Events Clear the Drive Status window of any history events.

Show Inactive Show or hide the inactive status events.

Show History Show or hide the status history events.

Icon Name Description
Active An event that is active but not assigned to an action. This includes events assigned to No Action in 

the Event Manager window and pure status events that cannot be assigned an action.

Disabling Event An event that is active and assigned to an action. An action either inhibits motion partially or 
disables motion completely according to the action assigned in the Event Manager window.

History An event which is not presently active, but was active at some point after the last time the drive was 
powered on or the last time the Reset Events button was used.

Inactive An event that is not presently active, and has not been active since after the last time the drive was 
powered on or the last time the Reset Events button was used.
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A.8 Critical Event Activity

The Critical Event Activity window is a list of drive protection events along with the time they 
occurred. The critical event activity window contains entries such as Short Circuit and Current 
Overshoot.

Click on the Critical Event Activity tab to view the Critical Event Activity information.

A.9 Event Counters

Lists the total operating time of the drive and the number of times faults have occurred since 
the drive has been in operation.

Click on the Event Counters tab to view the Event Counters information.

Icon Name Description
Refresh Refresh the Event Activity log.

Export Export the Event Activity log to a text file.

Icon Name Description
Refresh Refresh theEvent Counter values.

Export Export the Event Counter values to a text file.

Event Counters automatically stores to the drive approximately once 
every nine minutes. If the drive power is shut off within this time frame and 
a manual store to NVM is not performed, the counter will not be 
incremented.

Note
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This topic explains current limiting for digital servo drives. The basic concepts of current limiting are 
introduced first, followed by a detailed explanation of some underlying formulas.

B.1 Understanding the Limit Envelope

Digital drives limit current output according to a well-defined software and hardware current 
limit envelope. These envelopes consist of Peak Current, for a specified amount of Peak 
Current Time, followed by a foldback to Continuous Current for an amount of time specified by 
the Foldback Time Constant.

Foldback & current limit envelope
1. The current limit envelope is shown in red.
2. You use drive setup software to configure the software envelope while the hardware 

envelope is fixed and defined by drive hardware limitations.
3. The Peak Current Time and Foldback Time Constant of the hardware envelope is the 

same for all drives, fixed at 2 and 10 seconds, respectively. The current values, how-
ever, depend upon the hardware with Peak Current and Continuous Current always 
equal to the maximum peak and continuous current rating of the drive.
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The drive always compares each point on the user specified software envelope against each 
point on the hardware envelope and takes the lesser of the two to generate the actual 
application envelope. An example of this, where the hardware envelope almost entirely 
overrides the software envelope, is shown in Table 1. In this example, a constant 100% peak 
current command (shown in white) was given to the drive. Because, beyond the first two 
seconds, the hardware envelope (2 seconds Peak Current Time and 10 second Foldback Time 
Constant) is less demanding than the software specified envelope (65 second Peak Current 
Time and 65 second Foldback Time Constant), hardware current limiting is applied.

Table 1
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In order to have the software envelope entirely hold true, it must be specified such that it 
remains equal to or within the hardware envelope of the drive. Table 2 shows an example of a 
software configuration that will hold true in application (i.e. not be overridden by hardware 
limitations). For convenience, the drive hardware envelope has been superimposed (in red) on 
the image of Table 2.

Table 2
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On the other hand, Table 3 shows the result of a user configured software envelope that falls 
outside of the allowed hardware envelope. The image in Table 3 shows how the drive will 
follow the specified software envelope up until it intersects the hardware envelope.

Table 3
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B.2 Current Limiting Algorithm

In order to understand the current limiting algorithm used by digital servo drives, it is 
necessary to first understand the different current limiting regions. The graph in Figure B.1 
breaks the available current into three different regions.

FIGURE B.1 Current Limiting Regions

• Continuous Region: The commanded current is less than or equal to the continuous 
current limit. The available current is equal to the commanded current.

• Peak Region: The commanded current is between the continuous and peak current 
limits. The available current is equal to the commanded current for a limited time (Peak 
Time).

• Foldback Region: Commanded current is between the continuous and peak current limits 
of the drive. The available current is less than the commanded current. The available 
current decreases over time until it equals the continuous current limit. The rate of this 
decrease is equal to:

Ip Peak current limit
Ic Continuous current limit
tf Foldback time

Ip

Ic

Continuous Region

Foldback Region

Peak Time Foldback Time

Time

Peak 
Region

Current

Slope Ip Ic–
tf

-----------------=
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B.2.1 Time-Based Peak Current Limiting
The full peak value of current is available to begin with. When a current command is equal to 
the peak current limit, the current begins to foldback to the continuous limit after Tp, 
following the same slope as given in Figure B.1 on page 105. Once the available current has 
reached the continuous current limit after tf, the available current will be limited to the 
continuous current limit until the commanded current is dropped below the continuous level.

FIGURE B.2 Time-Based Peak Current Limiting
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B.2.2 Time-Based Non-Peak Current Limiting
When the commanded current is between the peak and continuous current limits, the 
available current will begin to foldback at the intersection with the slope from Figure B.2 on 
page 106. The larger the commanded current, the sooner the available current will begin to 
foldback.

FIGURE B.3 Time-Based Non-Peak Current Limiting
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B.2.3 Time-Based Current Recovery
Initially, the full peak value of current is available. A commanded current above the continuous 
level causes the available current to foldback to the continuous level as shown in the first graph 
of Figure B.4. When the commanded current drops below the continuous current limit value 
(A1 in the first graph), the available current will then begin to recover along the slope of the 
foldback line towards the peak current level, as shown in the second graph of Figure B.4. The 
relationship between the commanded current and the recovered current is given as: 

Using this relationship, you can calculate the amount of time recovered, t, by using the 
following equation:

FIGURE B.4 Time-Based Current Recovery - Foldback and Commanded Current

Note that current must be commanded below the specified continuous value to start 
recovering from a foldback condition.
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B.2.4 Charge-Based Peak Current Limiting
The charge is full to begin with. When a current greater than the continuous current limit is 
commanded, the charge begins to decay. The loss of charge is determined by the area under 
the curve as shown in Figure B.5. The larger the command, the faster the charge will decay. 
When the charge decreases to zero, the available current will be limited to the continuous 
current limit until the charge is restored.

FIGURE B.5 Charge-Based Peak Current Limiting
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B.2.5 Charge-Based Non-Peak Current Limiting
When the commanded current is between the peak and continuous current limits, the 
commanded current will be available for a longer period when compared to limiting at peak 
command. Note that the slope of the line during foldback is the same for both cases.

FIGURE B.6 Charge-Based Non-Peak Current Limiting
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B.2.6 Charge-Based Current Recovery
After losing some value of charge, the charge may be recovered when the commanded value is 
dropped less than the continuous current limit. The amount of charge recovered depends on 
the magnitude of the commanded current and the amount of time in which it is commanded. 
The amount of charge recovered can be calculated by measuring the area within the curve as 
shown during the charge recovery phase in Figure B.7.

FIGURE B.7 Charge Recovery
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B.2.7 RMS Current Scaling
RMS Current Scaling uses the charge-based algorithm described above. The only difference is 
the value of the continuous current the drive is capable of outputting. The continuous RMS 
limit can be used when the motor is moving so that the electrical cycle frequency is greater 
than the upper frequency assigned to that drive. The upper frequency is typically around 5Hz 
or 150 RPM for a 4-pole motor. The continuous RMS value is the continuous DC value 
multiplied by the square root of two.

When the electrical cycle frequency drops below the upper frequency, the continuous current 
drops below the RMS value. When the motor is moving at slow speeds, the continuous current 
is equal to the DC value of the current.

FIGURE B.8 RMS Current Limiting
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B.3 Calculating Current Limits

Availability of output current greater than continuous current depends on the level of an 
internal charge reservoir. Upon power-up, the drive begins with a full reservoir having a 
charge equal to:

QP = Peak Reservoir Charge
IP = Peak Current
IC = Continuous Current
tP = Peak Current Time
tF = Foldback Time Constant

A drive with a fully charged reservoir can always output peak current. However, any time the 
target output current goes above the Continuous Current setting of the drive the reservoir 
begins to discharge. The rate of discharge is given as:

For IT > IC,

IT = Target Current (units of amps)
C = coulombs
s = seconds

Once the reservoir discharges past a threshold necessary to output peak current, the amount 
of current available to output begins to foldback linearly (assuming hardware limits do not 
override software limits) from IP to IC according to the Foldback Time Constant (tF).

When the reservoir becomes empty, no more than Continuous Current can be output by the 
drive. The peak current threshold can be calculated as:

which is simply the amount of charge that would be depleted over a complete current foldback. 
The reservoir recharges (up to a maximum of QP) anytime the target output current drops 
below the Continuous Current setting. The rate of charge depends upon how far the target 
output current is below the Continuous Current as given by:

For IT < IC,

As a result, the reservoir will recharge most rapidly when the target output current is zero (no 
command or drive inhibited).

QP 2 IP IC–  tP tF+ =

2 IP IC– C s

QTh QP tF  tP tF+ =

IC IT– C s
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B.3.1 Example 1: Foldback Current
What is the output current of a drive enabled in the foldback state (0 < Q < QTh) if the drive is 
configured according to the parameters in “Table 2” on page 103? Assume that the charge 
reservoir has been tracked since power-up and is known to be half empty (Q = QP/2) at the 
instant it is enabled. Because current limits are set within hardware limits the current foldback 
will be linear and easily represented by the first order equation:

For 0 < t < tx,

IF = the foldback current
M = the rate of foldback
t = is time (drive enabled at t=0)
I0 = the initial current output

Starting with I0, the initial amount of current available beyond continuous current will be the 
maximum difference between peak and continuous current (IP - IC) weighed against the 
percentage of charge Q available relative to QTh. Using IC as a baseline, this is formulated as,

For 0 < Q < QTh,

Taking the drive parameters of Table 2, I0 is calculated as follows.

I0 = (IP - IC)  [QP/2]/[(QP  tF)/(tP + tF)] + IC
= (IP - IC)  (tP + tF)/2tF + IC
= (12 - 6)  (2 + 5)/10 + 6
= 10.2 A.

The rate of foldback can be formulated as

Again using the parameters of Table 2, this gives M = (6 - 12)/5 = -1.2. Lastly, we need to 
calculate the time at which foldback ends. Knowing that foldback always ends with IC, we can 
use the line equation we just generated to calculate tx by solving for time as follows:

tx = (IF - I0)/M
= (6 - 10.2)/-1.2
= 3.5

Combining all our results, this yields the formula:

For 0 < t < 3.5,

IF = -1.2t + 10.2.

IF Mt Io+=

I0 IP IC– Q QTh Ic+=

M IC IP–  tF =
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B.3.2 Example 2: Peak Current Recovery
If recovery time is the only interest, there's an easy way to calculate the amount of time 
required to recover maximum peak current. This is shown in the following example.

How long will it take to recover maximum peak current on a drive which, from power-up, is 
depleted for tD seconds, where tD < tP + tF?

Assume the current command is initially held at a constant current of IH, where IH > IC, for tD 
seconds and then held constant at IL, where IL < IC, for tR seconds. These parameters are 
illustrated as:

Depletion of the reservoir always happens at the rate 2(IP - IC) which means the amount of 
charge depleted over tD will be QD = 2(IP - IC) x tD. Similarly, for a recharge time of tR, the 
charge recovered will be QR = (IC - IL) x tR. In order to fully recharge the reservoir, the amount 
of charge depleted must match the amount recovered such that QR = QD or (IC - IL)tR = 2(IP - 
IC)tD. The final step is to solve for tR as shown below.

The concept of peak current recovery can be approached a little differently by matching the 
area of two squares. This method tends to be more intuitive and is easy to visualize. The 
previous figure illustrates a typical current limiting envelope (in red) with an example current 
command (in green) and two square areas marked AD and AR. Note that the area of AD is equal 
to (IP - IC)  tD while the area of AR is equal to (IC - IL)  tR. Now, from Example 2, we know that 
the charge recovered should match the charge depleted. Given this, we can equate areas as 
given below:

QR = QD
(IC - IL)tR = 2(IP - IC)tD
AR = 2AD

Thus, in order to completely recover peak current, the area of the square 
(IC - IL)  tR must double the area of the square (IP - IC)  tD.

tR 2 IP IC– tD IC IL– =
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The following diagram shows how the various PID and feed-forward terms are implemented in the control loop 
for Position around Velocity around Current (Torque) tuning. Other drive configurations are possible as well.
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The velocity loop feedback filter uses a single pole low-pass filter to attenuate changes in velocity feedback. This 
helps to avoid responding to high frequency “spikes” in velocity, resulting in a smoother response to velocity 
commands.
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D.1 Effects of the Feedback Filter

The figures below show how the filter affects measured velocity and, in turn, motor response. 
For this example, a 10Hz, 100,000-count/sec sine wave is commanded by the drive. This will 
be considered the worst-case move required for the application. The motor uses a 2000 line 
encoder, and has a low inertia load coupled to the motor shaft. The current loop and velocity 
loop gains are tuned aggressively for a fast response.

D.1.1 Cutoff Frequency Set to Infinite

With no feedback filter, the velocity measured and velocity feedback are equal. The velocity 
loop responds instantly to all measured changes in velocity. The resulting velocity profile is 
distorted. A loud audible noise is heard from the motor.

D.1.2 Cutoff Frequency Set to 300Hz

At this level, the audible noise is no longer present and the response is smooth. The two 
waveforms are nearly identical. This is the optimum setting because it results in no distortion 
and no phase lag.
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D.1.3 Cutoff Frequency Set to 50Hz

At this level, the response is still smooth, but phase lag is apparent as the two waveforms begin 
to separate.

D.1.4 Cutoff Frequency Set to 10Hz

With the cutoff frequency set to 10Hz, there is an obvious difference between the two 
waveforms. The response is also noticeable in the motor shaft. The phase lag results in the 
motor motion becoming unstable.

D.2 Conclusion

The velocity loop cutoff frequency filter allows you to tune with higher velocity loop gains, 
which results in a faster response. Most applications will benefit from a velocity feedback filter 
cutoff frequency between 50Hz and 1500Hz. Too high of a cutoff frequency may result in 
audible noise from the motor. Too low of a cutoff frequency will cause significant phase lag and 
may lead to instability. The cutoff frequency should be adjusted during velocity loop tuning. For 
the worst-case move, the motor should follow the command smoothly, and there should be 
little or no phase lag between the velocity feedback and velocity measured traces.
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E.1 Setup Software Safety Actions

The following table provides a brief explanation of how certain safety actions are effected in 
the drive hardware and software configuration.

E.2 Potential External System Errors

The following is a list of potential non-drive-related system errors, and how the setup software 
and drive are equipped to automatically protect drive hardware.

Drive Safety Action Description
Disable Bridge No power is delivered to the motor. Motor is allowed to move freely.

Dynamic Brake Motor leads are shorted together internally. The drive regulates the switching of the 
bottom side power devices to protect the motor from over current.

Apply Brake This event action activates the Brake Active event which is typically mapped to a 
programmable digital output. This output is used to indicate when an external brake 
should be active in a system.

System Error Drive Action
Loss of Logic Power The bridge will be disabled. The brake output device will open, engaging the brake.

Loss of Supply and Logic Power The bridge will be disabled. The brake output device will open, engaging the brake.

Logic Power is too Low The bridge will be disabled. The brake output device will open, engaging the brake.

Communication Connection is Disconnected Results in a "Communication Channel Error", which should be configured by the user for 
Dynamic Brake (or Disable Bridge). The brake output device will open, engaging the 
brake. The timeout value and host watchdog must be properly configured by the 
host/controller.

Communication Signal Times Out Results in a "Communication Channel Error", which should be configured by the user for 
Dynamic Brake (or Disable Bridge). The brake output device will open, engaging the 
brake. The timeout value and host watchdog must be properly configured by the 
host/controller.

Encoder/Halls Cable is Disconnected If Hall Sensors are disconnected, will result in a "Hall State Error". The drive will fail 
Phase Detect on power up, and result in a "Phase Detect Error". If the encoder cable 
becomes disconnected while motion is commanded, a following error or continuous 
current foldback event will result, depending on the configuration and command. Faults 
should be configured by the user for Dynamic Brake or Disable Bridge.

Faulty Encoder Signals Results in a "Phase Synchronization Error", which should be configured by the user for 
Dynamic Brake or Disable Bridge.

Disconnected Motor Wires The drive does not directly detect that the motor wires are disconnected. The "Current 
Loop Saturated" and following error faults are secondary errors that are generated. It is 
recommended to use the faults as a possible indication of a disconnected motor.
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E.3 Events and I/O Descriptions and Troubleshooting Methods

The following is a list of possible drive events and I/O signals, a brief description of the cause, 
issue, or behavior, and some recommended actions to take to remove the event if necessary.

Event Description Likely Cause Recommended Actions
Absolute Position Valid An absolute motor position has been 

established by one of the drive’s positioning 
methods.

1) A homing routine has been initiated and 
completed successfully
2) An absolute position has been established by 
execution of the Set Position command
3) Phase Detect routine has completed 
successfully (only applies to drives with absolute 
feedback devices)

Status Only, no action needed.

At Command Velocity Mode: The measured velocity has 
reached the target velocity, within the At Velocity 
Window.
Position Mode: The measured position has 
reached the target position, within the In-
Position Window.
Torque Mode: The measured current is within 
range of the target current. In general, the At 
Command window will be 1/100 of the hardware 
peak current limit.

The drive has reached the commanded position 
within the range of the At Command window.

Status Only, no action needed.

Brake Active A drive event may be configured to activate an 
external brake. This is accomplished by 
assigning the event action and by assigning a 
digital output to "Apply Brake".

The drive’s Apply Brake action is enabled. If 
assigned to a digital output, the digital output will 
be active also. This occurs when an active event 
has its action assigned to Apply Brake.
Note: SynqNet drives control the brake through 
the SynqNet interface.

Check all active events. Check the settings for 
the event actions to see which event actions are 
assigned to Apply Brake.

Bridge Active The drive’s power bridge is enabled. The drive has been enabled. Status Only, no action needed.

Capture Complete The Capture routine has completed. The High Speed Capture function has been 
initiated and completed successfully.

Status Only, no action needed.

Command Limiter Active The command is currently being profiled by the 
Command Limiter.

The Command Limiter has been enabled. Status Only, no action needed.

Communication Channel Error The drive has experienced an interruption of 
communication on the communications 
interface. Note: Normal setup software 
communication interruption/loss will not trigger 
this error.
RS485/232:
If the drive is configured via index 0x04 for 
heartbeat this error will be thrown if the 
consumer heartbeat time is not reset within the 
defined time interval.
CANopen:
If the drive is configured for node / life guarding, 
the event will be thrown if the drive does not 
receive a node guard pulse within the specified 
time interval.
If configured for heartbeat, the drive will throw 
the error if the host fails to reset the timer within 
the specified time interval.
EtherCAT:
The EtherCAT RPDO watchdog has been 
activated. This occurs when EtherCAT state 
machine is operational and the drive has not 
received an RPDO in more than 10 cycles.
If configured for heartbeat, the drive will throw 
the error if the host fails to reset the timer within 
the specified time interval.

1) Communication cable has been disconnected
2) Host software has not been properly 
initialized

1) Check communication cable connections
2) Check to ensure host software is properly 
initialized.

Configuration Select The active drive Configuration has switched. A digital input has been configured to switch 
drive Configurations.

Status Only, no action needed.

Continuous Current Foldback The drive has been commanded to output 
greater than continuous current and has folded 
back to the continuous value. The peak and 
continuous currents will be either the software or 
hardware limits. When this event is active, the 
drive is supplying continuous current.

The drive current has folded back to the 
continuous value.

This is application dependent. Default event 
action is 'no action' which is informational only. 
Can be configured to perform an event action 
(i.e. disable bridge).

Current Limit Active The drive is applying current limiting based on 
the software settings specified, or is limiting 
according to the hardware limits of the drive.

The drive is being commanded to output current 
that exceeds software or hardware limits.

This is application dependent. Default event 
action is 'no action' which is informational only. 
Can be configured to perform an event action 
(i.e. disable bridge).



MNDGACUG-06 122

 / Events and I/O Descriptions and Troubleshooting Methods

Current Loop Saturated The PWM output is at maximum duty cycle, and 
cannot deliver any more current under the given 
conditions.

1) The bus voltage is insufficient for a given 
motor / current level
2) The motor's resistance is high
3)The motor leads are not properly connected
4) The logic supply voltage is outside of the 
specified tolerance for the drive

1) Make sure there is sufficient bus voltage
2) Make sure motor resistance is not high
3) Turn the power off and make sure the motor 
leads are properly connected.
4) Measure the logic supply voltage and 
compare to the allowed logic supply tolerance 
for the drive

Drive Internal Error The drive has experienced an internal error 
while executing its firmware.

Defective drive Contact technical support

Drive Over Temperature The drive has reached its maximum allowed 
temperature. The drive will disable when this 
occurs, and will be re-enabled when sufficiently 
cooled.

1) Inadequate heatsinking / ventilation
2) Excessive and repeated overcurrents

1) Ensure adequate heatsinking / ventilation
2) Ensure that motor exceeds minimum 
inductance requirements

Drive Reset The drive's internal processor was reset. NOTE: 
This event will occur every time the drive is 
power cycled.

1) The drive was power cycled
2) A glitch in power caused a processor reset

1) None if the drive was power cycled (status 
only)
2) Check logic power coming to drive.

Dynamic Brake Active A drive event may be configured to activate the 
dynamic brake. This is accomplished by 
assigning the event action and by assigning a 
digital output to "Dynamic Brake".

The drive’s Dynamic Brake action is enabled. If 
assigned to a digital output, the digital output will 
be active also. This occurs when an active event 
has its action assigned to Dynamic Brake.

Check all active events. Check the settings for 
the event actions to see which event actions are 
assigned to Dynamic Brake.

Feedback Sensor Error 1) For a resolver drive, indicates that the 
resolver signals are excessively noisy or outside 
of the range required by the drive.
2) For sin/cos indicates the sin/cos signals are 
excessively noisy or the product of the sin and 
cos signals is outside of the range required by 
the drive.
Note that Feedback Sensor Error does not 
trigger for Brush type motors using Sin/Cos 
feedback.

Resolver:
1) Resolver not connected
2) Faulty grounding / shielding of feedback 
connector
3) Resolver specs don't match drive
Sin/Cos:
1) Sin/Cos encoder not connected
2) Faulty grounding / shielding of feedback 
connector

Resolver:
1) Check resolver connection
2) Check grounding / shielding of feedback 
connector
3) Check resolver specs against drive specs
Sin/Cos:
1) Check the amplitude of sin/cos signals 
coming into drive
2) Check grounding / shielding of feedback 
connector

Gain Select The active drive Gain Set has switched. A digital input has been configured to switch 
Gain Sets.

Status Only, no action needed.

Hall State Error The drive is seeing an invalid Hall state on the 
Hall sensor inputs. Note that this event is only 
valid when Hall sensors are used. Invalid Hall 
states are as follows where each binary digit 
represents a Hall sensor input. Hall sensor 
inputs are either high (1) or low (0).
120 degree phasing
-111 (7 in decimal representation)
-000 (0 in decimal representation)
60 degree phasing
-101 (5 in decimal representation)
010 (2 in decimal representation)

1) Broken or disconnected Hall sensor(s) 1) Check hall sensor wiring
2) Move the motor by hand and verify that each 
of the individual Hall sensors are changing. If 
one or more of the Hall sensors are not 
changing, this could mean the Hall sensor is 
bad.

High Speed Capture The High Speed Capture Function has been 
activated.

The drive was commanded to execute a High 
Speed Capture either through a digital input, 
network interface, or the setup software.

Status Only, no action needed.

Home Active The drive’s internal homing routine is active. Homing was invoked either through a digital 
input, network interface, or the setup software.

Status Only, no action needed.

Home Done The drive’s internal homing routine has finished 
successfully.

Homing was invoked and completed. The start homing command (invoked with digital 
input, network interface, or setup software) can 
now be removed.

Home Execute The Homing routine has been activated. The drive was commanded to execute a Home 
command either through a digital input, network 
interface, or the setup software.

Status Only, no action needed.

In Home Position The motor is in the home position. The home 
position is defined by the Home Position Value 
and In-Home Position Window in the Position 
Limits tab. This event is active when the 
measured position of the motor is equal to the 
Home Position value within the window specified 
by the In-Home Position Window.

The motor is in the home position. Status only, no action needed.

Index Active An Index motion task is currently active and has 
control of the axis. No other motion tasks can be 
executed while this is active.

The drive was commanded to execute an Index 
task either through a digital input, network 
interface, or the setup software.

Status only, no action needed.

Index Busy An Index motion task is currently active and has 
control of the axis. No other motion tasks can be 
executed while this is active.

The drive was commanded to execute an Index 
task either through a digital input, network 
interface, or the setup software.

Status only, no action needed.

Index Done The Index motion task has completed, including 
dwell time, and no longer has control of the axis.

The drive was commanded to execute an Index 
task either through a digital input, network 
interface, or the setup software.

Status only, no action needed.

Event Description Likely Cause Recommended Actions
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Index Motion Done An Index motion task has reached the target 
position for the task. The axis may still be in 
motion depending on the system. No other 
motion tasks can be executed while this is 
active.

The drive was commanded to execute an Index 
task either through a digital input, network 
interface, or the setup software.

Status only, no action needed.

Jog Active A Jog task is currently active and has control of 
the axis. No other motion tasks can be executed 
while this is active.

The drive was commanded to execute a Jog 
task either through a digital input, network 
interface, or the setup software.

Status only, no action needed.

Jog Forward The Jog Forward Task is currently active. The drive was commanded to execute a Jog 
Forward task either through a digital input, 
network interface, or the setup software.

Status only, no action needed.

Jog Reverse The Jog Reverse Task is currently active. The drive was commanded to execute a Jog 
Reverse task either through a digital input, 
network interface, or the setup software.

Status only, no action needed.

Log Entry Missed The drive attempted to write to the fault log 
counter, but was unable to.

An internal error prevented the drive from writing 
to the fault log counter.

If error persists, contact technical support.

Maximum Measured Position 
Limit

The measured position has exceeded the 
maximum value set by software. The Max 
Measured Position Limit can be found in the 
Limits and Events > Position Limits tab. NOTE: 
THE LIMITS ARE DISABLED VIA SOFTWARE 
BY DEFAULT. VALID ONLY IF 'DISABLE 
POSITION LIMITS' CHECK BOX IN THE 
POSITION LIMITS TAB IS UNCHECKED.

The measured position exceeds the measured 
position limit.

This is application dependent. Default event 
action is 'no action' which is informational only. 
Can be configured to perform an event action 
(i.e. disable bridge).

Maximum Target Position Limit The Maximum allowed position target (positive 
direction) defined by software. The Max Target 
Position Limit can be found in the Limits and 
Events > Position Limits tab. NOTE: THE 
LIMITS ARE DISABLED VIA SOFTWARE BY 
DEFAULT. VALID ONLY IF 'DISABLE 
POSITION LIMITS' CHECK BOX IN THE 
POSITION LIMITS TAB IS UNCHECKED.

1) The drive has been commanded to go to a 
target position value that exceeds the maximum 
target position

This is application dependent. Default event 
action is 'no action' which is informational only. 
Can be configured to perform an event action 
(i.e. disable bridge).

Minimum Measured Position 
Limit

The measured position has exceeded the 
minimum value set by software.  The Min 
Measured Position Limit can be found in the 
Limits and Events > Position Limits tab. NOTE: 
THE LIMITS ARE DISABLED VIA SOFTWARE 
BY DEFAULT. VALID ONLY IF 'DISABLE 
POSITION LIMITS' CHECK BOX IN THE 
POSITION LIMITS TAB IS UNCHECKED.

The resulting measured position exceeds the 
measured position limit.

This is application dependent. Default event 
action is 'no action' which is informational only. 
Can be configured to perform an event action 
(i.e. disable bridge).

Minimum Target Position Limit The Minimum allowed position target (minimum 
direction) defined by software. The Min Target 
Position Limit can be found in the Limits and 
Events > Position Limits tab. NOTE: THE 
LIMITS ARE DISABLED VIA SOFTWARE BY 
DEFAULT. VALID ONLY IF 'DISABLE 
POSITION LIMITS' CHECK BOX IN THE 
POSITION LIMITS TAB IS UNCHECKED.

1) The drive has been commanded to go to a 
target position value that exceeds the minimum 
target position

This is application dependent. Default event 
action is 'no action' which is informational only. 
Can be configured to perform an event action 
(i.e. disable bridge).

Motion Engine Abort The Motion Engine has aborted a motion task. The Motion Engine has been stopped via a 
digital input.

Status only, no action needed.

Motion Engine Error The Motion Engine is in a fault state. 1) A disabling event may be present that is 
preventing the bridge from enabling or not 
allowing motion to occur.
2) The drive may not be homed.
3) An Index or Sequence may be improperly 
configured.

1) Check the Drive Status panel and the Status 
Bar to see if any events are causing a disabling 
action.
2) Run the homing routine.
3) Examine all saved Sequences for flagged 
errors.

Motion Engine Executing The Motion Engine is enabled and running a 
motion task.

The Motion Engine was commanded to run a 
motion task in the setup software either via the 
toolbar, a digital input, enable on Power-up, or 
through the network.

Status only, no action needed.

Motor Over Speed The motor's measured velocity is higher than the 
motor overspeed limit set by software. The 
Motor Over Speed value can be found in the 
Limits and Events > Velocity Limits tab.

1) The drive is in current mode and the 
commanded current results in the motor 
spinning faster than the specified maximum 
velocity.
2) The limit is set too low
3) Excessive noise on feedback
4) Improper grounding / shielding of feedback 
cable

1) Make sure motor is connected to load. Do not 
command a current that will result in the motor 
spinning too fast.
2) Verify the limit is set properly.
3) Verify electrical noise
4) Verify proper grounding / shielding of motor 
feedback cable

Motor Over Temperature A digital input or analog input assigned to be a 
motor over temperature is signaling the drive 
that the motor's temperature has been 
exceeded.

1) The motor has overheated
2) The temperature cutoff defined in software is 
artificially low
3) The sensor is faulty and/or disconnected

1) Check the motor for overheating
2) Check to ensure temperature cutoff defined in 
software is correct
3) Check to ensure that motor temperature 
sensor is not faulty or disconnected

Negative Stop Active A drive event may be configured to halt motion 
in the negative direction. This is accomplished 
by assigning the event action "Negative Stop" to 
a drive event.

The drive’s Negative Stop action is enabled. If 
assigned to a digital output, the digital output will 
be active also. This occurs when an active event 
has its action assigned to Negative Stop.

Check all active events. Check the settings for 
the event actions to see which event actions are 
assigned to Negative Stop.

Event Description Likely Cause Recommended Actions
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Negative Velocity Limit The measured velocity has exceeded the 
negative limit set by software.

1) The magnitude of the velocity target is greater 
than the Negative Velocity Limit
2) The Negative Velocity Limit is too small for 
the velocity that is being commanded

This is application dependent. Default event 
action is 'no action' which is informational only. 
Can be configured to perform an event action 
(i.e. disable bridge).

Non-Sinusoidal Commutation The drive is operating in the non-sinusoidal 
commutation mode (trapezoidal). Drives with 
incremental feedback will automatically enter 
this mode on power-up until the relative position 
is sensed via hall sensors or a phase detect 
routine.

1) Drive is configured for a Brushed motor
2) Drive is configured to use only Hall Sensor 
commutation (trapezoidal)
3) Drive powered up in trapezoidal mode. 
Relative position has not yet been determined 
by the drive.
4) A synchronization error resulted in the drive 
being unable to synchronize properly

1) Status only, no action needed
2) Status only, no action needed
3) Status only, no action needed
4) Check encoder and Hall Sensors or index for 
noise, or misalignment of Hall Sensors

Over Current The measured output current has exceeded the 
Drive’s rated current.

1) Inductance of motor is below drive's minimum
2) Noise
3) Current loop is over-tuned

1) Make sure motor inductance is above drive 
minimum
2) Check system for excessive electrical noise
3) Make sure current loop is not tuned too 
aggressively.

Over Voltage The HV voltage (not logic power) is above the 
maximum HARDWARE specified voltage.

1) Excessive HV power supply
2) Drive drive is experiencing excessive 
regeneration

1) Ensure that HV voltage is below drive's 
maximum voltage rating
2) Make sure a shunt regulator is installed and 
sized to efficiently shunt off regenerative energy.

Parameter Restore Error The drive encountered an error when reading 
project file parameters from the drive's non-
volatile memory.

1) Corrupt non-volatile memory
2) Defective Drive

1) Reburn firmware
2) Contact technical support

Parameter Store Error The drive encountered an error when writing 
project file parameters from the drive's non-
volatile memory.

1) Corrupt non-volatile memory
2) Defective Drive

1) Reburn firmware
2) Contact technical support

Phase Detect Active The drive is going into phase detection mode to 
determine proper phasing for commutation.

Phase Detect was invoked through a power-up 
option, digital input, network interface, or the 
setup software.

Status Only, no action needed.

Phase Detect Done The phase detection algorithm is complete. Phase Detect was invoked through a power-up 
option, digital input, network interface, or the 
setup software.

Status Only, no action needed.

Phase Detect Error The drive was unable to correctly determine the 
proper phasing following a phase detect routine.

1) Phase detect current is excessive
2) Encoder wires broken / disconnected
3) Phase detection motion insufficient

1) Check encoder wiring
2) Check to see if phase detection motion is 
excessive. Lower current if necessary

Phase Synchronization Error Indicates the number of counts seen by the drive 
between synchronization markers was not 
consistent with what had been determined 
during AutoCommutation and/or the initial 
parameters. VALID ONLY IF DRIVE IS 
COMMUTATING SINUSOIDALLY AND IS 
USING EITHER INDEX SYNCHRONIZATION 
OR HALL EDGE SYNCHRONIZATION.

1) The drive is not commutating properly
2) The feedback sensor is faulty
3) Excessive system noise
4) Poor grounding / shielding of feedback cable

1) Check to make sure commutation is 
established properly using AutoCommutation 
feature in the setup software
     a) Check encoder feedback parameters (I.e, 
line count / rev)
     b) Check for correct motor pole count
2) Check to ensure that the feedback sensor is 
operating properly
3) Check for excessive system noise
4) Inspect for poor grounding / shielding of 
feedback cable.

Position Following Error The measured position is outside of the position 
following error window defined in the software. 
Only valid when drive is in position mode.

The magnitude of the difference between the 
position measured and the position target is 
greater than the Position Following Error value

This is application dependent. Can be 
configured to perform an event action (i.e. 
disable bridge).

Positive Stop Active A drive event may be configured to halt motion 
in the positive direction. This is accomplished by 
assigning the event action "Positive Stop" to a 
drive event.

The drive’s Positive Stop action is enabled. If 
assigned to a digital output, the digital output will 
be active also. This occurs when an active event 
has its action assigned to Positive Stop.

Check all active events. Check the settings for 
the event actions to see which event actions are 
assigned to Positive Stop.

Positive Velocity Limit The measured velocity has reached the positive 
velocity limit set by software.

1) The velocity target is greater than the Positive 
Velocity Limit
2) The Positive Velocity Limit is set too low for 
the velocity being commanded

This is application dependent. Default event 
action is 'no action' which is informational only. 
Can be configured to perform an event action 
(i.e. disable bridge).

PVT Buffer Empty The PVT point buffer has no points in it. VALID 
ONLY IF COMMAND SOURCE IS PVT.

1) The PVT point buffer has had no points sent 
to it

This is application dependent. Default event 
action is 'no action' which is informational only. 
Can be configured to perform an event action 
(i.e. disable bridge).

PVT Buffer Empty Stop The PVT buffer ran out of points and motion is 
stopped. VALID ONLY IF COMMAND SOURCE 
IS PVT.

1) The drive ran out of points before seeing a 
PVT stop point
2) The stop point sent down was not correct

1) Make sure points are sent down continuously. 
When motion is to be stopped, a PVT stop point 
is sent.

PVT Buffer Failure There is a failure in the PVT Buffer. VALID ONLY 
IF COMMAND SOURCE IS PVT.

The drive disabled while executing motion. Check the drive status to see if there are any 
events causing the drive to disable.

PVT Buffer Full The PVT point buffer has 16 points in it. VALID 
ONLY IF COMMAND SOURCE IS PVT.

1) The PVT point buffer has been filled prior to a 
motion starting

Do not send more points down until PVT motion 
is started

PVT Buffer Threshold The drive has consumed points and has made 
the transition threshold that has been defined. 
VALID ONLY IF COMMAND SOURCE IS PVT.

The drive is expecting more points to be sent 
down.

Send more PVT Points.

Event Description Likely Cause Recommended Actions
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PVT Sequence Number Error The drive has detected a sequence number 
error. VALID ONLY IF COMMAND SOURCE IS 
PVT.

1) User has sent down a PVT point with a 
discontinuous sequence number
2) User sent two points with the same sequence 
number

Make sure the sequence number of the PVT 
point is correct.

PWM/DIR Broken Wire The drive has detected a PWM duty cycle input 
of 0% or 100%. VALID ONLY IF COMMAND 
SOURCE IS CONFIGURED FOR PWM.

1) Broken or disconnected PWM or Direction 
wire
2) PWM frequency below drive’s minimum value

1) Check for broken or disconnected PWM or 
Direction wire
2) Check to ensure that PWM frequency is 
above drive minimum value (typically 1kHz).

Registration Invalid Indicates no valid registration event was found 
in the defined target distance for the 
Registration Index Task.

No valid registration event was found within the 
Registration Limit Distance or Registration 
Window.

1) Check that a valid registration event is set to 
occur within the Registration Limit Distance or 
registration window.

Reset Events The Drive Status Panel event states have been 
reset.

The drive was commanded to execute a Reset 
Events command either through a digital input, 
network interface, or the setup software.

Status only, no action needed.

Safe Torque Off Safe Torque Off (STO) digital output has 
become active. This will prevent current from 
being output to the motor.

1) Safe Torque Off was triggered by the 
controller 
2) The proper voltage is not being applied to the 
STO1 and STO2 pins.

1) Determine what system event triggered a 
Safe Torque Off event.
2) Check the STO connections, and verify the 
voltage levels on the STO1 and STO2 pins. See 
the drive’s hardware manual for more details.

Set Position The Set Position function has set the target 
position and measured position to the Preset 
Position value.

The drive was commanded to execute a Set 
Position command either through a digital input, 
network interface, or the setup software.

Status only, no action needed.

Set/Reset Capture A The Capture A function has been Set/Reset. The drive was commanded to execute a 
Set/Reset Capture command either through a 
digital input, network interface, or the setup 
software.

Status only, no action needed.

Set/Reset Capture B The Capture B function has been Set/Reset. The drive was commanded to execute a 
Set/Reset Capture command either through a 
digital input, network interface, or the setup 
software.

Status only, no action needed.

Set/Reset Capture C The Capture C function has been Set/Reset. The drive was commanded to execute a 
Set/Reset Capture command either through a 
digital input, network interface, or the setup 
software.

Status only, no action needed.

Sequence Active A motion task Sequence is currently active and 
has control of the axis. No other motion tasks 
can be executed while this is active.

The drive was commanded to execute a 
Sequence either through a digital input, network 
interface, or the setup software.

Status only, no action needed.

Sequence Done The motion task Sequence has completed, 
including dwell time and no longer has control of 
the axis.

The drive was commanded to execute a 
Sequence either through a digital input, network 
interface, or the setup software.

Status only, no action needed.

Short Circuit The drive has detected that there is an 
insufficient amount of resistance between the 
motor leads and ground.

1) Inductance of motor is below drive's minimum
2) Noise
3) Short in the motor windings
4) Defective power component in power section 
of drive

1) Make sure motor inductance is above drive 
minimum
2) Check system for excessive electrical noise
3) Check for a short across the the motor 
phases
4) Contact technical support

Shunt Regulator Active The shunt regulator is active (if equipped). 1) The drive is performing a regenerative 
operation and has engaged the shunt regulator
2) Shunt turn on voltage is at or below nominal 
bus voltage

1) Status Only, no action needed
2) Check to make sure that the shunt turn on 
voltage is not set too low

Software Disable The drive has been commanded to disable via 
the communications channel or by clicking on 
the enable/disable icon on the toolbar. A 
Software Disable can also occur if the drive is 
configured to disable on power up.

A fault occurred or the host told the drive to 
disable the bridge.

1) Check to see if the host disabled the drive
2) Look for the presence of other faults
3) Check if bridge state is Disabled on power up

Software Negative Limit Indicates the drive was commanded to disable 
the negative direction

Host commanded a Negative Limit over serial. Verify if a Software Negative Limit is being 
commanded over the network.

Software Over Voltage The HV voltage (not logic power) is above the 
maximum SOFTWARE specified voltage.

1) Drive is experiencing excessive regeneration
2) The software 'Over Voltage Limit' is set too 
low

This is application dependent. Default event 
action is 'no action' which is informational only. 
Can be configured to perform an event action 
(i.e. disable bridge).

Software Positive Limit Indicates the drive was commanded to disable 
the positive direction.

Host commanded a Positive Limit over serial. Verify if a Software Positive Limit is being 
commanded over the network.

Software Stop The drive was commanded to perform a Stop. An event action has been configured to perform 
a 'stop' when the event occurs.

1) If in response to an event action, check to see 
what event caused this response.
2) If commanded via network interface, then this 
is informational.

Software Under Voltage The HV voltage (not logic power) is below the 
minimum SOFTWARE specified voltage.

1) The HV voltage is disconnected
2) The power is off
3) The software 'Under Voltage Limit' is set too 
high

This is application dependent. Default event 
action is 'no action' which is informational only. 
Can be configured to perform an event action 
(i.e.disable bridge).

Event Description Likely Cause Recommended Actions
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Stop Active A drive event may be configured to halt motion. 
This is accomplished by assigning the event 
"Stop" to a drive event.

The drive’s Stop action is enabled. If assigned to 
a digital output, the digital output will be active 
also. This occurs when an active event has its 
action assigned to Stop.

Check all active events. Check the settings for 
the event actions to see which event actions are 
assigned to Stop.

Under Voltage The HV voltage (not logic power) is below the 
minimum HARDWARE specified voltage.

1) Insufficient power supply
2) HV power is disconnected

1) Ensure that HV voltage is above drive's 
minimum voltage rating
2) Ensure HV power is connected
3) Verify HV voltage is stable and does not drop, 
even momentarily, during system operation

User Aux. Disable The drive has been commanded via a digital 
input to disable the drive.

The User Aux. Disable input has been asserted. 1) Verify under what system conditions the user-
configured digital input will assert a User Aux. 
Disable.
2) Verify that the digital input mapped to User 
Aux. Disable is wired correctly to the drive.
3) Check to see that the input polarity for the 
digital input is configured correctly for the 
system (i.e. does the active low checkbox need 
to be checked?)

User Disable The drive has been disabled by a user-
configured digital input.

A digital input has been configured to disable the 
bridge.

1) Verify under what system conditions the user-
configured digital input will disable the bridge
2) Verify that the user-configured digital input is 
wired correctly to the drive
3) Check to see that the input polarity for the 
user-configured digital input is configured 
correctly for the system (i.e. does the active low 
checkbox need to be checked?)

User Negative Limit The drive has hit a negative limit switch. A digital 
input must be configured to be a negative limit.

The axis has reached the physical end of travel 
and has hit a mechanical limit switch.

Clear the axis away from the limit switch.

User Positive Limit The drive has hit a positive limit switch. A digital 
input must be configured to be a positive limit.

The axis has reached the physical end of travel 
and has hit a mechanical limit switch.

Clear the axis away from the limit switch.

User Stop A digital input has been assigned to perform a 
'Stop' when asserted.

A digital input triggered a Stop. 1) Ensure that a Stop was commanded via 
digital input.

Velocity Following Error The difference between the target and 
measured velocity is outside of the velocity 
following error window defined in the software.

1) The magnitude of the difference between the 
velocity measured and the velocity target is 
greater than the Velocity Following Error value
2) The Velocity Following Error value is too small

This is application dependent. Default event 
action is 'no action' which is informational only. 
Can be configured to perform an event action 
(i.e. disable bridge).

Zero Velocity The measured motor velocity is within the Zero 
Velocity window as defined in the Velocity 
Limits.

The motor is not moving. Status only, no action needed.

Event Description Likely Cause Recommended Actions



MNDGACUG-06 I

Index

A
Absolute Position Valid ............121
Active High ...................................37
Active Low ....................................34
Analog input .................................17
Analog Inputs ..............................33
Analog Outputs ............................34
At Command ..............................121
AutoCommutation™ ...................61

warnings ...............................62–63

B
BiSS Encoder Parameters ..........26
Bit Monitor ...................................48
Brake Active ...............................121

C
CAN Bus Speed ............................46
Caption Bar ....................................5
Capture Configuration ................35
Comm. Channel ...........................18
Command Limiter .................19–20

current loop control ....................19
position loop control ...................19
velocity loop control ....................19

Command Limiter Active ...19, 121
Command Settings ......................16
Command Source ........................16

analog input ................................17
comm. channel ...........................18
DriveLibrary ...............................19
encoder following .......................18
interface input ............................18
no command ...............................16
pwm & direction .........................17
step & direction ...........................17

Command Toolbar ........................8
Communication Channel Error 121
Commutation ...............................61

AutoCommutation™ ...................61
Manual Commutation .................63

Configuration
drive parameters .........................39

Configure Input Scaling .............17
Connecting to the Drive ....6, 13–14

communication parameters ........14
connection settings ...............13–14

Continuous Current Foldback .121

Control Loop Architecture ....... 116
Critical Event Activity ...............100
Current Limit Active .................121
Current Limiting ................101–115

calculation of .................... 113–115
Charge-Based .................... 109–111
RMS Current Scaling ................112
Time-Based .......................106–108

Current Loop
command limiter control ............19
tuning

integral gain ..........................58
proportional gain ..................58

Current Loop Saturated ............122
Current Measured .......................57
Current Target .............................57
Cutoff Frequency

see Feedback Filter

D
Deadband .....................................33
Derivative Gain

velocity loop tuning .....................71
Diagnostics

see I/O Configuration
Digital Inputs ...............................34

priority ........................................34
Digital Outputs ............................37
Disable Negative Direction ........44
Disable Positive Direction ..........44
Disable Power Bridge ..................44
Disconnecting from the Drive .....7
Drive Internal Error ..................122
Drive Menu .....................................3
Drive Name ....................................6
Drive Operation ...........................46
Drive Over Temperature ..........122
Drive Parameters

configuration of ..........................39
Drive Protection ..........................99
Drive Reset .................................122
Drive Status ..................................99
DriveLibrary .................................19
Dynamic Brake ............................44
Dynamic Help ................................4

E
Encoder Following ......................18

Event Actions ...............................44
Event Counters ..........................100
Event Recoveries .........................45
Events ............................................44

F
Fault Activity

critical event activity .................100
event counter ............................100
event logs ..................................100

Feedback Assignment .................21
Feedback Cutoff Freq. .................71
Feedback Filter .................. 117–119
Feedback Parameters ..................25
Feedback Sensor Error .............122
Feed-forward Gain

velocity loop tuning .....................71
File Menu ........................................3
Firmware

check drive version of .................10
download new version of .......85–86

Foldback .....................................101
time constant ....................101, 113

G
Gain Set .........................................16

H
Hall State Error .........................122
Help Menu ......................................4
Home Active ...............................122
Home Done ................................122
Homing .........................................76

direction of travel ........................77
index pulse ..................................77
limit and home switches .............77
load and physical limits ..............77

Hotkey .............................................7

I
In Home Position ......................122
Index Active ................................122
Index Done .................................122
Index Motion Done ...................123
Indexing Tasks .............................78
Input Type ....................................18
Integral Gain



MNDGACUG-06 II

Index

current loop tuning .....................58
velocity loop tuning ....................71

Interface input .............................18

J
Jerk Limiting ...............................20
Jog Active ...................................123
Jogs ...............................................82

L
Latch .............................................44
Limit Envelope ..........................101
Limits ............................................39
Log Entry Missed ......................123
Loop Configuration .....................16

M
Manual Commutation ................63
Max Measured Position Limit .123
Max Phase Detection Motion ....66
Maximum Target Position .......123
Menu ...............................................3
Min Measured Position Limit ..123
Minimum Target Position ........123
Motion Engine Abort ................123
Motion Engine Error ................123
Motion Engine Executing ........123
Motor

rotation direction ........................23
Motor Over Speed .....................123
Motor Over Temp. .....................123
Motor Parameters .......................23
Motor Ratings

see Motor/Feedback
Motor Selection ...........................23
Multimeter ...............................3, 91

signal definitions ........................95

N
Negative Stop ...............................44
Negative Velocity Limit ............124
Network Settings .........................46
No Action ......................................44
No Command ...............................16
Non-Sinusoidal Commutation 124

O
Open ............................................3, 6
Oscilloscope .................................87

signal definitions ........................95
Over Current ..............................124
Over Voltage ...............................124

P
Parameter Restore Error ..........124
Parameter Store Error ..............124
PDO Configuration ...............47–48
Peak Current Time ....................101
Phase Detect ...........................66–67

max phase detection motion .......66
Phase Detect Active ...................124

Phase Detect Done ....................124
Phase Detect Error ....................124
Phase Sync. Error ......................124
Position Following Error ..........124
Position Loop

around torque .............................73
around velocity ...........................73
command limiter control ............19
tuning .........................................73

Position Measured ......................74
Position Target .............................74
Positive Stop .................................44
Positive Velocity Limit ..............124
Power up or down the bridge .......3
Programmable Limit Switch ......37
Proportional Gain

current loop tuning .....................58
velocity loop tuning .....................71

PVT Buffer Empty .....................124
PVT Buffer Empty Stop ............124
PVT Buffer Failure ....................124
PVT Buffer Full ..........................124
PVT Buffer Threshold ...............124
PVT File Creation ........................80
PVT Generator .............................80
PVT Sequence Number .............125
PWM & Direction ........................17
PWM/DIR Broken Wire ...........125

R
Recoveries ....................................45
Recovery Time .............................45
Registration Invalid ..................125
Restore ......................................3, 15
Rotation Direction .......................23
RPDOs

CANopen ....................................47
EtherCAT ....................................48
Ethernet Powerlink .....................48

S
Safety ......................................... ii–iii
Sequence Active .........................125
Sequence Done ..........................125
Sequences .....................................82
Settings Menu ................................3
Setup Panel .....................................4
Setup Software Files .....................2
Short Circuit ...............................125
Shunt Regulator .....................41–42
Shunt Regulator Active .............125
Signal Definitions ........................95

command limiter ........................96
commutation ..............................96
current ........................................95
deadband input ...........................97
drive ............................................97
interface input ............................97
position .......................................96
temperature ................................97
torque .........................................97
velocity .......................................95
voltage ........................................96

Software Disable ........................125
Software Negative Limit ...........125
Software Over Voltage ..............125
Software Positive Limit ............125
Software Stop .............................125
Software Under Voltage ...........125
Station Alias .................................46
Status Bar .......................................4
Status Panel ....................................4
Step & Direction ..........................17
Stop ................................................44
System Protection .......................99
System Status ...............................99

T
Technical Support .......................10
Time-Out ......................................45
Timer .............................................48
Toolbar ....................................3–4, 9

icons .............................................3
Tools Menu .....................................3
TPDO Events ................................48
TPDOs

CANopen ....................................47
EtherCAT ....................................48
Ethernet Powerlink .....................48

Tuning ...........................................52
position loop ...............................73
velocity loop ................................68

U
Under Voltage ............................126
User Auxiliary Disable ..............126
User Disable ...............................126
User Negative Limit ..................126
User Positive Limit ....................126
User Stop ....................................126
User Units .....................................92

V
Value Changed .............................48
Value Reached .............................48
Velocity Following Error ..........126
Velocity Loop

command limiter control ............19
feedback filter ................... 117–119
tuning .........................................68

derivative gain .......................71
feedback cutoff freq. ..............71
feed-forward gain ..................71
integral gain ..........................71
proportional gain ..................71

Velocity Measured .......................70
Velocity Target .............................70
View Menu ......................................4

W
Window Menu ................................4

Z
Zero Velocity ..............................126



ACE User Guide
MNDGACUG-05

3805 Calle Tecate  Camarillo, CA 93012-5068
Tel: (805) 389-1935 Fax: (805) 384-2315 www.a-m-c.com


	Preface
	Contents
	1 Introduction 1
	2 Connecting to the Drive 12
	3 Configuring the Drive 15
	4 Tuning and Commutation 52
	5 Motion Tasks 75
	6 Downloading the Firmware 85
	A Tools and Functions 87
	B Current Limiting 101
	C Control Loop Architecture 116
	D Filtering Velocity Feedback 117
	E Troubleshooting 120

	1 Introduction
	1.1 Getting Started
	1.1.1 Software Files
	1.1.2 Workspace Display
	1.2 Using the Setup Software
	1.2.1 Opening a File
	1.2.2 Working with the Drive
	1.2.3 Hot Key
	1.2.4 Working with the Command Toolbar
	1.2.5 Working with the Setup Software Windows
	1.3 Getting Help
	1.3.1 Dynamic Help
	1.3.2 Technical Support
	1.4 Saving Your Setup
	1.4.1 Storing the Changes onto the Drive
	1.4.2 Saving the Project File onto Your Computer
	1.5 Exiting the Program

	2 Connecting to the Drive
	2.1 Connecting to the Drive
	2.2 Changing Communication Parameters

	3 Configuring the Drive
	3.1 Configuration
	3.1.1 Command Source
	3.1.2 Command Limiter
	3.2 Loop Feedback
	3.2.1 Velocity Feedback Source
	3.2.2 Position Feedback Source
	3.3 Power-up Settings
	3.4 Motor Parameters
	3.4.1 Motor Selection
	3.4.2 Motor Parameters
	3.4.3 Feedback Type
	3.4.4 Commutation
	3.4.5 Braking
	3.4.6 Motor Database
	3.5 AutoCommutation
	3.6 Encoder Output
	3.7 Inputs / Outputs
	3.7.1 Analog Inputs
	3.7.2 Analog Outputs
	3.7.3 Digital Inputs
	3.7.4 Digital Outputs
	3.7.5 Extended I/O
	3.7.6 Programmable Limit Switch
	3.8 Limits
	3.8.1 Current Limits
	3.8.2 Velocity Limits
	3.8.3 Position Limits
	3.8.4 Stop
	3.8.5 Voltage Limits
	3.8.6 Temperature Limits
	3.9 Events
	3.9.1 Basic Events
	3.9.2 Advanced Events
	3.10 Network Settings
	3.11 PDO Configuration
	3.11.1 RPDOs - CAN Drive
	3.11.2 TPDOs - CAN Drive
	3.11.3 TPDO Events - CAN Drive
	3.11.4 RPDOs and TPDOs - Ethernet Powerlink or EtherCAT
	3.12 Tuning
	3.12.1 Current Loop Gains
	3.12.2 Gain Sets
	3.12.3 Filters
	3.12.4 Advanced Settings

	4 Tuning and Commutation
	4.1 Current Loop Tuning
	4.1.1 Current Loop Auto-Tuning
	4.1.2 Manual Current Loop Tuning
	4.2 Commutation
	4.2.1 AutoCommutation™
	4.2.2 Manual Commutation Procedure
	4.2.3 Advanced Commutation
	4.2.4 Phase Detect
	4.3 Velocity Loop Tuning
	4.3.1 Velocity Loop Auto-Tuning
	4.3.2 Manual Velocity Loop Tuning
	4.4 Position Loop Tuning

	5 Motion Tasks
	5.1 Motion Tasks
	5.1.1 Homing
	5.1.2 Indexes
	5.1.3 PVT
	5.1.4 Jogs
	5.1.5 Sequences

	6 Downloading the Firmware
	6.1 Prepare for Download
	6.2 Open the Firmware Download Window
	6.3 Downloading the Firmware

	A Tools and Functions
	A.1 Digital Oscilloscope
	A.1.1 Waveform Generator
	A.1.2 Data Capture
	A.1.3 Import
	A.2 Multimeter
	A.3 User Units
	A.4 Motion Panel
	A.5 Motor Diagnostics
	A.6 Signal Definitions
	A.7 Drive Status
	A.8 Critical Event Activity
	A.9 Event Counters

	B Current Limiting
	B.1 Understanding the Limit Envelope
	B.2 Current Limiting Algorithm
	B.2.1 Time-Based Peak Current Limiting
	B.2.2 Time-Based Non-Peak Current Limiting
	B.2.3 Time-Based Current Recovery
	B.2.4 Charge-Based Peak Current Limiting
	B.2.5 Charge-Based Non-Peak Current Limiting
	B.2.6 Charge-Based Current Recovery
	B.2.7 RMS Current Scaling
	B.3 Calculating Current Limits
	B.3.1 Example 1: Foldback Current
	B.3.2 Example 2: Peak Current Recovery

	C Control Loop Architecture
	D Filtering Velocity Feedback
	D.1 Effects of the Feedback Filter
	D.1.1 Cutoff Frequency Set to Infinite
	D.1.2 Cutoff Frequency Set to 300Hz
	D.1.3 Cutoff Frequency Set to 50Hz
	D.1.4 Cutoff Frequency Set to 10Hz
	D.2 Conclusion

	E Troubleshooting
	E.1 Setup Software Safety Actions
	E.2 Potential External System Errors
	E.3 Events and I/O Descriptions and Troubleshooting Methods

	Index



